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Introduction

This reference describes the objects and methods in the Adobe® Photoshop® CS4° JavaScript™ type
library. A companion document, Photoshop CS4 Scripting Guide, describes basic scripting concepts and the
Photoshop object model. This document provides reference details of the Photoshop object model, and
additional information on JavaScript-specific features.

Adobe Photoshop CS4 uses ExtendScript, Adobe’s extended implementation of JavaScript. See JavaScript
support in Adobe Photoshop CS4 for additional information.

This book contains the following sections:

e This introduction, which describes scripting support in Adobe Photoshop CS4, and lists changes to the
JavaScript interface since the previous release.

e JavaScript Object Reference, which provides a complete reference for all Photoshop DOM objects and
commands.

e Scripting Constants, which lists all enumerations used in the Photoshop type library.

For a JavaScript file to be recognized by Photoshop as a valid script file, it must use eithera .js ora .jsx
extension.

On the Mac OS, there is no difference in the way scripts with the two extensions function. On Windows, if
the script files is opened from inside Photoshop, there is no difference between using the .js and . jsx
extension. However, if the script is launched by double-clicking on it, a script with the . s extension is
interpreted with the Microsoft JScript engine, and it cannot launch Adobe Photoshop CS4. For Windows,
using the . jsx extension is preferrable, since it interprets the script with the ExtendScript engine.

All of the Adobe Creative Suite 4 applications, including Adobe Photoshop CS4, use ExtendScript, Adobe’s
extended implementation of JavaScript. ExtendScript files are distinguished by the . jsx extension.
ExtendScript offers all standard JavaScript features, plus additional features and utilities, such as:

e A debugging environment (the ExtendScript Toolkit)

e Alocalization utility

e Tools that allow you to combine scripts and direct them to particular applications

e Platform-independent file and folder representation

Many of the JavaScript objects and methods use objects defined in ExtendScript, such as the File object,

the Folder object, and the unitvalue object. For that reason, using the . jsx extension for your script
files is preferable.

For details of these and additional features, see the JavaScript Tools Guide CS4. This document is installed
with Creative Suite 4 applications at these locations:
e In Windows:

C:\Program Files\Adobe\Adobe Utilities\ExtendScript Toolkit CS4\SDK
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e InMacOS:

Applications/Utilities/Adobe Utilities/ExtendScript Toolkit CS4/SDK

The latest versions of this document and of the ExtendScript Tookit, can also be downloaded from Adobe
Developer Center, http://www.adobe.com/devnet/.

The Adobe Photoshop CS4 interface includes a Scripts menu (File > Scripts) which provides quick and
easy access to your JavaScripts. Scripts can be listed directly as menu items that run when you select them,
or you can navigate to and run any JavaScript in your file system.

If Adobe Photoshop CS4 encounters an error during script execution, it displays the error message.

To install a JavaScript in the Scripts menu, place it in the Scripts folder (Photoshop CS4/Presets/Scripts).
The names of the scripts in the Scripts folder, without the file name extension, will be displayed in the
Scripts menu. Any number of scripts may be installed in the Scripts menu.

Scripts added to the Scripts folder while Adobe Photoshop CS4 is running will not appear in the Scripts
menu until the next time you launch the application.

All scripts found in the Scripts folder and sub-folders are displayed at the top level of the File > Scripts
menu. The addition of sub-folders does not add a hierarchical organization to the Scripts menu.

The Browse item at the end of the Scripts menu (File > Scripts > Browse) allows you to execute scripts
which are not installed in the Scripts folder. You can also use Browse to select scripts installed in the Scripts
folder after the application was last launched.

Selecting Browse displays a file browser dialog which allows you to select a script file for execution. Only
.js or .jsx files are displayed in the browse dialog. When you select a script file, it is executed the same
way as an installed script.

On startup, Adobe Photoshop CS4 executes all . §sx files that it finds in the startup folders.
e On Windows, the startup folder for user-defined scripts is:
C:\Program Files\Common Files\Adobe\Startup Scripts CS4\Adobe Photoshop
e On Mac OS, the startup folder for user-defined scripts is:
~/Library/Application Support/Adobe/Startup Scripts CS4/Adobe Photoshop
If a script is meant to be executed only by Adobe Photoshop CS4, it must include code such as the
following:

if ( BridgeTalk.appName == "photoshop" ) ({
//continue executing script
}

For additional details, see the JavaScript Tools Guide CS4.
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The JavaScript API follows JavaScript naming conventions in that all classes (object types) begin with
uppercase letters and have mixed case. Typically, in JavaScript, you instantiate classes using the new
operator:

new ClassName () ;
However, in the Photoshop Object Model, it is often not necessary to do this. Major object types are
collected into collection classes; for example, a list of Document objects is contained in a Documents

collection object. You then access the collection object through a corresponding collection property in its
container in the object hierarchy.

For example, the collection of all open documents is contained in the top-level application object. You
can access this through the global variable app, or simply reference its properties directly at the top level:

app.documents [0] // get the first loaded documented
documents [0] // this is the same

A collection property has the same name as the collection object, but begins with lowercase. For example,
a Document contains a collection of Layersets, and a Layerset contains a collection of ArtLayers. To
access one ArtLayer object in a set:

var myLayer = activeDocument.layerSets[0] .artLayers([0];
The collections, as in this example, can be treated as arrays, which is useful for iteration. They also provide
methods to create their contained objects, and to access them by name:

var newLayer = activeDocument.artlLayers.add(); // Create a new ArtLayer object
newlLayer.name = "My Layer"; // name it for later reference

var layerRef = activeDocument.artLayers.getByName ("My Layer") ;

Some objects, such as the Font objects contained in the app. fonts collection, are created by the
application, and never by your scripts.

Your scripts do use the JavaScript new operator to create helper objects, such as those that encapsulate a
set of options for opening or saving a document in a particular format:

var opts = new PDFOpenOptions() ;
opts.page = 10;
app.open (myPDFFile, opts) ;

The following changes have been made to the JavaScript object model and language support in Adobe
Photoshop CS4:

e New methods and properties:
e PrintSettings oftype DocumentPrintSettings has been added to the bocument object.
e togglePalettes method has been added to the Application object.
e runMenuItem method has been added to the Application object.
e printOneCopy method has been added to the Document object.
e build property hasbeen added to the Application object.

e systemInformation property hasbeen added to the application object.
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layerMaskDensity property hasbeen added to the aArtLayer object.
layerMaskFeather property hasbeen added to the aArtLayer object.
vectorMaskDensity property hasbeen added to the artLayer object.
vectorMaskFeather property hasbeen added to the artLayer object.
filterMaskDensity property has been added to the ArtLayer object.
filterMaskFeather property has been added tothe ArtLayer object.

xmpMetadata property has been added to the Layer object.

e New enumerations:

DocPositionStyle has been added for the DocumentPrintSettings object.
PrintColorHandling has been added for the DocumentPrintSettings object.
PDFx42008 has been added for the PDFStandard object.

pDF17 has been added for the PDFCcompatibility object.

e Modified enumerations:

LIGHTERCOLOR and DARKERCOLOR has been added to the BlendMode enumeration.

BLACKANDWHITE and VIBRANCE has been added to the LayerKind enumeration.

Bug fixes

size for the font is now of type Unitvalue.



2

JavaScript Object Reference

The Photoshop objects (the JavaScript type library for Adobe® Photoshop® CS4) are presented
alphabetically and in tabular format in this chapter. Sample code for several object model classes is given
to help illustrate the syntax as well as usage of the object class.

Object properties and methods are described in separate tables for each object. The following sections
describe the conventions used in these descriptions.

The Properties table for an object lists the following:
e The properties defined in each object.
e The value type for each property.

When the value type is a constant or another object, the value is a hypertext link to the listing for that
constant or object.

e The property’s input status: read-only or read-write.

e Adescription that explains what the property does.

Property Value type What it is

displayDialogs DialogModes Read-write. The dialog mode for the application, which controls
what types of dialogs should be displayed when running
scripts.

For constants, like DialogModes in the sample, click the link to go to the table that shows allowed values.
Constants are represented by objects, and allowed values are properties of those objects. Specify a
constant value in the form ConstantName.VALUE. For example:

app.displayDialogs = DialogModes.ERROR;

The Methods table for an object lists the following:

e The method name.

e The parameters list.

e The parameter value types, on lines corresponding to each parameter.
e Return value type

e Adescription of what the method does, and further descriptions of parameters, if needed.

37
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Method Parameter type Returns What it does
crop Crops the document. The
(bounds %flriat%aolfu e4 bounds parameter is an array of
[, angle] number four coordinates for the region
E' ‘lflléciltit]:] ) Unitvalue remaining after cropping, [left,
! g UnitValue top, right, bottom].

When a parameter type or return value is a constant or another object, the value is a hypertext link to the
listing for that constant or object.

Parameters can be required or optional. Optional parameters are indicated in the table by square brackets
(). In the example, the first parameters, bounds, is required. The remaining parameters are all optional.

You must pass a value for each required parameter. You can leave out optional parameters if there are no
remaining values to pass; however, if you wish to use the default value for any optional parameter that is
not the last one specified, pass undefined as a placeholder. You must enter the values in the order they are
listed, so that the JavaScript compiler knows which value you are entering.

For example, the following passes only the required parameter (using a previously-defined variable for the
bounding region):

app.activeDocument.crop ( myRegion ) ;

The following skips the angle parameter, specifies the width value, and omits the final height value:

var myWidth = new UnitValue( "500 pixels" );
app.executeAction ( myRegion,undefined, myWidth ) ;
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This object provides a dictionary-style mechanism for storing data as key-value pairs. It can be used for
low-level access into Photoshop. See an example of this usage in ‘Selection sample script’ on page 169.

Many configuration files use serialized action descriptors to represent their data. It is used, for example, to
encapsulate playback options in Application.playbackParameters, and is returned by

Application.getCustomOptions().

Property Value type What it is

count number Read-only. The number of keys contained in the descriptor.

typename string Read-only. The class name of the referenced

actionDescriptor object.

Method Parameter type Returns What it does

clear Clears the descriptor.
0

erase Erases a key from the descriptor.
(key) number

fromStream Creates a descriptor from a stream
(value) string of bytes; for reading from disk.

getBoolean boolean Gets the value of a key of type
(key) number boolean.

getClass number Gets the value of a key of type
(key) number class.

getData string Gets raw byte data as a string
(key) S value.

getDouble number Gets the value of a key of type
(key) number double.

getEnumerationType nurmber Gets the enumeration type of a
(key) number key.

getEnumerationValue number Gets the enumeration value of a
(key) number key.

getInteger number Gets the value of a key of type
(key) number integer.

getKey number Gets the ID of the Nth key,
(index) number provided by index.
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Method Parameter type Returns What it does (Continued)

getList ActionList Gets the value of a key of type list.
(key) number

getObjectType nurmber Gets the class ID of an object in a
(key) number key of type object.

getObjectValue ActionDescriptor |Gets the value of a key of type
(key) number object.

getPath File Gets the value of a key of type
(key) number File.

getReference ActionReference  Getsthe value of a key of type
(key) number ActionReference.

getString string Gets the value of a key of type
(key) S string.

getType DescValueType Gets the type of a key.
(key) number

getUnitDoubleType number Gets the unit type of a key of type
(key) number UnitDouble.

getUnitDoubleValue number Gets the value of a key of type
(key) S UnitDouble.

hasKey boolean Checks whether the descriptor
(key) number contains the provided key.

isEqual boolean Determines whether the
(otherDesc) ActionDescriptor descriptor is the same as another

descriptor.

putBoolean Sets the value for a key whose type
(key, number is boolean.
value) boolean

putClass Sets the value for a key whose type
(key, number is class.
value) number

putData Puts raw byte data as a string
(key, number value.
value) string

putDouble Sets the value for a key whose type
(key, number is double.
value) number

putEnumerated Sets the enumeration type and
(key, number value for a key.
enumType, number number
value)

putInteger Sets the value for a key whose type
(key, number is integer.

number

value)
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Method Parameter type Returns What it does (Continued)
putList Sets the value for a key whose type
(key, number isan ActionList object.
value) ActionList
putObject Sets the value for a key whose type
(key, nuger is an object, represented by an
classID, numoer i i
atne) ActionDescriptor Action Descriptor.
putPath Sets the value for a key whose type
(key, i is path.
value) File
putReference Sets the value for a key whose type
(key, number is an object reference.
value) ActionReference
putString Sets the value for a key whose type
(key, number is string.
value) string
putUnitDouble Sets the value for a key whose type
(key, nuger is a unit value formatted as a
unitID, S double
value) number
toStream string Gets the entire descriptor as a

0

stream of bytes, for writing to disk.
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This object provides an array-style mechanism for storing data. It can be used for low-level access into

Photoshop.

This object is ideal when storing data of the same type. All items in the list must be of the same type.

You can use the "put" methods, such as putBoolean(), to append new elements, and can clear the entire
list using clear(), but cannot otherwise modify the list.

Note: The ActionList objectis part of the Action Manager functionality. For details on using the Action
Manager, see the Photoshop CS4 Scripting Guide.

Property Value type What it is

count number Read-only. The number of commands that comprise the
action.

typename string Read-only. The class name of the referenced

ActionList object.

With the exception of the clear () method, you use the methods of this object to either get the value of a
specific type of data in the list or set (put) the value type.

Method Parameter type  Returns What it does

clear Clears the list.
()

getBoolean boolean Gets the value of a list element of
(index) numbex type boolean.

getClass number Gets the value of a list element of
(index) number type class.

getData string Gets raw byte data as a string
(index) number value.

getDouble number Gets the value of a list element of
(index) number type double.

getEnumerationType number Gets the enumeration type of a list
(index) number element.

getEnumerationValue number Gets the enumeration value of a
(index) number list element.

getInteger number Gets the value of a list element of
(index) number

type integer.
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Method Parameter type  Returns What it does (Continued)

getList ActionList Gets the value of a list element of
(index) numbex type list.

getObjectType number Gets the class ID of a list element
(index) number of type object.

getObjectValue ActionDescriptor Getsthe value of a list element of
(index) number type object.

getPath File Gets the value of a list element of
(index) number type File.

getReference ActionReference  Getsthe value of a list element of
(index) numbex type ActionReference.

getString string Gets the value of a list element of
(index) number type string.

getType DescValueType Gets the type of a list element.
(index) number

getUnitDoubleType number Gets the unit value type of a list
(index) number element of type Double.

getUnitDoubleValue number Gets the unit value of a list
(index) numbex element of type double.

putBoolean Appends a new value, true or
(value) boolean false.

putClass Appends a new value, a class or
(value) number data type.

putData Appends a new value, a string
(value) string containing raw byte data.

putDouble Appends a new value, a double.
(value) number

putEnumerated Appends a new value, an
(enumType, number enumerated (constant) value.
value) number

putInteger Appends a new value, an integer.
(value) number

putList Appends a new value, a nested
(value) Actionbist action list.

putObject Appends a new value, an object.
(classID, number .
value) ActionDescriptor

putPath Appends a new value, a path.
(value) File

putReference Appends a new value, a reference
(value) ActionReference to an object created in the script.




JavaScript Scripting Reference

Adobe Photoshop CS4

JavaScript Object Reference 44

Method Parameter type  Returns What it does (Continued)
putString Appends a new value, a string.
(value) string
putUnitDouble Appends a new value, a unit/value
(classID, number pair.
number

value)
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This object provides information about what the action is refering to. For example, when referring to the
name of something you might use keyName. The reference would also need to know what name you are
referring to. In this case you could use classDocument for the name of the document or classLayer for the
name of the layer. It can be used for low-level access into Photoshop.Contains data associated with an
ActionDescriptor.

Property Value type What it does
typename string Read-only. The class name of the referenced Action
object.
Method Parameter type Returns What it does
getContainer ActionReference | Gets a reference contained in this
0 reference.
Container references provide
additional pieces to the reference.
This looks like another reference,
but it is actually part of the same
reference.
getDesiredClass number Gets a number representing the
0 class of the object.
getEnumeratedType number Gets the enumeration type.
0
getEnumeratedvValue number Gets the enumeration value.
0
getForm ReferenceFormType Gets the form of this action
0 reference.
getIdentifier number Gets the identifier value for a
0 reference whose form is identifier.
getIndex number Gets the index value for a
0 reference in a list or array.
getName string Gets the name of a reference.
0
getOffset number Gets the offset of the object’s

0 index value.

getProperty number Gets the property ID value.
0
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Method Parameter type Returns What it does (Continued)
putClass Puts a new class form and class
(desiredClass) number type into the reference.
putEnumerated Puts an enumeration type and ID
(desiredClass, nuger into a reference along with the
enumType, numoer i
e number desired class for the reference.
putIdentifier Puts a new identifier and value into
(desiredClass, number the reference.
value) number
putIndex Puts a new index and value into
(desiredClass, number the reference.
value) number
putName Puts a new name and value into
(desiredClass, number the reference.
value) string
putOffset Puts a new offset and value into
(desiredClass, number the reference.
value) number
putProperty Puts a new property and value into
(desiredClass, number the reference.
number

value)
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The Adobe Adobe Photoshop CS4 application object, which is the root of the object model and provides
access to all other objects. This object provides application-wide information, such as application defaults
and available fonts. It provides many important methods, such as those for opening files and loading
documents.
To access the properties and methods, you can use the pre-defined global variable app. For example:

var docRef = app.documents.add (800, 600, 72, "docRef", NewDocumentMode.RGB) ;
The properties and methods of the application object are also available at the top level; you can omit
references to the application object altogether. For example:

var docRef = documents.add (800, 600, 72, "docRef", NewDocumentMode.RGB) ;

This usage can be somewhat ambiguous; for clarity, it is recommended that you use an explicit reference

to app.

Property Value type Whatit is

activeDocument Document Read-write. The frontmost document.
Setting this property is equivalent to clicking an
open document in the Adobe Photoshop CS4
application to bring it to the front of the screen.
Tip: If there is no open document, accessing this

property throws an exception.

backgroundColor SolidColor Read-write. The default background color and color
style for documents.

build string Read-only. Information about the application.

colorSettings string Read-write. The name of the current color settings,
as selected with Edit > Color Settings.

displayDialogs DialogModes Read-write. The dialog mode for the application,
which controls what types of dialogs should be
displayed when running scripts.

documents Documents Read-only. The collection of open documents.
This is the primary point of access for documents
that are currently open in the application. The array
allows you to access any open document, or to
iterate through all open documents.

fonts TextFonts Read-only. The fonts installed on this system.

foregroundColor SolidColor Read-write. The default foreground color (used to
paint, fill, and stroke selections).

freeMemory number Read-only. The amount of unused memory

available to Adobe Photoshop CS4.
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Property

Value type

What it is (Continued)

locale

macintoshFileTypes

measurementLog
name

notifiers

notifiersEnabled

path

playbackDisplayDialogs

playbackParameters

preferences

preferencesFolder
recentFiles
scriptingBuildDate
scriptingVersion

systemInformation

typename

string

array of string

MeasurementLog

string

Notifiers

boolean

File

DialogModes

ActionDescriptor

Preferences

File
array of File
string
string

string

string

Read-only. The language location of the
application.

An Adobe locale code consists of a 2-letter ISO-639
language code and an optional 2-letter ISO 3166
country code separated by an underscore. Case is
significant. For example, en Us, en UK, ja_JB de DE,
fr FR.

Read-only. A list of file image types Adobe
Photoshop CS4 can open.

The log of measurements taken.
Read-only. The application's name.

Read-only. The collection of notifiers currently
configured (in the Scripts Events Manager menu in
the Adobe Photoshop CS4 application).

Read-write. True if all notifiers are enabled.

Read-only. The full path to the location of the
Adobe Photoshop CS4 application.

Read-write. The dialog mode for playback mode,
which controls what types of dialog to display
when playing back a recorded action with the
Actions palette.

Read-write. Stores and retrieves parameters used as
part of a recorded action. Can be used, for example,
to control playback speed.

Read-only. The application preference settings
(equivalent to selecting Edit > Preferences in the
Adobe Photoshop CS4 application in Windows or
Photoshop > Preferences in Mac OS).

Read-only. The full path to the Preferences folder.
Read-only. Files in the Recent Files list.

Read-only. The build date of the Scripting interface.
Read-only. The version of the Scripting interface.
Read-only. Runtime details of the application and
system.

Read-only. The class name of the referenced app
object.
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Property Value type What it is (Continued)
version string Read-only. The version of Adobe Photoshop
application you are running.
windowsFileTypes array of string Read-only. A list of file image extensions Adobe
Photoshop CS4 can open.
Method Parameter type Returns What it does
batch string Runs the batch automation routine
(inputFiles, air"le of File (similar to the File > Automate >
. string

?EZ;On’ string Batch command).

[, options]) BatchOptions The inputFiles parameter specifies
the sources for the files to be
manipulated by the batch command.

beep Causes a "beep" sound.
0
bringToFront Makes Adobe Photoshop C54 the
0 active (front-most) application.
charIDToTypeID number Converts from a four character code
(charID) string (character ID) to a runtime ID.
doAction Plays an action from the Actions
(action, string palette. The action parameter is the
from) string name of the action, the from
parameter is the name of the action
set.
eraseCustomOptions Erases the user object with specified
(key) string ID value from the Photoshop registry.
executeAction ActionDescriptor |Playsan Action Manager event.
(eventID number .
[, descriptor] ActionDescriptor
[, displayDialogs]) DialogModes
executeActionGet ActionDescriptor Obtainsinformation abouta
(reference) ActionReference predefined or recorded action.
featureEnabled boolean Determines whether the feature
(name) string specified by name is enabled.

The following features are supported
as values for name:

"photoshop/extended"
"photoshop/standard"
"photoshop/trial"
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etho arameter type eturns at it does (Continue
Method P ter ty Ret What it does (Continued)
getCustomOptions ActionDescriptor Retreives user objectsin the
(key) string Photoshop registry for the ID with
value key.
load Loads a support file (as opposed to a
(document ) File Photoshop image document) from
the specified location.
makeContactSheet string Creates a contact sheet from the
(inputFiles array of File specified files.
[, options]) ContactSheetOptions
makePDFPresentation string Creates an Adobe PDF presentation
(inputFiles, array of File file from the specified input files.
outputFiles File , , . .
[, options]) PresentationOptions The return string contains the path to
the PDF file.
makePhotoGallery string Creates a web photo gallery from the
(inputFolder, File files in the specified input folder.
outputFolder File .
[, options]) GalleryOptions
makePhotomerge string DEePRECATED for Adobe Photoshop CS4.
(inputFiles) array of File Use provided script:
runphotomergeFromScript = true;
S.evalFile( app.path +
"Presets/Scripts/Photomerge.jsx")
photomerge . createPanorama (
filelList, displayDialog ) ;
Merges multiple files into one, with
user interaction required.
makePicturePackage string Creates a picture package from the

(inputFiles
[, options])

array of File

PicturePackageOptions

specified input files.
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Method

Parameter type Returns

What it does (Continued)

open
(document
[, asl]

[, asSmartObject])

openDialog
0

purge
(target)

putCustomOptions

(key,
customObject
[, persistent])

refresh
()

runMenuItem
(menulID)

stringIDToTypelID
(stringID)

Document
File
object or OpenDocumentType
boolean

array of File

PurgeTarget

string
ActionDescriptor
boolean

number

number
string

Opens the specified document.

Use the optional as parameter to
specify the file format using the
constants in OpenDocumentType; Of,
you can specify a file format together
with its open options using these
objects:

CameraRAWOpenOptions
DICOMOpenOptions
EPSOpenOptions
PDFOpenOptions
PhotoCDOpenOptions
RawFormatOpenOptions

Use the optional parameter
asSmartObject (default: false) to
create a smart object around the
opened document.

See the Application sample scripts for
an example of using the File object
in the open method.

Invokes the Photoshop Open dialog
box for the user to select files.

Returns an array of File objects for
the files selected in the dialog.

Purges one or more caches.

Saves a customized settings object in
the Photoshop registry.

key is the unique identifier for your
custom settings.

customObiject is the object to save in
the registry.

persistent indicates whether the
object should persist once the script
has finished.

Pauses the script while the
application refreshes. Use to slow
down execution and show the results
to the user as the script runs. Use
carefully; your script runs much more
slowly when using this method.

Run a menu item given the menu ID.

Converts from a string ID to a runtime
ID.
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Method Parameter type Returns What it does (Continued)

togglePalettes Toggle palette visibility.
()

typeIDToCharID string Converts from a runtime IDto a
(typeID) number character ID.

typeIDToStringID string Converts from a runtime ID to a string
(typelID) number ID.

Application.jsx

This script invokes an alert box to display Properties important to an application such as version number,
the path to the application, the amount of memory available, and the number of documents open.

When a user presses the OK button on the alert box, a second dialog opens, which asks users whether they
would like the foreground and background colors set for the document presently open. If no document is

open, the script opens a new document for the user.

The script (with no document open) produces a progression of three dialogs.

//Create a Welcome message

// Use the name and version properties of the application object to
// BAppend the application’s name and version to the Welcome message

// use "\r" to insert a carriage return

// use the combination operator += to append info to the message

var message = "Welcome to " + app.name

message += " version " + app.version + "\r\r"

// find out where Adobe Photoshop CS4 is installed

// and add the path to the message

// add the optional parameter fsName to the path property
// to display the file system name in the most common format
message += "I’'m installed in " + app.path.fsName + "\r\r"

// see how much memory Adobe Photoshop CS4 has to play with
message += "You have this much memory available for Adobe Photoshop CS4: " +

app.freeMemory + "\r\r"

// use the length property of the documents object to

// see how many documents are open
var documentsOpen = app.documents.length

message += "You currently have " + documentsOpen + " document (s) open.\r\r"

// display the message to the user
alert (message)

// answer will be true for a "Yes" answer and false for a "No" answer
var answer = confirm("Set the foreground and background to my favorite colors?")

// set the colors
if (answer)

// I don’t have a favorite color. Why did I ask you may wonder?

app . foregroundColor.rgb.red = Math.random/()
app . foregroundColor.rgb.green = Math.random()

* 255
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app.foregroundColor.rgb.blue = Math.random() * 255
app.backgroundColor.rgb.red = Math.random() * 255
app.backgroundColor.rgb.green = Math.random() * 255
app.backgroundColor.rgb.blue = Math.random() * 255

// Open a document
if (app.documents.length == 0) {

// use the application’s path and the offset to the samples folder
var sampleDocToOpen = File (app.path + "/Samples/Fish.psd")

// compose a message with the name of the file

message = "Would you like me to open a sample for you? ("
message += sampleDocToOpen. fsName

message += ")"

// ask the user another question
answer = confirm(message)

// open the document accordingly
if (answer)
open (sampleDocToOpen)

}

PDFPresentation.jsx
This script presents a progression of images as an Adobe PDF slide show.

// use all the files in the Samples folder
var inputFolder = new Folder (app.path + "/Samples/")

// see if we have something interesting
if (inputFolder != null) ({

// get all the files found in this folder that are Adobe Photoshop CS4 (.psd
format)
var inputFiles = inputFolder.getFiles("*.psd")

// output to the desktop
var outputFile = File("~/Desktop/JavaScriptPresentation.pdf")

// there are defaults but I like to set the options myself
var options = new PresentationOptions
options.presentation = true

options.view = true

options.autoAdvance = true

options.interval = 5

options.loop = true

options.transition = TransitionType.RANDOM

// create the presentation
makePDFPresentation (inputFiles, outputFile, options)

alert ("Presentation file saved to: " + outputFile.fsName)

}
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An object within a document that contains the visual elements of the image (equivalent to a layer in the
Adobe Photoshop CS4 application).

Access an art layer in a document through the Document.artLayers collection. You can access a layer by

name; for example:

var layerRef = app.activeDocument.artLayers.getByName ("my layer") ;
layerRef.allLocked = true;

Access the art layers in a layer set through the LayerSet.artLayers collection in the parent set.

Property

Value type

Whatitis

allLocked

blendMode

bounds

fillOpacity

filterMaskDensity

filterMaskFeather

grouped

isBackgroundLayer

kind

layerMaskDensity

boolean

BlendMode

array of

UnitValue

number [0.0..100]

double

double

boolean

boolean

LayerKind

double

Read-write. True to completely lock the contents and
settings of this layer.

Read-write. The blending mode.

Read-only. An array of coordinates that describes the
bounding rectangle of the layer.

Read-write. The interior opacity of the layer, a
percentage value.

Read-write. The density of the filter mask (between
0.0 and 250.0)

Read-write. The feather of the filter mask (between 0.0
and 250.0)

Read-write. True if this layer is grouped with the layer
beneath it.

Read-write. True if this is the background layer of the
document. A document can have only one
background layer. If there is no background layer,
setting this to true causes this to become the
background layer.

Read-write. Sets the type (such as 'text layer') for an
empty layer.

Valid only when the layer is empty and when
isBackgroundLayer is false. See
isBackgroundLayer.

You can use the kind property to make a background
layer a normal layer; however, to make a layer a
background layer, you must set i sBackgroundLayer
to true.

Read-write. The density of the layer mask (between
0.0 and 100.0)
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Property Value type What it is (Continued)

layerMaskFeather double Read-write. The feather of the layer mask (between
0.0 and 250.0)

linkedLayers array of ArtLayer |Read-only. The layers linked to this layer. See

or LayerSet ArtLayer.link.

name string Read-write. The name.

opacity number [0.0..100.0]. Read-write. The master opacity of the layer, a
percentage value.

parent Document Read-only. The object's container.

pixelsLocked boolean Read-write. True if the pixels in the layer’s image
cannot be edited using the paintbrush tool.

positionLocked boolean Read-write. True if the pixels in the layer’s image
cannot be moved within the layer.

textItem TextItem Read-only. The text item that is associated with the
layer.
Valid only when kind = LayerKind.TEXT.

transparentPixelsLocked boolean Read-write. True if editing is confined to the opaque
portions of the layer.

typename string Read-only. The class name of the referenced
artLayer object.

vectorMaskDensity double Read-write. The density of the vector mask (between
0.0 and 250.0)

vectorMaskFeather double Read-write. The feather of the vector mask (between
0.0 and 250.0)

visible boolean Read-write. True if the layer is visible.

xmpMetadata xmpMetadata Read-write. Metadata for the layer.
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Method Parameter type Returns What it does
adjustBrightnessContrast Adjusts the brightness in the

(brightness, number range [-100..100] and contrast
contrast) number [-100..100].
adjustColorBalance Adjusts the color balance of the
( [shadows] array of number layer’'s component channels. For
[, midtones] array of number shadows, midtones, and

highligh array of number
[! proserseran boolean highlights, the array must

include three values in the
range [-100..100], which
represent cyan or red, magenta
or green, and yellow or blue,
when the document mode is
CMYK or RGB.

[, preserveluminosity]

See Document.mode.

adjustCurves Adjusts the tonal range of the
(curveShape) array of array of number selected channel using up to
fourteen points.

Each value in the curveShape
array is a point pair, an array of
an x and y integer value.

adjustLevels [ | Adjusts the levels of the
(inputRangeStart, number [0..253 selected channels
inputRangeEnd, number [(start + 2)..255]

number [0.10..9.99]

inputRangeGamma,

outputRangeStart, number [0..253]

outputRangeEnd) number [ (start + 2)..255]
applyAddNoise Applies the Add Noise filter

(amount, number .[0'1 ~'4OO] . amount is a percentage value.

distribution, NoigeDistribution

monochromatic) boolean
applyAverage Applies the Average filter.

()
applyBlur Applies the Blur filter.

()
applyBlurMore Applies the Blur More filter.

()
applyClouds Applies the Cloud:s filter.

()
applyCustomFilter Applies a custom filter.

e array of number
(ziz;:cterlstlcs, number The characteristics array has
offset) number 25 members.

See Adobe Photoshop CS4 Help
for specific instructions.
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Method Parameter type Returns |What it does (Continued)
applyDelInterlace Applies the De-Interlace filter.
(eliminateFields, EliminateFields
createFields) CreateFields
applyDespeckle Applies the Despeckle filter.

0

applyDifferenceClouds
0

applyDiffuseGlow

(graininess,
glowAmount,
clearAmount)

applyDisplace
(horizontalScale,
verticalScale,
displacement,
undefinedareas,
displacementMapFiles)

applyDustAndScratches

(radius,
threshold)

applyGaussianBlur
(radius)

applyGlassEffect
(distortion,
smoothness,
scaling
[, invert]
[, texture]
[, textureFile])

applyHighPass
(radius)

number [0..10]
number [0..20]
number [0..20]

number [-999..999]
number [-999..999]
DisplacementMapType

UndefinedAreas
File

number [1..100]
number [0..255]

number [0.1..250.0]

number [0..20]
number [1..15]
number [50..200]
boolean

TextureType
File

number [0.1..250.0]

Applies the Difference Clouds
filter.

Applies the Diffuse Glow filter.

Applies the Displace filter using
the specified horizontal and
vertical scale, mapping type,
treatment of undistorted areas,
and path to the distortion
image map.

Applies the Dust & Scratches
filter.

Applies the Gaussian Blur filter
within the specified radius (in
pixels)

Applies the Glass filter.

scalingis a percentage value.

Applies the High Pass filter
within the specified radius.
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Method Parameter type Returns |What it does (Continued)
applyLensBlur Applies the Lens Blur filter.
DepthMapSource
( [[Soggims cance] nurber source: The source for the
¥ invertDepthMap] boolean depth map (default:
[, shape] Geometry DepthMapSource .NONE)
[, radius] number
[, bladeCurvature] number focalDistance : The blur focal
[, rotation] nuﬁer distance for the depth map
[, brightness] amost default: o).
[, threshold] number ( )
[, amount] ;unlwbeli; Ctributs invertDepthMask : True if the
[, distribution] C-SELIELIIDULION depth map is inverted (default:
[, monochromatic] boolean P P (
) false).
shape: The shape of the iris
(default: Geometry . HEXAGON)
radius: The radius of the iris
(default: 15).
bladeCurvature: The blade
curvature of the iris (default: o).
rotation: The rotation of the
iris (default: o)
brightness: The brightness for
the specular highlights (default:
0).
threshold: The threshold for
the specular highlights (default:
0).
amount: The amount of noise
(default: 0)
distribution: The distribution
value for the noise (default:
NoiseDistribution.UNIFORM).
monochromatic: True if the
noise is monochromatic
(default: false).
applyLensFlare Applies the Lens Flare filter with
(brightness, number(U evalue) the specified brightness (0 - 300,
flareCenter, i;z% eeE as a percentage), the x and y
lensType) coordinates (unit value) of the
flare center, and the lens type.
applyMaximum Applies the Maximum filter
(radius) number [1..100] within the specified radius (in
pixels).
applyMedianNoise Applies the Median Noise filter
(radius) number [1..100] within the specified radius (in

pixels).
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Method Parameter type Returns |What it does (Continued)
applyMinimum Applies the Minimum filter
(radius) number [1..100] within the specified radius (in
pixels) (1 - 100).
applyMotionBlur Applies the Motion Blur filter.
(angle, number [-360..360]
radius) number [1..999]
applyNTSC Applies the NTSC colors filter.
()
applyOceanRipple Applies the Ocean Ripple filter.
(size, number [1..15]
magnitude) number [0..20]
applyOffset Moves the layer the specified
(horizontal, 751’1}1;361111(5 amount horizontally and
. ni alue . .
ﬁg‘;iii&reas) OffsetUndefinedAreas vertically (mm/ma'x amoun.ts
depend on layer size), leaving
an undefined area at the layer’s
original location.
applyPinch Applies the Pinch filter.
(amount) number [-100..100]

applyPolarCoordinates
(conversion)

applyRadialBlur
(amount,

blurMethod,
blurQuality)

applyRipple
(amount,
size)

applySharpen
0

applySharpenEdges
0

applySharpenMore
0

applyShear
(curve,
undefinedAreas)

PolarConversionType

number [1..100]
RadialBlurMethod
RadialBlurQualit

number [-999..999]
RippleSize

array of array of number
UndefinedAreas

amount is a percentage value.

Applies the Polar Coordinates
filter.

Applies the Radial Blur filter in
the specified amount, using
either a spin or zoom effect and
the specified quality.

Applies the Ripple filter in the
specified amount, throughout
the image and in the specified
size.

Applies the Sharpen filter.

Applies the Sharpen Edges filter.

Applies the Sharpen More filter.

Applies the Shear filter. The
curve defines a curve with
[2..255] points.

Each value in the curve array is a
point pair, an array of an x and y
integer value.
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Method Parameter type Returns |What it does (Continued)
applySmartBlur Applies the Smart Blur filter.
(radius, number [0.1..100.0]
threshold number [0.1..100.0]
blurQualiéy SmartBlurQuality
mode) ! SmartBlurMode
applySpherize Applies the Spherize filter.
number [-100..100]
(;:fi:l;t’ SpherizeMode amount is a percentage value.
applyStyle Applies the specified style to the
(styleName) string layer. You must use a style from
the Styles list in the Layer Styles
Palette.
applyTextureFill Applies the Texture Fill filter.
(textureFile) File
applyTwirl Applies the Twirl filter.
(angle) number [-999..999]
applyUnSharpMask Applies the Unsharp Mask filter.
(amount, number [1..500] (amount is a percentage value.
radius number [0.1..250.0]
threshéld) number [0..255]
applyWave Applies the Wave filter.
(generatorNumber, number [1..999]
minimumiavelength, nurber [1..998] Scale factors are percentage
mascimumiavelength, number [2..min+1] values.
minimumAmplitude, number[l..99§]
maximumAmplitude, nurber [2..min+1]
horizontalScale, nurber [1..100]
verticalScale, ;umbif [1..100]
T , ave ygge
XigifXEZdAreas UndefinedAreas
randomSeed) number
applyZzigZag Applies the Zigzag filter.
(amount , number [-100..100]
ridges number [0..20]
style) ! ZigZagType
autoContrast Adjusts the contrast of the
0 selected channels automatically.
autoLevels Adjusts the levels of the
0 selected channels using the
auto levels option.
clear Cuts the layer without moving it

to the clipboard.
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Method Parameter type

Returns

What it does (Continued)

copy

( [merge] ) boolean

cut
()

desaturate
()

duplicate

([relativeObject] ArtLayer or LayerSet

[, insertionLocation]) ElementPlacement

equalize
0

invert

0

link
(with) ArtLayer or LayerSet

merge

ArtLayer
or

LayerSet

ArtLayer

Copies the layer to the
clipboard. When the optional
argument is set to true, a
merged copy is performed (that
is, all visible layers are copied to
the clipboard).

Cuts the layer to the clipboard.

Converts a colorimage to a
grayscale image in the current
color mode by assigning equal
values of each component color
to each pixel.

Creates a duplicate of the object
on the screen.

Redistributes the brightness
values of pixels in an image to
more evenly represent the
entire range of brightness levels
within the image.

Inverts the colors in the layer by
converting the brightness value
of each pixel in the channels to
the inverse value on the
256-step color-values scale.

Links the layer with the
specified layer.

Merges the layer down,
removing the layer from the
document; returns a reference
to the art layer that this layer is
merged into.
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Method

Parameter type

Returns

What it does (Continued)

mixChannels
(outputChannels
[, monochrome])

move
(relativeObject,

insertionLocation)

photoFilter
([fillColor]
[, density]

[, preserveluminosityl])

posterize
(levels)

rasterize
(target)

remove

array of array of number
boolean

ArtLayer or LayerSet
ElementPlacement

SolidColor
number [1..100]
boolean

number [2..225]

RasterizeType

Modifies a targeted (output)
color channel using a mix of the
existing color channels in the
image.

The outputChannels
parameter is an array of channel
specifications. For each
component channel, specify a
list of adjustment values in the
range [-200..200] followed by a
‘constant’ value [-200..200].)

When monochrome = true, the
maximum number of channel
value specifications is 1.

Valid only when docRef . mode =
DocumentMode .RGB OF CMYK.

RGB arrays must include four
values. CMYK arrays must
include five values.

Moves the layer relative to the
object specified in parameters.

For art layers, only the constant
values ElementPlacement .
PLACEBEFORE and PLACEAFTER
are valid.

For layer sets, only the constant
values ElementPlacement .
PLACEBEFORE and INSIDE are
valid.

Adjust the layer’s color balance
and temperature as if a color
filter had been applied.

density is a percentage value.

Specifies the number of tonal
levels for each channel and then
maps pixels to the closest
matching level.

Converts the targeted contents
in the layer into a flat, raster
image.

Deletes the object.
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Method Parameter type Returns |What it does (Continued)
resize Resizes the layer to the specified
([horizontall nuﬁer dimensions (as a percentage of
[, verticall erllcheo];:]?osition its current size) and places itin
[, anchor]) the specified position.
rotate Rotates rotates the layer around
(angle gumk}’ler et the specified anchor point
[, anchor]) fchoz o8 tn (default: MIDDLECENTER).
selectiveColor Modifies the amount of a
(selectionMethod AdjustmentReference process color in a specified
ds] array of number . . .
[, reds array of number primary color without affecting
{' ;iiii:]S] array of number the other primary colors.
! array of number
[, cyans] arrég of nﬁmber Each color array must have four
, bl
E magiii]:as] array of number values.
[' whites] array of number
[' neutrals] array of number
[' blacks]) array of number
shadowHighlight Adjusts the range of tonesin the
( [shadowAmount ] number [0..100] image’s shadows and highlights.
[, shadowWidth] pumber [0.100] ,
[, shadowRadius] number [0..2500] Amounts and widths are
[, highlightAmount] nuﬁer Eg' '188% percentage values. Radius
, highlightWidth pumber LY. . in pi
% highlighw;diu]s] nutber [0 .2500] values are in pixels.
[, colorCorrection] number [-100..100]
[, midtoneContrast] number  [-100..100]
[, blackClip] number [0.000..50.000]
[’ whiteClip]) number [0.000..50.000]
threshold Converts grayscale or color
(level) number [1..255] images to high-contrast, B/W
images by converting pixels
lighter than the specified
threshold to white and pixels
darker than the threshold to
black.
translate Moves the layer the specified
([deltax] UnitValue amount (in the given unit)
[, deltay]) UnitValue . . .
, —_— relative to its current position.
unlink Unlinks the layer.

0

The following script opens all the files in the samples folder, creating one multi-layered document. Each
layer is pasted into one of four quadrants and given 50% transparency. Finally the layers are sorted by

name.

ArtLayer.jsx
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// Save the current preferences

var startRulerUnits = app.preferences.rulerUnits
var startTypeUnits = app.preferences.typelUnits
var startDisplayDialogs = app.displayDialogs

// Set Adobe Photoshop CS4 to use pixels and display no dialogs
app.preferences.rulerUnits = Units.PIXELS
app.preferences.typeUnits = TypeUnits.PIXELS
app.displayDialogs = DialogModes.NO

//Close all the open documents
while (app.documents.length)
app.activeDocument.close ()

}

// Create a new document to merge all the samples into
var mergedDoc = app.documents.add (1000, 1000, 72, "Merged Samples",
NewDocumentMode .RGB, DocumentFill.TRANSPARENT, 1)

// Use the path to the application and append the samples folder
var samplesFolder = Folder (app.path + "/Samples/")

//Get all the files in the folder
var fileList = samplesFolder.getFiles ()

// open each file
for (var i = 0; i < fileList.length; i++) {
// The fileList is folders and files so open only files
if (fileList[i] instanceof File) {
open(fileList [i])

// use the document name for the layer name in the merged document
var docName = app.activeDocument.name

// flatten the document so we get everything and then copy
app.activeDocument.flatten ()

app.activeDocument .selection.selectAll ()
app.activeDocument.selection.copy ()

// don’t save anything we did
app.activeDocument .close (SaveOptions.DONOTSAVECHANGES)

// make a random selection on the document to paste into
// by dividing the document up in 4 quadrants and pasting
// into one of them by selecting that area
var topLeftH = Math.floor (Math.random() * 2)
var topLeftV = Math.floor (Math.random() * 2)
var docH = app.activeDocument.width.value / 2
var docV = app.activeDocument.height.value / 2
var selRegion = Array (Array (topLeftH * docH, topLeftV * docV),
Array (topLeftH * docH + docH, topLeftV * docV),
Array (topLeftH * docH + docH, topLeftV * docV + docV),
*
*

Array (topLeftH * docH, topLeftV * docV + docV),

Array (topLeftH * docH, topLeftV * docV))
app.activeDocument.selection.select (selRegion)
app.activeDocument .paste ()

// change the layer name and opacity
app.activeDocument .activelLayer.name = docName
app.activeDocument.activelLayer.fillOpacity = 50
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}

// sort the layers by name

for (var x = 0; X < app.activeDocument.layers.length; x++) {

for (var y = 0; y < app.activeDocument.layers.length - 1 - x; y++) {

// Compare in a non-case sensitive way
app.activeDocument.layers [y] .name
app.activeDocument.layers [y + 1] .name
toUpperCase () > doc2.toUpperCase()) {

var docl
var doc2
if (docl.

app.activeDocument.layers [y] .move (app.activeDocument.layers [y+1],
ElementPlacement . PLACEAFTER)

}

// Reset the application preferences
app.preferences.rulerUnits = startRulerUnits
app.preferences.typeUnits = startTypeUnits

app.displayDialogs

startDisplayDialogs
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The collection of ArtLayer objects in a document or layer set.

Access through the Document.artLayers or LayerSet.artLayers collection. For example:

var layerRef

docRef .artLayers.add ()

Property Value type Whatitis
length number Read-only. The number of elements in the artLayers
collection.
parent Document Read-only. The object's container.
typename string Read-only. The class name of the referenced
artLayers object.
Method Parameter type Returns What it does
add ArtLayer Creates a new art layer in the
0 document and adds the new object to
this collection.
getByName ArtLayer Get thefirst element in the artLayers
(name) string collection with the provided name.
removeAll

0

Removes all elements from the
artLayers collection.
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Options for running a batch operation using the Application.batch() method.

JavaScript only supports folders as sources for batch commands. Specify the batch source folder as the
inputFiles parameter of the Application.batch() method.

Property Value type What it is

destination BatchDestinationType Read-write. The type of destination for the
processed files (default:
BatchDestinationType.NODESTINATION).

destinationFolder Folder Read-write. The folder location for the processed
files.

Valid only when destination =
BatchDestinationType.FOLDER.

errorFile File Read-write. The file in which to log errors
encountered.

To display errors on the screen (and stop batch
processing when errors occur) leave blank.

fileNaming array of Read-write. A list of file naming options
FileNamingType (maximum: 6)

Valid only when destination =
BatchDestinationType.FOLDER.

macintoshCompatible boolean Read-write. True to make the final file names
Macintosh compatible (default: t rue).

Valid only when destination =
BatchDestinationType.FOLDER.

overrideOpen boolean Read-write. True to override action open
commands (default: false).

overrideSave boolean Read-write. True to override save as action steps
with the specified destination (default: false).

Valid only when destination =
BatchDestinationType.FOLDER Of
SAVEANDCLOSE.

startingSerial number Read-write. The starting serial number to use in
naming files (default: 1).

Valid only when destination =
BatchDestinationType.FOLDER.

suppressOpen boolean Read-write. True to suppress the file open options
dialogs (default: false).
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Property Value type What it is (Continued)
suppressProfile boolean Read-write. True to suppress the color profile

warnings (default: false).

typename string Read-only. The class name of the referenced
batchOptions object.

unixCompatible boolean Read-write. True to make the final file name Unix
compatible (default: true).

Valid only when destination =
BatchDestinationType.FOLDER.

windowsCompatible boolean Read-write. True to make the final file names
Windows compatible (default: t rue).

Valid only when destination =
BatchDestinationType.FOLDER.
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Options for converting an image to bitmap mode, using Document.changeMode() with

ChangeMode .Bitmap.

Convert color images to grayscale before converting the image to bitmap mode. See the
ArtLayer.desaturate() method.

Property

Value type

Whatitis

angle

frequency

method

patternName

resolution

shape

typename

number [-180..180]

number [1.0..999.99]

BitmapConversionType

string

number

BitmapHalfToneType

string

Read-write. The angle (in degrees) at which to
orient individual dots. See shape.

Valid only when method =
BitmapConversionType .HALFTONESCREEN.

Read-write. The number of printer dots (per inch) to
use.

Valid only when method =
BitmapConversionType . HALFTONESCREEN.

Read-write. The conversion method to use (default:
BitmapConversionType.DIFFUSIONDITHER)

Read-write. The name of the pattern to use.

For information about pre-installed valid patterns,
see Adobe Photoshop CS4 Help on the bitmap
conversion command, or view the options availabe
in the Custom Color drop down box after choosing
the bitmap conversion command.

Valid only when method =
BitmapConversionType . CUSTOMPATTERN.

Read-write. The output resolution in pixels per inch
(default: 72. 0).

Read-write. The dot shape to use.

Valid only when method =
BitmapConversionType . HALFTONESCREEN.

Read-only. The class name of the referenced
bitmapConversionOptions object.
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BMPSaveOptions

Options for saving a document in BMP format using the Document.saveAs() method.

Properties

Property Value type Whatitis

alphaChannels boolean Read-write. True to save the alpha channels.

depth BMPDepthType Read-write. The number of bits per channel.

flipRowOrder boolean Read-write. True to write the image from top
to bottom (default: false).
Available only when osType =
OperatingSystem.WINDOWS.

osType OperatingSystem Read-write. The target OS.
(default: operatingSystem. WINDOWS).

rleCompression boolean Read-write. True to use RLE compression.
Available only when osType =
OperatingSystem.WINDOWS.

typename string Read-only. The class name of the referenced
BMPSaveOptions object.
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Options for opening a document in Camera RAW format using the Application.open() method.

Property Value type Whatit is

bitsPerChannel BitsPerChannelType Read-write. The number of bits per channel.

blueHue number [-100..100] Read-write. The blue hue of the shot.

blueSaturation number [-100..100] Read-write. The blue saturation of the shot.

brightness number [0..150] Read-write. The brightness of the shot.

chromaticAberrationBY number [-100..100] Read-write. The chromatic aberration B/Y of the
shot.

chromaticAberrationRC number [-100..100] Read-write. The chromatic aberration R/C of the
shot

colorNoiseReduction number [0..100] Read-write. The color noise reduction of the
shot.

colorSpace ColorSpaceType Read-write. The colorspace for the image.

contrast number [-50..100] Read-write. The contrast of the shot.

exposure number [-4.0..4.0] Read-write. The exposure of the shot.

greenHue number [-100..100] Read-write. The green hue of the shot.

greenSaturation number [-100..100] Read-write. The green saturation of the shot.

luminanceSmoothing number [0..100] Read-write. The luminance smoothing of the
shot.

redHue number [-100..100] Read-write. The red hue of the shot.

redSaturation number [-100..100] Read-write. The red saturation of the shot.

resolution number [1..999] Read-write. The resolution of the document in

pixels per inch.
saturation number [-100..100] Read-write. The saturation of the shot.

settings CameraRAWSettingsType Read-write. The global settings for all Camera
RAW options. Default:
CameraRAWSettingsType.CAMERA.

shadows number [0..100] Read-write. The shadows of the shot.
shadowTint number [-100..100] Read-write. The shadow tint of the shot.
sharpness number [0..100] Read-write. The sharpness of the shot.
size CameraRAWSize Read-write. The size of the new document.

temperature number [2000..50000] Read-write. The temperature of the shot.




Adobe Photoshop CS4

JavaScript Scripting Reference JavaScript Object Reference 72
Property Value type What it is (Continued)
tint number [-150..150] Read-write. The tint of the shot.
typename string Read-only. The class name of the referenced

cameraRAWOpenOptions object.

vignettingAmount number [-100..100] Read-write. The vignetting amount of the shot.

vignettingMidpoint number [-100..100] Read-write. The vignetting mid point of the
shot.

whiteBalance WhiteBalanceType Read-write. The white balance options for the

image. These are lighting conditions that affect
color balance.
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Information about a color element in the image.

Access through the Document.channels collection. You can access an individual channel object in this list
by index or by name. For example, this accesses a channel object in the active document by name and
assigns an opacity value:

var channelRef = app.activeDocument.channels.getByName ("my channel") ;
channelRef .opacity = 22;

A channel is analogous to a plate in the printing process that applies a single color. The document’s color
mode determines the number of default channels; for example, an RGB document has three channels, red,

green, and blue. A color can also have an alpha channel, which stores selections as masks, or a spot
channel, which stores spot colors.

Property Value type What it is

color SolidColor Read-write. The color of the channel.
Not valid when kind = ChannelType.COMPONENT.

histogram array of number Read-only. A histogram of the color of the channel. The
array contains 256 members.
Not valid when kind = ChannelType.COMPONENT. For
component channel histogram values, use the histogram
property of the Document object instead.

kind ChannelType Read-write. The type of the channel.

name string Read-write. The name of the channel.

opacity number [0..100] Read-write. The opacity to use for alpha channels or the
solidity to use for spot channels.
Valid only when kind = ChannelType.MASKEDAREA Of
SELECTEDAREA,

parent Document Read-only. The containing document.

typename string Read-only. The class name of the referenced channel
object.

visible boolean Read-write. True if the channel is visible.

Method Parameter type Returns What it does

duplicate Channel Duplicates the channel.

Document

( [targetDocument] )




JavaScript Scripting Reference

Adobe Photoshop CS4

JavaScript Object Reference 74

Method

Parameter type

Returns

What it does

merge

Merges a spot channel into the
component channels.

Deletes the channel.




Adobe Photoshop CS4
JavaScript Scripting Reference JavaScript Object Reference 75

The collection of Channel objects in a document.

Access through the Document.channels collection property. For example:

var channelRef = app.activeDocument.channels.add ()

Property Value type What it is
length number Read-only. The number of elements in the channels
collection.
parent Document Read-only. The containing document.
typename string Read-only. The class name of the referenced channels
object.
Method Parameter type Returns What it does
add Channel Creates a new channel object and
0 adds it to this collection.
getByName Channel Get the first element in the channels
(name) string collection with the provided name.
removeAll Removes all alpha channel objects

O from the channels collection.

The following script opens a file if one is not already open, and then writes a histogram report
(histogram.log) for the channels in the active document.

Note: This script contains a switch construction that uses a break statement. The break statement
requires an ending semicolon (;), as in the following sample:

break;
Histogram.jsx
// Function to activate all the channels according to the documents mode
// Takes a document reference for input

function TurnOnDocumentHistogramChannels (inDocument) {

// see how many channels we need to activate
var visibleChannelCount = 0

// based on the mode of the document
switch (inDocument.mode) {

case DocumentMode.BITMAP:
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case DocumentMode.GRAYSCALE:

case DocumentMode.INDEXEDCOLOR :
visibleChannelCount = 1
break;

case DocumentMode .DUOTONE :
visibleChannelCount = 2
break;

case DocumentMode.RGB:
case DocumentMode.LAB:

visibleChannelCount = 3
break;

case DocumentMode.CMYK:
visibleChannelCount = 4

break;

case DocumentMode.MULTICHANNEL:

default:
visibleChannelCount = inDocument.channels.length + 1
break;

// now get the channels to activate into a local array
var aChannelArray = new Array ()

// index for the active channels array
var aChannelIndex = 0

for (var channelIndex = 0; channelIndex < inDocument.channels.length;
channelIndex++) {
if (channelIndex < visibleChannelCount) {
aChannelArray[aChannelIndex++] = inDocument.channels [channelIndex]

// now activate them
inDocument .activeChannels = aChannelArray

// Save the current preferences

var startRulerUnits = app.preferences.rulerUnits
var startTypeUnits = app.preferences.typeUnits
var startDisplayDialogs = app.displayDialogs

// Set Adobe Photoshop CS4 to use pixels and display no dialogs
app.preferences.rulerUnits = Units.PIXELS
app.preferences.typeUnits = TypeUnits.PIXELS
app.displayDialogs = DialogModes.NO

// if there are no documents open then try to open a sample file
if (app.documents.length == 0) {
open (File (app.path + "/Samples/Fish.psd"))

// get a reference to the working document
var docRef = app.activeDocument
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// create the output file
// first figure out which kind of line feeds we need

if ($.os.search(/windows/i) != -1) ({
fileLineFeed = "Windows"

} else {
fileLineFeed = "Macintosh"

}

// create the output file accordingly

fileOut = new File("~/Desktop/Histogram.log")
fileOut.lineFeed = fileLineFeed
fileOut.open ("w", "TEXT", "??2?2°?")

// write out a header
fileOut.write ("Histogram report for " + docRef.name)

// find out how many pixels I have
var totalCount = docRef.width.value * docRef.height.value

// more info to the out file
fileOut.write (" with a total pixel count of " + totalCount + "\n")

// channel indexer
var channelIndex = 0

// remember which channels are currently active
var myActiveChannels = app.activeDocument.activeChannels

// document histogram only works in these modes

if (docRef.mode == DocumentMode.RGB | |
docRef .mode == DocumentMode.INDEXEDCOLOR | |
docRef .mode == DocumentMode.CMYK) {

// activate the main channels so we can get the documents histogram
TurnOnDocumentHistogramChannels (docRef)

// Output the documents histogram
OutputHistogram(docRef.histogram, "Luminosity", fileOut)

}

// local reference to work from
var myChannels = docRef.channels

// loop through each channel and output the histogram
for (var channelIndex = 0; channellIndex < myChannels.length; channellIndex++) {

// the channel has to be visible to get a histogram
myChannels [channelIndex] .visible= true

// turn off all the other channels
for (var secondaryIndex = 0; secondaryIndex < myChannels.length;
secondaryIndex++) {
if (channelIndex != secondaryIndex) ({
myChannels [secondaryIndex] .visible= false

}

// Use the function to dump the histogram
OutputHistogram (myChannels [channelIndex] .histogram,
myChannels [channelIndex] .name, fileOut)
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}

// close down the output file
fileOut.close()
alert ("Histogram file saved to: " + fileOut.fsName)

// reset the active channels
docRef .activeChannels = myActiveChannels

// Reset the application preferences
app.preferences.rulerUnits = startRulerUnits
app.preferences.typeUnits = startTypeUnits
app.displayDialogs = startDisplayDialogs

// Utility function that takes a histogram and name
// and dumps to the output file
function OutputHistogram(inHistogram, inHistogramName, inOutFile)

// f£ind ouch which count has the largest number
// I scale everything to this number for the output
var largestCount = 0

// a simple indexer I can reuse
var histogramIndex = 0

// see how many samples we have total
var histogramCount = 0

// search through all and find the largest single item
for (histogramIndex = 0; histogramIndex < inHistogram.length;
histogramIndex++)
histogramCount += inHistogram[histogramIndex]
if (inHistogram[histogramIndex] > largestCount)
largestCount = inHistogram[histogramIndex]

}

// These should match
if (histogramCount != totalCount) ({

alert ("Something bad is happening!")
}

// see how much each "X" is going to count as
var pixelsPerX = largestCount / 100

// output this data to the file
inOutFile.write("One X = " + pixelsPerX + " pixels.\n")

// output the name of this histogram
inOutFile.write (inHistogramName + "\n")

// loop through all the items and output in the following format

// 001

// 002

for (histogramIndex = 0; histogramIndex < inHistogram.length;
histogramIndex++)

// I need an extra "O" for this line item to keep everything in line
if (histogramIndex < 10)
inOutFile.write("0")
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// I need an extra "O" for this line item to keep everything in line
if (histogramIndex < 100)
inOutFile.write("0")

// output the index to file
inOutFile.write (histogramIndex)

// some spacing to make it look nice
inOutFile.write (" ")

// figure out how many X’'s I need
var outputX = inHistogram[histogramIndex] / largestCount * 100

// output the X's
for (var a = 0; a < outputX; a++)

inOutFile.write ("X")

inOutFile.write ("\n")

}

inOutFile.write ("\n")
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CMYKColor

Defines a CMYK color, used in the SolidColor object.

See also GrayColor, HSBColor, LabColor, NoColor, RGBColor

Properties
Property Value type What it is
black number [0.0..100.00] |Read-write. The black color value (as percent).
cyan number [0.0..100.00] |Read-write. The cyan color value (as percent).
magenta number [0.0..100.00] Read-write. The magenta color value (as percent).
typename string Read-only. The class name of the referenced cMmykcolor
object.
yellow number [0.0..100.00] Read-write. The yellow color value (as percent).
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A color sampler for a document. Access through the Document.colorSamplers collection. For example:

var colorSamplerRef = app.activeDocument.colorSamplers[0];
var currentColor = colorSamplerRef.color;

Note: For additional information about color samplers, see Adobe Photoshop CS4 help on the Color

SamplerTool.
Property Value type Whatitis
color SolidColor Read-only. The color of the color sampler.
position array of Read-only. The position of the color sampler in the
UnitValue .
—_— document. The array (x,y) represents the horizontal and
vertical location of the count item.
parent Document Read-only. The containing document.
typename string Read-only. The class name of the referenced colorsampler
object.
Method Parameter type Returns What it does
move Moves the color sampler to a new location
(position) array of in the document.
nitvValue

The position parameter (x,y) represents
the new horizontal and vertical locations
of the moved color sampler.

remove Deletes the colorsampler object.
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The collection of ColorSampler objects in a document. Access through the Document.colorSamplers
collection property. For example:

app.activeDocument .colorSamplers.removeAll ()

Property Value type What it is

length number Read-only. The number of elements in the
ColorSamplers collection.

parent Document Read-only. The containing document.

typename string Read-only. The class name of the referenced
ColorSamplers object.

Method Parameter type Returns What it does
add ColorSampler  Createsa new color sampler object
(position) array of UnitValue and adds it to this collection.

The position parameter (x,y)
represents the new horizontal and
vertical locations of the moved color
sampler.

removeAll Removes all colorsampler objects
0 from the colorsamplers collection.




JavaScript Scripting Reference

Adobe Photoshop CS4

JavaScript Object Reference 83

Options for creating a contact sheet with the Application.makeContactSheet() method.

Property Value type Whatitis

acrossFirst boolean Read-write. True to place the images horizontally
(left to right, then top to bottom) first (default: true).

bestFit boolean Read-write. True to rotate images for the best fit
(default: false).

caption boolean Read-write. True to use the filename as a caption for
the image (default: true).

columnCount number [1..100] Read-write. The number of columns to include
(default: 5).

flatten boolean Read-write. True to flatten all layers in the final
document (default: true).

font GalleryFontType Read-write. The font used for the caption (default:
GalleryFontType.ARIAL).

fontSize number Read-write. The font size to use for the caption
(default: 12).

height number [0..29000] Read-write. The height (in pixels) of the resulting
document (default: 720).

horizontal number Read-write. The horizontal spacing (in pixels)
between images (default: 1).

mode NewDocumentMode Read-write. The document color mode (default:
NewDocumentMode . RGB).

resolution number [35..1200] Read-write. The resolution of the document in pixels
per inch (default: 72. 0).

rowCount number [1..100] Read-write. The number of rows to use (default: 6).

typename string Read-only. The class name of the referenced
contactSheetOptions object.

useAutoSpacing boolean Read-write. True to auto space the images (default:
true).

vertical number [0..29000] Read-write. The vertical spacing (in pixels) between
images (default: 1).
Valid only when useAutoSpacing = false.

width number [100..29000] Read-write. The width (in pixels) of the resulting

document (default: 576).
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A counted item in a document. Access through the Document.countltems collection. See the
Document.autoCount() method.

Note: This feature is available in the Extended Version only.

For additional information about count items, see Adobe Photoshop CS4 help on the Count Tool.

Property Value type Whatit is

position array of Read-only. The position of the count item in the document.
UnitValue

parent Document Read-only. The containing document.

typename string Read-only. The class name of the referenced countItem

object.
Method Parameter type Returns What it does
remove

0

Deletes the count Ttem object.
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The collection of Countltem objects in the document.

Access through the Document.countltems collection property. For example:

app.activeDocument.countItems.removeAll ()

Note: This feature is available in the Extended Version only.

Property Value type Whatit is
length number Read-only. The number of elements in the countItems
collection.
parent Document Read-only. The containing document.
typename string Read-only. The class name of the referenced count Items
object.
Method Parameter type Returns What it does
add CountItem Creates a new count item object and
(position) array of UnitvValue adds it to this collection.
Parameter position (X,y) represents
the horizontal and vertical positions,
respectively, of the count Item object.
getByName CountItem Get the first element in the
(name) string CountTtems collection with the
provided name.
removeAll

0

Removes all countItem objects from
the countItems collection.
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Options for saving a CMYK document in DCS1 format using the Document.saveAs() method.

Property Value type What it is

dcs DCSType Read-write. (default: bcsType . COLORCOMPOSITE).

embedColorProfile boolean Read-write. True to embed the color profile in the
document

encoding SaveEncoding | Read-write. The type of encoding to use for document
(default: saveEncoding . BINARY).

halftoneScreen boolean Read-write. True to include halftone screen (default:
false).

interpolation boolean Read-write. True to use image interpolation (default:
false)

preview Preview Read-write. The type of preview (default:

Preview.MACOSEIGHTBIT).

transferFunction boolean Read-write. True to include the Transfer functions to
compensate for dot gain between the image and film
(default: false).

typename string Read-only. The class name of the referenced
DCS1_SaveOptions object.

vectorData boolean Read-write. True to include vector data.

Valid only if the document includes vector data
(unrasterized text).
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Options for saving a CMYK document in DCS2 format using the Document.saveAs() method.

Property Value type Whatit is

dcs DCSType Read-write. The type of composite file to create
(default: DCSType . NOCOMPOSITE).

embedColorProfile boolean Read-write. True to embed the color profile in the
document.

encoding SaveEncoding Read-write. The type of encoding to use (default:
SaveEncoding.BINARY).

halftoneScreen boolean Read-write. True to include the halftone screen
(default: false).

interpolation boolean Read-write. True to use image interpolation (default:
false).

multiFileDCS boolean Read-write. True to save color channels as multiple
files or a single file (default: false).

preview Preview Read-write. The preview type (default:
Preview.MACOSEIGHTBIT).

spotColors boolean Read-write. True to save spot colors.

transferFunction boolean Read-write. True to include the Transfer functions to
compensate for dot gain between the image and film
(default: false).

typename string Read-only. The class name of the referenced
DCS2_SaveOptions object.

vectorData boolean Read-write. True to include vector data.

Valid only if the document includes vector data
(unrasterized text).
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Options for opening a document in DICOM format using the Application.open() method.

Note: This feature is available in the Extended Version only.

Property Value type What it is

anonymize boolean Read-write. True to make the patient
information anonymous.

columns number Read-write. Number of columns in n-up
configuration.

reverse boolean Read-write. True to reverse (invert) the image.

rows number Read-write. The number of rows in n-up
configuration.

showOverlays boolean Read-write. True to show overlays.

typename string Read-only. The class name of the referenced
DICOMOpenOpt ions object.

windowLevel number Read-write. The contrast of the image in
Houndsfield units.

windowWidth number Read-write. The brightness of the image in
Houndsfield units.
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The active containment object for layers and all other objects in the script; the basic canvas for the file.

e Access the object for the currently active document through Application.activeDocument.

e You can access other documents, or iterate through all open documents using the list in the
Application.documents collection. You can access individual documents in the list by index, or use

Documents.getByName() to retrieve them by name.

e Create documents programmatically using the Documents.add() method.

See Document sample script and the Documents collection object for examples.

Note: In Adobe Photoshop CS4, a document can also be referred to as an image or a canvas.

e The term image refers to the entire document and its contents. You can trim or crop an image.
You resize an image using the resizeImage () method.

e The term canvas refers to the space in which the document sits on the screen. You can rotate or
flip the canvas. You resize the canvas using the resizecanvas () method.

Property

Value type

Whatitis

activeChannels

activeHistoryBrushSource

activeHistoryState

activeLayer

artLayers

backgroundLayer

bitsPerChannel
channels

colorProfileName

colorProfileType

colorSamplers

componentChannels

array of Channel

HistoryState

HistoryState

ArtLayer or
LayerSet

ArtLayers

ArtLayer

BitsPerChannelType

Channels

string

ColorProfileType

ColorSamplers

array of Channel

Read-write. The selected channels.

Read-write. The history state to use with the
history brush.

Read-write. The selected HistoryState object.

Read-write. The selected layer.

Read-only. The art layers collection.

Read-only. The background layer of the
document.

Read-write. The number of bits per channel.
Read-only. The channels collection.

Read-write. The name of the color profile.

Valid only when colorProfileType =
ColorProfile.CUSTOM OF WORKING.

Read-write. Whether the document uses the
working color profile, a custom profile, or no
profile.

Read-only. The current color samplers
associated with this document.

Read-only. The color channels that make up
the document; for instance, the Red, Green,
and Blue channels for an RGB document.
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Property Value type What it is (Continued)
countItems CountItems Read-only. The current count items.

Note: For additional information about count
items, see Adobe Photoshop CS4 help
on the Count Tool.

fullName File Read-only. The full path name of the
document.

height Unitvalue Read-only. The height of the document (unit
value).

histogram array of number Read-only. A histogram showing the number
of pixels at each color intensity level for the

composite channel. The array c ontains 256

members.

Valid only when mode = DocumentMode.RGB,

CMYK; OF INDEXEDCOLOR.

historyStates HistoryStates Read-only. The history states collection.

info DocumentInfo Read-only. Metadata about the document.

layerComps LayerComps Read-only. The layer compositions collection.

layers Layers Read-only. The layers collection.

layerSets LayerSets Read-only. The layer set collection.

managed boolean Read-only. True if the document a is workgroup
document.

measurementScale MeasurementScale Read-only. The measurement scale for the
document.

Note: The measurement scale feature is
available in the Extended version only.

mode DocumentMode Read-only. The color profile.
name string Read-only. The document's name.
parent Application Read-only. The application object that contains
this document.
path File Read-only. The path to the document.
pathItems PathTltems Read-only. The path items collection.
pixelAspectRatio number Read-write. The (custom) pixel aspect ratio to
[0.100..10.000]
use.
printSettings DocumentPrintSettin Read-only. The print settings for the document.
gs
quickMaskMode boolean Read-write. True if the document is in Quick

Mask mode.
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Property Value type What it is (Continued)

resolution number Read-only. The document’s resolution (in pixels
per inch).

saved boolean Read-only. True if the document has been
saved since the last change.

selection Selection Read-only. The selected area of the document.

typename string Read-only. The class name of the Document
object.

width Unitvalue Read-only. The width of the document (unit
value).

xmpMetadata xmpMetadata Read-only. XMP metadata for the document.

Camera RAW settings for the image are stored
here for example.
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Method Parameter type Returns  What it does
autoCount Counts the number of objects in a
(channel, Channel document. Available in the Extended
threshold) numbex Version only.
Creates a Countltem object for each
object counted.
For additional information about how to
set up objects to count, see the Count Tool
in the Adobe Photoshop CS4 Help
changeMode Changes the color profile of the
(destinationMode _9—;?1? eI‘C’IOde S document.
. itmapConversionOptions
[, options]) or
IndexedConversionOptions
close Closes the document. If any changes have
([saving]) SaveOptionsType been made, the script presents an alert
with three options: save, do not save,
prompt to save. The optional parameter
specifies a selection in the alert box
(default: saveoptionsType.
PROMPTTOSAVECHANGES).
convertProfile Changes the color profile.
: i onProfil string
(ﬁ:;:atlon rotiLie, Intent The destinationProfile parameter must
[, blackPointCompensation] Poolean be either a string that names the color
[, ditherl]) boolean mode or Working RGB, Working CMYK,
Working Gray, Lab Color (meaning one
of the working color spaces or Lab color).
crop Crops the document. The bounds
(bounds ar:;gy of 4 UnitValue parameter is an array of four coordinates
[, angle] Eiitf;;lue for the region remaining after cropping,
\3th UnitValue i
{' ;J;?;hi]:] ) Unitvalue [left, top, right, bottom].
duplicate Document | Creates a duplicate of the document
([name ] string object.
[, mergeLayersOnly] boolean

)

The optional parameter name provides the
name for the duplicated document.

The optional parameter
mergeLayersOnly indicates whether to
only duplicate merged layers.
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Method Parameter type Returns | What it does (Continued)
exportDocument Exports the paths in the document to an
(exportIn Elle T lllustrator file, or exports the document to
, £A. Xpor vype . . . . .
% gxf:)(ijgns]ﬂ ExportoptionsIllustrator a f||fe vylth‘Web or device viewing
+ OP —or— optimizations.
ExportOptionsSaveForWeb
This is equivalent to choosing File >
Export > Paths To lllustrator, or File >
Save For Web and Devices.
flatten Flattens all layers in the document.
0
flipCanvas Flips the image within the canvas in the
(direction) Direction specified direction.
importAnnotations Imports annotations into the document.
(file) File
mergeVisibleLayers Flattens all visible layers in the document.
0
paste ArtLayer Pastes the contents of the clipboard into
([intoSelection]) boolean the document. If the optional argument is
set to true and a selection is active, the
contents are pasted into the selection.
print Prints the document.
( [postScriptEncoding] PrintEncoding _ ifies th | f
[, sourceSpace] SourceSpaceType prlntSpace SpECI les the color Space or
[, printSpace] string the printer. Valid values are nothing (that
[, intent] Intent is, the same as the source); or Working
[blackPointCompensation]) boolean

printOneCopy
0

rasterizeAllLayers
0

recordMeasurements

( [sourcel]
[, dataPoints])

resizeCanvas
( [width]
[, height]
[, anchor])

resizeImage
( [width]
[, height]
[, resolution]
[, resampleMethod])

MeasurementSource
array of string

UnitValue
UnitValue
AnchorPosition

UnitValue
UnitValue
number
ResampleMethod

RGB, Working CMYK, Working Gray, Lab
Color (meaning one of the working color
spaces or Lab color); or a string specifying
a specific colorspace (default: nothing).

Print one copy of the document.

Rasterizes all layers.

Record measurements of document.

Changes the size of the canvas to display
more or less of the image but does not
change the image size. See resizelmage.

Changes the size of the image.
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Method

Parameter type

Returns

What it does (Continued)

revealAll
()

Expands the document to show clipped
sections.

rotateCanvas
(angle)

number

Rotates the canvas (including the image)
in clockwise direction.

save

0

Saves the document.

saveAs
(savelIn
[, options]
[, asCopy]
[, extensionType])

File

object (see description)

boolean
Extension

Saves the document in a specific format.

Specify the save options appropriate to
the format by passing one of these
objects:

BMPSaveOptions

DCS1 SaveOptions
DCS2 SaveOptions
EPSSaveOptions
GIFSaveOptions
JPEGSaveOptions
PDFSaveOptions
PhotoshopSaveOptions
PICTFileSaveOptions
PICTResourceSaveOptions
PixarSaveOptions
PNGSaveOptions
RawSaveOptions
SGIRGBSaveOptions
TargaSaveOptions
TiffSaveOptions

splitChannels
0

array of

Document

Splits the document channels into
separate images.

suspendHistory
(historyString
javaScriptString)

string
string

Provides a single entry in history states for
the entire script provided by
javaScriptString. Allows a single undo
for all actions taken in the script.

The historyString parameter provides
the string to use for the history state.

The javaScriptString parameter
provides a string of JavaScript code to
excute while history is suspended.

trap
(width)

number

Applies trapping to a CMYK document.

Valid only when docref.mode =
DocumentMode . CMYK,

trim
([typel
, top]
, left]
, bottom]
, right])

— ——

TrimType
boolean

boolean
boolean
boolean

Trims the transparent area around the
image on the specified sides of the canvas.

Default is true for all Boolean parameters.
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The following script creates a document that contains two images (a sunflower and a duck) obtained from
the Adobe Photoshop CS4 Samples folder and employs the following steps:

e Determines which image is larger.

e Resizes the smaller image to match the larger image.

e Creates a merged document twice as high as either image in order to hold both images.
e Selects part of the document and pastes the sunflower into the selection.

e Inverts the selection and pastes the duck into the lower part of the document.

e Positions the sunflower over the duck.

Document.jsx
// Save the current preferences
var startRulerUnits = app.preferences.rulerUnits
var startTypeUnits = app.preferences.typeUnits
var startDisplayDialogs = app.displayDialogs

// Set Adobe Photoshop CS4 to use pixels and display no dialogs
app.preferences.rulerUnits = Units.PIXELS
app.preferences.typeUnits = TypeUnits.PIXELS
app.displayDialogs = DialogModes .NO

// first close all the open documents
while (app.documents.length)
app.activeDocument.close ()

}

// Open the sunflower and duck files from the samples folder
var flowerDoc = open(File (app.path + "/Samples/Sunflower.psd"))
var duckDoc = open(File (app.path + "/Samples/Ducky.tif"))

// Find out which document is larger
// Resize the smaller document the to the larger document’s size
// The resize requires the document be the active/front document
if ((flowerDoc.width.value * flowerDoc.height.value) >
(duckDoc.width.value * duckDoc.height.value)) {
app.activeDocument = duckDoc
duckDoc.resize (flowerDoc.width, flowerDoc.height)
}
else {
app.activeDocument = flowerDoc
flowerDoc.resizeImage (duckDoc.width, duckDoc.height)

}

// Create a new document twice as high as two files
var mergedDoc = app.documents.add (duckDoc.width, duckDoc.height * 2,
duckDoc.resolution, "FlowerOverDuck")

// Copy the flower to the top; make it the active document so we can manipulate it
app.activeDocument = flowerDoc

flowerDoc.activeLayer.copy ()

//Paste the flower to the merged document, making the merged document active
app.activeDocument = mergedDoc

// Select a square area at the top of the new document
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var selRegion = Array (Array (0, 0),
Array (mergedDoc.width.value, 0),
Array (mergedDoc.width.value, mergedDoc.height.value / 2),
Array (0, mergedDoc.height.value / 2),
Array (0, 0))
// Create the selection
mergedDoc.selection.select (selRegion)

//Paste in the flower
mergedDoc.paste (TRUE)

// do the same thing for the duck
app.activeDocument = duckDoc
duckDoc.activeLayer.copy ()

app.activeDocument = mergedDoc
mergedDoc.selection.select (selRegion)

// Inverting the selection so the bottom of the document is now selected
mergedDoc.selection. invert ()

// Paste the duck
mergedDoc.paste (TRUE)

// get rid of our originals without modifying them
duckDoc.close (SaveOptions.DONOTSAVECHANGES)
flowerDoc.close (SaveOptions.DONOTSAVECHANGES)

// Reset the application preferences
app.preferences.rulerUnits = startRulerUnits
app.preferences.typeUnits = startTypeUnits
app.displayDialogs = startDisplayDialogs
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The print settings for a document. New for Photoshop CS4.

Property Value type Whatitis

backgroundColor SolidColor Read-write. Background color of page.
bleedWidth UnitValue Read-write. Bleed width

caption boolean Read-write. Print the caption found in Filelnfo.
centerCropMarks boolean Read-write. Print center crop marks.
colorBars boolean Read-write. Print color calibration bars.
copies number Read-write. Number of copies to print.
cornerCropMarks boolean Read-write. Print corner crop marks.
colorHandling PrintColorHandling | Read-only. Color handling.

activePrinter string Read-write. The currently active printer.

flip boolean Read-write. Flip the image horizontally.
hardProof boolean Read-write. Print a hard proof.

interpolate boolean Read-write.

labels boolean Read-write. Prints the document title.
mapBlack boolean Read-write. Map blacks.

negative boolean Read-write. Invert the image colors.
renderIntent Intent Read-write. Color conversion intent when print

space is different from the source space.

posX Unitvalue Read-only. The x position of the image on
page.

posY Unitvalue Read-only. The y position of the image on
page.

printBorder Unitvalue Read-write. The width of the print border.

printSelected boolean Read-write. Print the selected area of the
document.

printSpace string Read-write. color space for printer. Can be

nothing (meaning same as source); 'Working
RGB', 'Working CMYK', 'Working Gray', 'Lab
Color' (meaning one of the working spaces or
Lab color); or a string specifying a specific
colorspace (default is same as source)
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Property Value type What it is (Continued)
registrationMarks boolean Read-write. Print registration marks.
scale number Read-only. Scale of image on page.
vectorData boolean Read-write. Include vector data.
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Method Parameter type Returns  What it does
setPagePosition Set the position of the image on the page.
(docPosition DocPositionStyle
posX, UnitValue
posY, UnitValue
number

scale)
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Metadata about a document object.

Access through the Document.info property. For example, the following sets the author, caption, and
copyrighted properties:

var docRef = open(fileList[i])

// set the file info

docRef.info.author = "Mr. Adobe programmer"
docRef.info.caption = "Adobe Photo shoot™"

docRef .info.copyrighted = CopyrightedType.COPYRIGHTEDWORK

These values can be set interactively by choosing File > File Info.

Property Value type What it is

author string Read-write.

authorPosition string Read-write.

caption string Read-write.

captionWriter string Read-write.

category string Read-write.

city string Read-write.

copyrighted CopyrightedType Read-write. The copyrighted status.

copyrightNotice string Read-write.

country string Read-write.

creationDate string Read-write.

credit string Read-write.

exif array of array [tag datal Read-only. Camera data thatincludes
camera settings used when the image
was taken.

Each array member is a tag pair, an array
of [tag, tag_datal; for example, [
"camera" "Cannon"].

headline string Read-write.

instructions string Read-write.

jobName string Read-write.

keywords array of string Read-write. A list of keywords that can
identify the document or its contents.

ownerUrl string Read-write.
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Property Value type What it is (Continued)
parent Document Read-only. The info object's container.
provinceState string Read-write.
source string Read-write.
supplementalCategories array of string Read-write.
title string Read-write.
transmissionReference string Read-write.
typename string Read-only. The class name of the

referenced info object.

urgency Urgency Read-write.

The following script sets document info (metadata) for all of the files in a specified folder and then saves
the modified files as low-quality JPEG images in a new folder without changing the originals.

Ask the user to specify the folder that contains the original files and the output folder for the JPEG
images, and then check that the folders exist.

Open each file and use the document Info object properties to tag it with the following metadata:
e author: Adobe programmer

e caption: Adobe Photo shoot

e captionWriter: Adobe programmer

e city: San Jose

e copyrightNotice: Copyright (c) Adobe programmer Photography

e copyrighted status: Copyrighted Work

e country: USA

e state:CA

Save the new documents in JPEG format with a low quality setting.

Documentinfo.jsx

// Save the current preferences
var startDisplayDialogs = app.displayDialogs

// Set Adobe Photoshop CS4 to use pixels and display no dialogs
app.displayDialogs = DialogModes .NO

// ask the user for the input and output folders
var inputFolder = Folder.selectDialog("Select a folder to tag")
var outputFolder = Folder.selectDialog("Select a folder for the output files")

// see if we got something interesting from the dialog
if (inputFolder != null && outputFolder != null)

// get all the files found in this folder

var fileList = inputFolder.getFiles()
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// save the outputs in JPEG

var jpegOptions = new JPEGSaveOptions ()

// set the jpeg quality really low so the files are small
jpegOptions.quality = 1

// open each one in turn

for (var i = 0; 1 < fileList.length; i++) {

// The fileList includes both folders and files so open only files
(fileList[i] instanceof File && fileList[i] .hidden == false) ({

if

}

// get a reference to the new document
var docRef = open(fileList[i])

// tag all of the documents with photo shoot information
docRef.info.author = "Adobe programmer"
docRef.info.caption = "Adobe Photo shoot"
docRef.info.captionWriter = "Adobe programmer"
docRef.info.city = "San Jose"

docRef.info.copyrightNotice = "Copyright (c) Adobe programmer

Photography"
docRef.info.copyrighted = CopyrightedType.COPYRIGHTEDWORK
docRef .info.country = "USA"
docRef.info.provinceState = "CA"

// change the date to a Adobe Photoshop CS4 date format
// "YYYYMMDD"
var theDate = new Date()
// the year is from 1900 2?27
var theYear = (theDate.getYear() + 1900) .toString/()
// convert the month from 0..12 to 00..12
var theMonth = theDate.getMonth () .toString/()
if (theDate.getMonth() < 10) {
theMonth = "0" + theMonth
}
// convert the day from 0..31 to 00.31
var theDay = theDate.getDate() .toString/()
if (theDate.getDate() < 10) {
theDay = "0" + theDay
}
// stick them all together
docRef.info.creationDate = theYear + theMonth + theDay

// flatten because we are saving to JPEG
docRef.flatten()

// go to 8 bit because we are saving to JPEG
docRef .bitsPerChannel = BitsPerChannelType.EIGHT

// save and close

docRef .saveAs (new File (outputFolder + "/Output" + i + ".jpg"),

// don’t modify the original
docRef .close (SaveOptions .DONOTSAVECHANGES)

// Reset the application preferences
app.displayDialogs = startDisplayDialogs

jpegOptions)
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The collection of open Document objects.

Access this list through the Application.documents collection property, which is available through the app
global variable, or directly at the top level. For example, the following adds a new document to the

collection:

app.documents.add (800, 500, 72,

"myDocument", NewDocumentMode.RGB)

documents.add (800, 500, 72, "myDocument", NewDocumentMode.RGB)
Property Value type Whatit is
length number Read-only. The number of elements in the documents
collection.
parent Application Read-only. The containing application.
typename string Read-only. The class name of the referenced documents
object.
Method Parameter type Returns What it does
add Document Creates a new document object and
([width] UnitValue adds it to this collection.
[, height] UnitValue
[, resolution] number pixelAspectRatio: Defaultis 1.0, a
[, name] string square aspect ratio.
[, mode] NewDocumentMode
[ initialFill] DocumentFill bitsPerChannelType: Default is
[, pixelAspectRatio] nLllmber [0.1..10.00] BitsPerChannelType.EIGHT.
[, bitsPerChannel] BitsPerChannelType
' string
[,colorProfileName] )
getByName string Document Gets the first element in the
(name) documents collection with the

provided name
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EPSOpenOptions

Options for opening a document in EPS format using the Application.open() method.

Properties

Property Value type Whatitis

antiAlias boolean Read-write. True to use antialias.

constrainProportions boolean Read-write. True to constrain the proportions of
the image.

height Unitvalue Read-write. The height of the image (unit
value).

mode OpenDocumentMode |Read-write. The color profile to use as the
document mode.

resolution number Read-write. The resolution of the document in
pixels per inch.

typename string Read-only. The class name of the referenced
EPSOpenOptions object.

width Unitvalue Read-write. The width of the image (unit value).
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Options for saving a document in EPS format using the Document.saveAs() method.

Property Value type Whatitis

embedColorProfile boolean Read-write. True to embed the color profile in this
document.

encoding SaveEncoding Read-write. The type of encoding to use (default:
SaveEncoding.BINARY).

halftoneScreen boolean Read-write. True to include the halftone screen
(default: false).

interpolation boolean Read-write. True to use image interpolation (default:
false).

preview Preview Read-write. The preview type.

psColorManagement boolean Read-write. True to use Postscript color management
(default: false).

transferFunction boolean Read-write. True to include the Transfer functions to
compensate for dot gain between the image and film
(default: false).

transparentWhites boolean Read-write. True to display white areas as
transparent.
Valid only when document.mode =
DocumentMode . BITMAP. See also changeMode().

typename string Read-only. The class name of the referenced
EPSSaveOptions object.

vectorData boolean Read-write. True to include vector data.

Valid only if the document includes vector data (text).
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ExportOptionslllustrator

Options for exporting Pathltem objects to an Adobe lllustrator® file using using the
Document.exportDocument() method. These options are the options that you can provide when you

choose File > Export > Paths To lllustrator.

Properties

Property Value type What it is

path IllustratorPathType Read-write. The type of path to export
(default:
IllustratorPathType. DOCUMENTBOUNDS).

pathName string Read-write. The name of the path to export.
Valid only when path =
IllustratorPathType.NAMEDPATH.

typename string Read-only. The class name of the referenced
exportOptionsIllustrator object.
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Options for optimizing a document for the web or devices using the Document.exportDocumenty()
method. These are the options that you can provide when you choose File > Save For Web and Devices.

Property Value type Whatitis

blur number Read-write. Applies blur to the image to reduce
artifacts (default: 0. 0).

colorReduction ColorReductionType | Read-write. The color reduction algorithm (default:
ColorReductionType.SELECTIVE).

colors number Read-write. The number of colors in the palette
(default: 256).

dither Dither Read-write. The type of dither (default:
Dither.DIFFUSION).

ditherAmount number Read-write. The amount of dither (default: 100).
Valid only when
dither = Dither.DIFFUSION.

format SaveDocumentType | Read-write. The file format to use (default:
SaveDocumentType . COMPUSERVEGI F).
Note: For this property, only COMPUSERVEGTF,

JPEG, PNG-8,PNG-24, and BMP are
supported.

includeProfile boolean Read-write. True to include the document’s
embedded color profile (default: false).

interlaced boolean Read-write. True to download in multiple passes;
progressive (default: false).

lossy number Read-write. The amount of lossiness allowed
(default: o).

matteColor RGBColor Read-write. The colors to blend transparent pixels
against.

optimized boolean Read-write. True to create smaller but less
compatible files (default: true).
Valid only when
format = SaveDocumentType.JPEG.

PNG8 boolean Read-write. Indicates the number of bits; true =8,

false = 24 (default: true).

Valid only when
format = SaveDocumentType.PNG.
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Property Value type What it is (Continued)

quality number [0..100] Read-write. The quality of the produced image as a
percentage; default: so.

transparency boolean Read-write. Indication of transparent areas of the
image should be included in the saved
image(default: true).

transparencyAmount number Read-write. The amont of transparency dither
(default: 100).
Valid only if transparency = true.

transparencyDither Dither Read-write. The transparency dither algorithm
(default: transparencyDither = Dither.NONE).

typename string Read-only. The class name of the referenced
ExportOptionsSaveForWeb object.

webSnap number Read-write. The tolerance amount within which to

snap close colors to web palette colors (default: o).
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File

Folder

ExtendScript defines the JavaScript classes File and Folder to encapsulate file-system references in a
platform-independent manner; see ‘JavaScript support in Adobe Photoshop CS4’ on page 33. For
references details of these classes, see the JavaScript Tools Guide.
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Options for the bannerOptions property of the GalleryOptions object.

Tip: You can preserve default values for many of these properties by setting the GalleryOptions property
preserveAllMetadata to true; this is the same as choosing File > Automate > Web Photo Gallery, and
then choosing Preserve all metadata in the Options area of the Web Photo Gallery dialog.

Property Value type What it is

contactInfo string Read-write. The web photo gallery
contact info.

date string Read-write. The web photo gallery date
(default: current date).

font GalleryFontType Read-write. The font setting for the
banner text (default:
GalleryFontType.ARIAL).

fontSize number [1..7] Read-write. The font size for the banner
text (default: 3).

photographer string Read-write. The web photo gallery
photographer.
siteName string Read-write. The web photo gallery site

name (default:
Adobe Web Photo Gallery).

typename string Read-only. The class name of the
referenced galleryBannerOptions
object.
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GalleryCustomColorOptions

Options for the customColorOptions property of the GalleryOptions object.

Tip: You can preserve default values for many of these properties by setting the GalleryOptions property
preserveAllMetadata to true; this is the same as choosing File > Automate > Web Photo Gallery, and
then choosing Preserve all metadata in the Options area of the Web Photo Gallery dialog.

Properties

Property Value type What it is

activeLinkColor RGBColor Read-write. The color to use to indicate
an active link.

backgroundColor RGBColor Read-write. The background color.

bannerColor RGBColor Read-write. The banner color.

linkColor RGBColor Read-write. The color to use to indicate a
link.

textColor RGBColor Read-write. The text color.

typename string Read-only. The class name of the
referenced
galleryCustomColorOptions object.

visitedLinkColor RGBColor Read-write. The color to use to indicate a
visited link.
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Options for the imagesOptions property of the GalleryOptions object.

Tip: You can preserve default values for many of these properties by setting the GalleryOptions property
preserveAllMetadata to true; this is the same as choosing File > Automate > Web Photo Gallery, and

then choosing Preserve all metadata in the Options area of the Web Photo Gallery dialog.

Property

Value type

Whatitis

border

caption

dimension

font

fontSize

imageQuality

includeCopyright

includeCredits

includeFilename

includeTitle

numericLinks

number [0..99]

boolean

number

GalleryFontType

number [1..7]

number [0..12]

boolean

boolean

boolean

boolean

boolean

Read-write. The size (in pixels) of the border
that separates images (default: o).

Read-write. True to generate image captions
(default: false).

Read-write. The resized image dimensions in
pixels (default: 350).

Valid only when resizelmages = true.

Read-write. The font to use for image
captions (default: calleryFontType .ARIAL).

Read-write. The font size for image captions
(default: 3).

Valid only when caption = true.

Read-write. The quality setting for a JPEG
image (default: 5).

Read-write. True to include copyright
information in captions (default: false).

Valid only when caption = true.

Read-write. True to include the credits in
image captions (default: false).

Valid only when caption = true.

Read-write. True to include the file name in
image captions (default: true).

Valid only when caption = true.

Read-write. True to include the title in image
captions (default: false).

Valid only when caption = true.

Read-write. True to add numeric links
(default: true).
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Property

Value type

What it is (Continued)

resizeConstraint

resizeImages

typename

GalleryConstrainType

boolean

string

Read-write. The image dimensions to
constrain in the gallery image (default:
GalleryConstrainType . CONSTRAINBOTH).

Valid only when resizelmages = true.
Read-write. True to automatically resize

images for placement on the gallery pages
(default: true).

Read-only. The class name of the referenced
galleryImagesOptions object.
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Options for a Web photo gallery, created with Application.makePhotoGallery().

Tip: You can preserve default values for many of these properties by choosing File > Automate > Web
Photo Gallery, and then choosing Preserve all metadata in the Options area of the Web Photo

Gallery dialog.

Property Value type What it is

addSizeAttributes boolean Read-write. True to add width and
height attributes for images (default:
true).

bannerOptions GalleryBannerOptions Read-write. The options related to
banner settings.

customColorOptions GalleryCustomColorOptions Read-write. The options related to
custom color settings.

emailAddress string Read-write. The email address to show
on the web page.

imagesOptions GalleryImagesOptions Read-write. The options related to
images settings.

includeSubFolders boolean Read-write. True to include all files
found in sub folders of the input
folder (default: true).

layoutStyle string Read-write. The style to use for laying
out the web page (default: centered
Frame 1 - Basic).

preserveAllMetadata boolean Read-write. True to save metadata
(default: false).

securityOptions GallerySecurityOptions Read-write. The options related to
security settings.

thumbnailOptions GalleryThumbnailOptions | Read-write. The options related to
thumbnail image settings.

typename string Read-only. The class name of the
referenced galleryoptions object.

useShortExtension boolean Read-write. True to use the short web
page extension . htm. If false, use the
web page extension .html (default:
true).

useUTF8Encoding boolean Read-write. True to use UTF-8

encoding for the web page (default:
false).
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Options for the securityOptions property of the GalleryOptions object.

Tip: You can preserve default values for many of these properties by setting the GalleryOptions property

preserveAllMetadata to true; this is the same as choosing File > Automate > Web Photo Gallery, and
then choosing Preserve all metadata in the Options area of the Web Photo Gallery dialog.

Property

Value type

Whatitis

content

font

fontSize

opacity

text

textColor

textPosition

textRotate

typename

GallerySecurityType

GalleryFontType

number [1..72]

number

string

GallerySecurityTextColorType

GallerySecurityTextPositionType

GallerySecurityTextRotateType

string

Read-write. The web photo gallery
security content (default:
GallerySecurityType .NONE).

Read-write. The web photo gallery
security font (default:
GalleryFontType.ARIAL).

Read-write. The web photo gallery
security font size (default: 3).

Read-write. The web page security
opacity as a percent (default: 100).

Read-write. The web photo gallery
security custom text.

Read-write. The web page security text
color.

Read-write. The web photo gallery
security text position (default:
GallerySecurityTextPositionType.
CENTERED).

Read-write. The web photo gallery
security text orientation to use (default:
GallerySecurityTextRotateType.
ZERO).

Read-only. The class name of the
referenced gallerySecurityOptions
object.
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Options for the thumbnailOptions property of the GalleryOptions object.

Tip: You can preserve default values for many of these properties by setting the GalleryOptions property
preserveAllMetadata to true; this is the same as choosing File > Automate > Web Photo Gallery, and

then choosing Preserve all metadata in the Options area of the Web Photo Gallery dialog.

Property Value type What it is

border number [0..99] Read-write. The amount of border pixels you
want around your thumbnail images (default:
0).

caption boolean Read-write. True if there is a caption (default:
false).

columnCount number Read-write. The number of columns on the
page (default: 5).

dimension number Read-write. The web photo gallery thumbnail
dimension in pixels (default: 75).

font GalleryFontType Read-write. The web photo gallery font
(default: GalleryFontType .ARIAL).

fontSize number [1..7] Read-write. The font size for thumbnail
images text (default: 3).

includeCopyright boolean Read-write. True to include copyright
information for thumbnails (default: false).

includeCredits boolean Read-write. True to include credits for
thumbnails (default: false).

includeFilename boolean Read-write. True to include file names for
thumbnails (default: false).

includeTitle boolean Read-write. True to include titles for
thumbnails (default: false).

rowCount number Read-write. The number of rows on the page
(default: 3).

size GalleryThumbSizeType Read-write. The thumbnail image size
(default: GalleryThumbSizeType . MEDIUM).

typename string Read-only. The class name of the referenced

GalleryThumbnailOptions object.
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Options for saving a document in GIF format using the Document.saveAs() method.

Property Value type Whatitis

colors number Read-write. The number of palette colors.
Valid only when palette =
Palette.LOCALADAPTIVE, LOCALPERCEPTUAL,
LOCALSELECTIVE, MACOSPALETTE, UNIFORM,
WEBPALETTE; Of WINDOWSPALETTE .

dither Dither Read-write. The dither type.

ditherAmount number [1..100]  Read-write. The amount of dither (default: 75).
Valid only when dither = Dither.DIFFUSION.

forced ForcedColors Read-write. The type of colors to force into the
color palette.

interlaced boolean Read-write. True if rows should be interlaced
(default: false).

matte MatteType Read-write. The color to use to fill anti-aliased
edges adjacent to transparent areas of the image
(default: Mat teType . WHITE).
When transparency = false, the matte color is
applied to transparent areas.

palette PaletteType Read-write. The type of palette to use (default:

preserveExactColors

transparency

typename

boolean

boolean

string

Palette.LOCALSELECTIVE).

Read-write. True to protect colors in the image
that contain entries in the color table from being
dithered.

Valid only when dither = Dither.DIFFUSION.

Read-write. True to preserve transparent areas of
the image during conversion to GIF format.

Read-only. The class name of the referenced
GIFSaveOptions object.




Adobe Photoshop CS4

JavaScript Scripting Reference JavaScript Object Reference 118

GrayColor

Defines a gray color, used in the SolidColor object.

See also CMYKColor, HSBColor, LabColor, NoColor, RGBColor

Properties
Property Value type Whatiit is
gray numpber [0.0..100.0] |Read-write. The gray value (default: 0.0).
typename string Read-only. The class name of the referenced graycolor
object.
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A version of the document stored automatically (and added to the HistoryStates collection), which
preserves the document’s state, each time the document is changed.

Access through Document.historyStates collection. You can access a state in the list by name. For example,
this assigns a property value in the state object named "AddLayerMask":

var stateRef = app.activeDocument.historyState.getByName ("AddLayerMask") ;
stateRef.snapshot = true;

Property Value type Whatitis

name string Read-only. The HistoryState object's name.

parent Document Read-only. The containing document.

snapshot boolean Read-only. True if the history state is a snapshot.

typename string Read-only. The class name of the referenced Historystate

object.
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The collection of HistoryState objects in the document.

Access through Document.historyStates collection property. For example, this accesses one of the states in
the collection by index:

myState = app.activeDocument.historyStates[7];

Property Value type Whatit is

length number Read-only. The number of elements in the HistoryStates
collection.

parent Document Read-only. The containing document.

typename string Read-only. The class name of the referenced

HistoryStates object.

Method Parameter type Returns What it does
getByName HistoryState  Get the first elementin the
(name) string

HistoryStates collection with the
provided name.
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HSBColor

Defines an HSB color, used in the SolidColor object.

See also CMYKColor, GrayColor, LabColor, NoColor, RGBColor

Properties
Property Value type What it is
brightness numpber [0.0..100.0]  Read-write. The brightness value.
hue number [0.0..360.0] Read-write. The hue value.
saturation number [0.0..100.0] Read-write. The saturation value.
typename string Read-only. The class name of the referenced HSBColor
object.
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Options for converting an RGB image to an indexed color model using Document.changeMode().

Property Value type What it is

colors number Read-write. The number of palette colors.

Valid only when palette =
Palette.LOCALADAPTIVE, LOCALPERCEPTUAL,
LOCALSELECTIVE, MACOSPALETTE, UNIFORM,
WEBPALETTE, or WINDOWSPALETTE.

dither Dither Read-write. The dither type.

ditherAmount number [1..100] Read-write. The amount of dither.

Valid only when dither = Dither.diffusion.

forced ForcedColors Read-write. The type of colors to force into the
color palette.

matte MatteType Read-write. The color to use to fill anti-aliased
edges adjacent to transparent areas of the image
(default: Mat teType . WHITE).

When transparency = false, the matte coloris
applied to transparent areas.

palette PaletteType Read-write. The palette type (default:
Palette.EXACT).

preserveExactColors boolean Read-write. True to protect colors in the image
that contain entries in the color table from being
dithered.

Valid only when dither = Dither.DIFFUSION.

transparency boolean Read-write. True to preserve transparent areas of
the image during conversion to GIF format.

typename string Read-only. The class name of the referenced
IndexedConversionOptions object.
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Options for saving a document in JPEG format using the Document.saveAs() method.

Property Value type What itis

embedColorProfile boolean Read-write. True to embed the color profile in the
document.

formatOptions FormatOptions Read-write.The download format to use (default:

FormatOptions. STANDARDBASELINE).

matte MatteType Read-write. The color to use to fill anti-aliased edges
adjacent to transparent areas of the image (default:
MatteType.WHITE).

When transparency is turned off for an image, the
matte color is applied to transparent areas.

quality number [0..12] Read-write. The image quality setting to use; affects
file size and compression (default: 3).

scans number [3..5] Read-write. The number of scans to make to
incrementally display the image on the page
(default: 3).

Valid only for when formatOptions =
FormatOptions.PROGRESSIVE.

typename string Read-only. The class name of the referenced
JPEGSaveOptions object.
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LabColor

Defines an LAB color, used in the SolidColor object.

See also CMYKColor, GrayColor, HSBColor, NoColor, RGBColor

Properties
Property Value type What it is
a number [-128.0..127.0]  Read-write. The a-value.
b number [-128.0..127.0]1 Read-write. The b-value.
1 number [0.0..100.0] Read-write. The L-value.
typename string Read-only. The class name of the referenced
LabColor object.
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A snapshot of a state of the layers in a document, which can be used to view different page layouts or
compositions.

Access through Document.layerComps collection. You can access a layer comp by its name. For example,
this sets the comment property value for a Layercomp object named myLayerComp:

var layercompRef = app.activeDocument.layerComps.getByName ("myLayerComp") ;

layercompRef.comment = "View from shoreline";
Property Value type What it is
appearance boolean Read-write. True to use layer appearance (layer styles) settings.
comment string Read-write. A description of the layer comp.
name string Read-write. The name of the layer comp.
parent Document Read-write. The containing document.
position boolean Read-write. True to use layer position.
selected boolean Read-only. True if the layer comp is currently selected.
typename string Read-only. The class name of the referenced 1ayercomp object.
visibility boolean Read-write. True to use layer visibility settings .
Method Parameter type Returns What it does
apply Applies the layer comp to the document.
0
recapture Recaptures the current layer state(s) for
0 this layer comp.
remove Deletes the 1ayercomp object.
0
resetfromComp Resets the layer comp state to the

0 document state.
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The collection of LayerComp objects in the document.

Access through the Document.layerComps collection property. For example:

app.activeDocument.layerComps.add ("myLayerComp", "View from Shoreline",
true, true, true);

Property Value type What itis

length number Read-only. The number of elements in the 1ayercomps
collection.

parent Document Read-only. The containing document.

typename string Read-only. The class name of the referenced

layerComps object.

Method Parameter type Returns What it does
add LayerComp Creates a new layer composition
(name, string object and adds it to this collection.
comment , string
appearance, booiean
position, boolean
visibility) boolean
getByName LayerComp Gets the first element in the
(name) string collection with the provided name.
removeAll Removes all member objects from

0 the layercomps collection.
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The collection of layer objects, including ArtLayer and LayerSet objects, in the document. Access through
Document.layers, or the LayerSet.layers collections properties.

For example, this uses the 1ength property to count the number of 1ayer objects in the active document,
then displays the number on the screen:

var layerNum = app.activeDocument.layers.length
alert (layerNum)

Property Value type Whatitis
length number Read-only. The number of elements in the 1ayers
collection.
parent Document or Read-only. The containing document or layer set.
LayerSet
typename string Read-only. The class name of the referenced 1ayers object.
Method Parameter type Returns What it does
getByName Layer Gets the first element in the 1layers
(name) string collection with the provided name.

removeAll Removes all layers from the collection.
0
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A group of layer objects, which caninclude ArtLayer objects and other (nested) Layerset objects. A single
command can manipulate all layers in the set.

Access top-level layers sets in a document through the Document.layerSets collection. You can access a
layer set by name. For example, the following sets the al1Locked value for "myLayerSet":

var layerSetRef = app.activeDocument.layerSets.getByName ("myLayerSet") ;
layerSetRef .allLocked = true

Access nested layer sets through the LayerSet.layerSets collection in the parent set. For example:

app.activeDocument.layerSets [0] .layerSets[0] ;

Property Value type Whatit is

allLocked boolean Read-write. True if the contents in the layers in this set
are not editable.

artLayers ArtLayers Read-only. The art layers in this layer set.

blendMode BlendMode Read-write. The blend mode to use for the layer set.
bounds array of Unitvalue Read-only. The bounding rectangle of the layer set.
enabledChannels array of Channel Read-write. The channels enabled for the layer set; must

be a list of component channels. See Channel.kind.

layers Layers Read-only. The layers in this layer set.
layerSets LayerSets Read-only. Nested layer sets contained within this layer
set.
linkedLayers array of ArtLayer  Read-only.The layers linked to this layerset object.
and/or LayerSet
name string Read-write. The name of this layer set.
opacity nurber [0.0..100.0] Read-write. The master opacity of the set.
parent Document or Read-only. The containing document or layer set.
LayersSet
typename string Read-only. The class name of the referenced Layerset
object.

visible boolean Read-write. True if the set is visible.
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Methods
Method Parameter type Returns What it does
duplicate LayerSet Creates a duplicate of the object.
([relativeObject] ArtLayer or
LayerSet
El tP1l t
[, insertionLocation]) - Ees o=
link Links the layer set with another
(with) Artlayer or Iayer
LayerSet ’
merge ArtLayer Merges the layerset; returns a
0 reference to the art layer created
by this method.
move Moves the object.
(relativeObject, ArtLayer or
LayerSet
El tP1 t
insertionLocation) Efmer geenel
remove Deletes the object.
0
resize Resizes all layers in the layer set to
([horizontall nuﬁer to the specified dimensions (as a
. 1Y r . .
[, verticall Aichirposition percentage of its current size) and
[, anchorl) places the layer set in the
specified position.
rotate Rotates all layers in the layer set
(angle number o around the specified anchor point
[, anchor]) AnchorPosition (deﬁnﬂt
AnchorPosition.MIDDLECENTER)
translate Moves the position relative to its
([deltax] UnitValue current position.
[, deltay]) UnitValue
unlink Unlinks the layer set.
0
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The collection of LayerSet objects in the document.

Access the top-level layer sets in a document through the Document.layerSets collection property. For
example:

var layerSetRef = app.activeDocument.layerSets.add ()

Access the nested layer sets through the LayerSet.layerSets collection property in the parent set. For
example:

var layerSetRef = app.activeDocument.layerSets.getByName ("myParentSet") ;
var childSet = layerSetRef.layerSets.getByName ("myChildSet") ;

Property Value type What it is
length number Read-only. The number of elements in the Layersets
collection.
parent Document or Read-only. The containing document or layer set.
LayerSet
typename string Read-only. The class name of the referenced 1ayersets
object.
Method Parameter type Returns What it does
add LayerSet Creates a new layer set object and adds it to
0 the collection.
getByName LayerSet Gets the first element in the collection with
(name) string the provided name.
removeAll Removes all member layer sets, and any
0 layers or layer sets they contain, from the
document.

The following script creates three layer sets, then nests a second layer set in each layer set, and then
creates a text layer in each nested set that that displays the text "Layer in n Set Inside n Set", where n
represents the ordinal number of the set (first, second, or third).

Note: This script uses the ExtendScript ¢ debugging object. For further details, see the JavaScript Tools
Guide.

LayerSets.jsx
S.level =1

//close all open documents
while (app.documents.length)
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app.activeDocument.close ()

}

// create a working document
var docRef = app.documents.add()

// create an array to hold the layer sets
var myLayerSets = new Array ()

// Create an array to hold the text
var textArray = Array("First", "Second", "Third")

//Create an indexer variable
var i = 0

// Create three layer sets at the top level
for (i = 0; 1 < 3; 1i++) {
myLayerSets[i] = new Array ()
myLayerSets [i] [0] = docRef.layerSets.add()

}

// Rearrange the layer sets with the first one on top, second next, etc.
myLayerSets [1] [0] .moveAfter (myLayerSets[0] [0])
myLayerSets [2] [0] .moveAfter (myLayerSets[1] [0])

// Create a layer set inside each layer set

for (i = 0; 1 < 3; i++) {
myLayerSets[i] [0] .name = textArray[i] + " Set"
myLayerSets[i] [1] = myLayerSets[i] [0] .layerSets.add ()
myLayerSets[i] [1] .name = "Inside " + textArray[i] + " Set"

}

// Create an array to hold the layers
var myLayers = new Array ()

// Create a text layer with a description inside each layer set
for (i = 0; 1 < 3; i++) {

myLayers [i] = myLayerSets[i] [1] .artLayers.add ()
myLayers[i] .kind = LayerKind.TEXT
myLayers[i] .textItem.contents = "Layer in " + textArray[i] + " Set Inside "

+ textArray[i] + " Set"
myLayers[i] .textItem.position = Array(app.activeDocument.width * i * 0.33,
app.activeDocument.height * (i + 1) * 0.25)
myLayers [i] .textItem.size = 12
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MeasurementlLog

The measurement log for the application. Access through the Application.measurementLog property.

Note: This feature is available in the Extended Version only.

Methods
Method Parameter type Returns  What it does
exportMeasurements Export measurement to a file.
([file] File
[, rangel) MeasurementRange
[, dataPoints]) array of string

deleteMeasurements
([range])

MeasurementRange

Delete measurements from
the log.
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The measurement scale for the document. Access through the Document.measurementScale property.
For example:

app.activeDocument .measurementScale.pixellLength = 25

Note: This feature is available in the Extended Version only.

Property Value type What it is
pixelLength number Read-write. The length in pixels this scale equates to.
logicalLength number Read-write. The logical length this scale equates to.

logicalUnits string Read-write. The logical units for this scale.
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NoColor

Represents a missing color object, used in the SolidColor object.

See also CMYKColor, GrayColor, HSBColor, LabColor, RGBColor

Properties
‘ Property Value type What it is
typename string Read-only. The class name of the referenced nocolor
object.
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An event-handler object that tells a script to execute specified code when a specified event occurs.
Notifiers must be enabled using the Application.notifiersEnabled property.

Access through the Application.notifiers collection.

Note: Events that occur within scripts do not generally trigger notifiers, because they occur inside a "play
script" event.

Property Value type Whatit is

event string Read-only. The event identifier, a four-character code or a
unique string.

For a list of four-character codes, see Appendix A: Event ID
Codes.

eventClass string Read-only. The class identifier, a four-character code or a
unique string.

When an event applies to multiple types of objects, use this
propery to distinguish which object this notifier applies to.
For example, the Make event ("Mk ") can apply to
documents ("Demn ), channels ("chnl ") and other objects.

eventFile File Read-only. The path to the file to execute when the event
occurs and activates the notifier.

parent Application Read-only. The containing application.

typename string Read-only. The class name of the referenced object.
Method Parameter type Returns What it does

remove Deletes this object.

0 You can also remove a Notifier object

from the Script Events Manager
drop-down list by deleting the file named
Script Events Manager.xml from the
Photoshop preferences folder. See Adobe
Photoshop CS4 help for more information.




JavaScript Scripting Reference

Adobe Photoshop CS4

JavaScript Object Reference 136

The collection of Notifier objects in the document. Access through the Application.notifiers collection

property. For example:

var notRef = app.notifiers.add("OnClickGoButton", eventFile)

Notifiers must be enabled using the Application.notifiersEnabled property.

Property

Value type

What it is

length

parent

typename

number

Application

string

Read-only. The number of elements in the notifiers

collection.

Read-only. The notifiers object’s container

Read-only. The class name of the referenced notifiers object.

Method

Parameter type Returns

What it does

add

(event,
eventFile
[, eventClass])

removeAll
()

string
File
string

Notifier

Creates a notifier object and adds it to this
collection.

event defines the class ID of the event: use a
4-characters code or a unique string. See
Appendix A: Event ID Codes.

eventFile defines the script file that
executes when the event occurs.

When an event applies to multiple types of
objects, use the eventClass (a 4-character ID
or unique string) to distinguish which object
this Notifier applies to. For example, the
Make event ("mk ") applies to documents
("Demn ), channels ("chnl ") and other
objects.

Tip: When specifying an event or event calss
wtih a 4-character ID code, omit the
single quotes in your code.

Removes all member objects from the
notifiers collection.

You can also remove a notifier object from
the Script Events Manager drop-down list by
deleting the file named script Events
Manager.xml from the Photoshop
preferences folder. See Adobe

Photoshop CS4 help for more information.




Adobe Photoshop CS4
JavaScript Scripting Reference JavaScript Object Reference 137

A path or drawing object, such as the outline of a shape or a straight or curved line, which contains sub
paths that define its geometry.

Access through the collection in the Document.pathltems property. For example, this selects a named
path item:

var currentPathItem = app.activeDocument.pathItems.getByName ("myPath") ;
currentPathItem.select ()

Create these objects by passing a set of SubPathInfo objects to the Pathltems.add() method. This method
creates a SubPathltem object for each SubPathinfo object, and creates and returns a new Pathltem object
for the path represented by all of the subpaths.

Property Value type Whatitis
kind PathKind Read-write. The type.
name string Read-write. The name.
parent Document Read-only. The containing document.
subPathItems SubPathItems Read-only. The contained sub-path objects.
typename string Read-only. The class name of the referenced
pathItem object.
Method Parameter type Returns  What it does
deselect Deselects this pathItem
0 object.
duplicate Duplicates this
(name) string pathItem object with
the new name.
fillPath Fills the area enclosed by
([fillcolor] SolidColor this path.
[, mode] ColorBlendMode
3 opacity] number [0..100] opacity is a percentage.
! boolean
E' ?Z:iig‘]eﬁa“parency] number [0.0..250.0] feather is in pixels.
' boolean .
[, wholePath] If wholePath is true, all
[, antiAlias]) boolean

subpaths are used when
doing the fill (default:

true)
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Method Parameter type Returns  What it does
makeClippingPath Makes this the clipping
([flatness]) numper [0.2..100] path for this document.
flatness tells the
PostScript printer how to
approximate curves in
the path.
makeSelection Makes a Selection object
([feather] Eum?er [0.0..250.0] whose border is this
NE oolean
{' EEZ;atigi%) SelectionType path.
feather is in pixels.
remove Deletes this object.
0
select Makes this the active or
0 selected pathItem
object.
strokePath Strokes the path with
([tool] ToolType the specified tool.
[, simulatePressure]) boolean

The following creates a path in three segments: two diagonal lines that form a V, and a curved line above
the Vthat makes it look like a 2D ice cream cone.

Paths.jsx

// Save the current preferences

var startRulerUnits = app.preferences.rulerUnits
var startTypeUnits = app.preferences.typelUnits
var startDisplayDialogs = app.displayDialogs

// Set Adobe Photoshop CS4 to use pixels and display no dialogs
app.preferences.rulerUnits = Units.PIXELS
app.preferences.typeUnits = TypeUnits.PIXELS
app.displayDialogs = DialogModes .NO

// first close all the open documents
while (app.documents.length)
app.activeDocument.close ()

}

// create a document to work with
var docRef = app.documents.add (5000, 7000, 72, "Simple Line")

//line 1--it’s a straight line so the coordinates for anchor, left, and right
//for each point have the same coordinates
var lineArray = new Array ()

lineArray[0] = new PathPointInfo

lineArray[0] .kind = PointKind.CORNERPOINT

lineArray[0] .anchor = Array (100, 100)
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lineArray [0]
lineArray [0]

lineArray[1]
lineArray[1]
lineArray[1]
lineArray [1]
lineArray [1]

var lineSubPathArray =
lineSubPathArray[0] =
lineSubPathArray[0] .operation =
lineSubPathArray[0] .closed =

.kind =
.anchor = Array (150, 200)

.leftDirection = lineArray[1] .anchor
.rightDirection =

.leftDirection = lineArray[0] .anchor
.rightDirection =

lineArray[0] .anchor

= new PathPointInfo
PointKind.CORNERPOINT

lineArray[1] .anchor

new Array ()

new SubPathInfo ()
ShapeOperation.SHAPEXOR
false

lineSubPathArray[0] .entireSubPath = lineArray

// line 2

var lineArray2 =
lineArray2 [0]
lineArray2 [0]
lineArray2 [0]
lineArray2 [0]
lineArray2 [0]

lineArray2[1]
lineArray2[1]
lineArray2[1]
lineArray2[1]
lineArray2[1]

lineSubPathArray[1]
lineSubPathArray[1]
lineSubPathArray[1]
lineSubPathArray[1]

new Array ()

= new PathPointInfo

.kind = PointKind.CORNERPOINT

.anchor = Array (150, 200)
.leftDirection = lineArray2[0] .anchor
.rightDirection = lineArray2 [0] .anchor

= new PathPointInfo

.kind = PointKind.CORNERPOINT

.anchor = Array (200, 100)
.leftDirection = lineArray2[1l] .anchor
.rightDirection = lineArray2[1] .anchor

= new SubPathInfo ()

.operation = ShapeOperation.SHAPEXOR
.closed = false

.entireSubPath = lineArray?2

//ice cream curve

//it’s a curved

line, so there are 3 points, not 2

//coordinates for the middle point (lineArray3[1]) are different.

//The left direc
//The right dire
//You can change

tion is positioned "above" the anchor on the screen.
ction is positioned "below" the anchor
the coordinates for these points to see

//how the curve works...

var lineArray3 =
lineArray3[0]
lineArray3[0]
lineArray3[0]
lineArray3[0]
lineArray3[0]

lineArray3[1]
lineArray3[1]
lineArray3[1]
lineArray3[1]
lineArray3[1]

lineArray3[2]
lineArray3[2]
lineArray3[2]
lineArray3[2]
lineArray3[2]

new Array ()

= new PathPointInfo

.kind = PointKind.CORNERPOINT

.anchor = Array (200, 100)
.leftDirection = lineArray3[0] .anchor
.rightDirection = lineArray3[0] .anchor

= new PathPointInfo

.kind = PointKind.CORNERPOINT
.anchor = Array (150, 50)
.leftDirection = Array (100, 50)
.rightDirection = Array (200, 50)

= new PathPointInfo

.kind = PointKind.CORNERPOINT

.anchor = Array (100, 100)
.leftDirection = lineArray3[2] .anchor
.rightDirection = lineArray3[2] .anchor



Adobe Photoshop CS4
JavaScript Scripting Reference JavaScript Object Reference 140

lineSubPathArray[2] = new SubPathInfo()
lineSubPathArray[2] .operation = ShapeOperation.SHAPEXOR
lineSubPathArray[2] .closed = false

lineSubPathArray[2] .entireSubPath = lineArray3

//create the path item
var myPathItem = docRef.pathItems.add("A Line", lineSubPathArray)

// stroke it so we can see something
myPathItem. strokePath (ToolType .BRUSH)

// Reset the application preferences
preferences.rulerUnits = startRulerUnits
preferences.typeUnits = startTypeUnits
displayDialogs = startDisplayDialogs
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The collection of Pathltem objects in a document.

Access through the Document.pathltems collection property. For example, this creates a new path item
using a previously-defined set of subpaths:

app.activeDocument .pathItems.add ("myPath", lineSubPathInfoArray) ;

Property Value type What it is

length number Read-only. The number of pathItem objects in the
pathItems collection.

parent Document Read-only. The pathItems object's container.

typename string Read-only. The class name of the referenced pathitems
object.

Method Parameter type Returns What it does

add _ pathTItem Createsa new path item object and adds it

(name, string to this collection.

array of SubPathInfo

entirePath) . .
A new SubPathltem object is created for
each subPathInfo object provided in
entirePath, and those SsubPathItem
objects are added to the subPathltems
collection of the returned Pathltem.
getByName pPathItem Get the first elementin the pathItems
(name) string collection with the provided name.
removeAll Removes all pathTtem objects from the

0 pathItems collection.
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Represents the anchor and control-handle endpoints for a path segment. Each point (the anchor point,
left-direction point, and right-direction point) is an array containing X and Y position coordinates.

e Use the pathproint object to retrieve information about the points that describe existing path
segments. The properties are read-only. Access PathPoint objects through the SubPathltem.pathPoints

property.

e Use PathPointInfo with Pathltems.add() to create path points. The properties are writeable.

For paths that are straight segments (not curved), the coordinates of all three points are the same. For
curved segements, the the coordinates are different. The difference between the anchor point and the left
or right direction points determines the arc of the curve. You use the left direction point to bend the curve
"outward" or make it convex; you use the right direction point to bend the curve "inward" or make it

concave.

Property Value type What itis

anchor array of Read-only. The X and Y coordinates of the anchor point of the
UnitValue
—_— curve.

kind PointKind Read-only. The role (corner or smooth) this point plays in the

containing path segment.

leftDirection array of Read-only. The location of the left-direction endpoint (in’
UnitValue "
— position).

parent SubPathItem Read-only. The containing subpath object.

rightDirection array of Read-only. The location of the right-direction endpoint (‘out’
UnitValue "
— position).

typename string Read-only. The class name of the referenced pathPoint

object.
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Used to create a PathPoint, which represents the anchor and control-handle endpoints for a path segment.
Each point (the anchor point, left-direction point, and right-direction point) is an array containing X and Y
position coordinates.

e Use the JavaScript new operator to create these objects, and store them in the
SubPathinfo.entireSubPath property before using that object to create a path item with
Pathltems.add().

See the PathPointInfo sample script below.

e Theresulting SubPathltem objects contain the resulting PathPoint objects. Use the PathPoint object to
retrieve information about the points that describe existing path segments. The properties are
read-only.

For paths that are straight segments (not curved), the coordinates of all three points are the same. For
curved segements, the the coordinates are different. The difference between the anchor point and the left
or right direction points determines the arc of the curve. You use the left direction point to bend the curve
"outward" or make it convex; you use the right direction point to bend the curve "inward" or make it

concave.
Property Value type Whatitis
anchor array of Read-write. The X and Y coordinates of the anchor point of
UnitValue
—— the curve.
kind PointKind Read-write. The role (corner or smooth) this point plays in the
containing path segment.
leftDirection array of Read-write. The location of the left-direction endpoint ('in’
UnitValue i
—_— position).
rightDirection array of Read-write. The location of the right-direction endpoint (‘out’
UnitValue .
—_— position).
typename string Read-only. The class name of the referenced PathPointInfo
object.

function drawLine (doc, start, stop) ({

var startPoint = new PathPointInfo() ;
startPoint.anchor = start;
startPoint.leftDirection = start;
startPoint.rightDirection = start;
startPoint.kind = PointKind.CORNERPOINT;

var stopPoint = new PathPointInfol() ;
stopPoint.anchor = stop;
stopPoint.leftDirection = stop;
stopPoint.rightDirection = stop;
stopPoint.kind = PointKind.CORNERPOINT;
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var spi = new SubPathInfo() ;

spi.closed = false;

spi.operation = ShapeOperation.SHAPEXOR;
spi.entireSubPath = [startPoint, stopPoint];

var line = doc.pathItems.add("Line", [spi]);
line.strokePath (ToolType.PENCIL) ;
line.remove () ;

Vi

drawLine (app.activeDocument, [100,100], [200,200]);
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PathPoints

A collection of PathPoint objects that define a subpath, kept in the SubPathltem.pathPoints property.

Properties
Property Value type Whatit is
length number Read-only. The number of elements in the collection.
parent SubPathItem Read-only. The containing subpath object.
typename string Read-only. The class name of the referenced PathPoints
object.




Adobe Photoshop CS4
JavaScript Scripting Reference JavaScript Object Reference 146

Options for opening a document in generic Adobe PDF format using the Application.open() method.

Property Value type Whatitis

antiAlias boolean Read-write. True to use antialias.

bitsPerChannel BitsPerChannelType Read-write. The number of bits per channel.

constrainProportions boolean DEePRECATED for Adobe Photoshop CS4.

cropPage CropToType Read-write. The method of cropping to use.

height Unitvalue DEePRECATED for Adobe Photoshop CS4.

mode OpenbDocumentMode  Read-write. The color model to use.

name string Read-write. The name of the object.

page number Read-write. The page or image to which to open
the document, depending on the value of
usePageNumber.

resolution number Read-write. The resolution of the document (in

pixels per inch).

suppressWarnings boolean Read-write. True to suppress warnings when
opening the document.

typename string Read-only. The class name of the referenced
PDFOpenOptions object.

usePageNumber boolean Read-write. When true, the page property refers
to a page number; when false, it refers to an
image number.

width Unitvalue DEePRECATED for Adobe Photoshop CS4.
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Options for saving a document in Adobe PDF format using the Document.saveAs() method.

Property Value type What it is

alphaChannels boolean Read-write. True to save the alpha channels
with the file.

annotations boolean Read-write. True to save comments with the
file.

colorConversion boolean Read-write. True to convert the color profile

to a destination profile.

convertToEightBit boolean Read-write. True to convert a 16-bit image
to 8-bit for better compatibility with other
applications.

description string Read-write. Description of the save options
to use.

destinationProfile string Read-write. Description of the final RGB or

CMYK output device, such as a monitor or a
press standard.

downgradeColorProfile boolean DEePRECATED for Adobe Photoshop CS4.

downSample PDFResample Read-write. The down sample method to
use.

downSampleSize number Read-write. The size to downsample images

if they exceed the limit in pixels per inch.

downSampleSizeLimit number Read-write. Limits downsampling or
subsampling to images that exceed this
value in pixels per inch.

embedColorProfile boolean Read-write. True to embed the color profile
in the document.

embedFonts boolean DEePRECATED for Adobe Photoshop CS4.

embedThumbnail boolean Read-write. True to include a small preview
image in Adobe PDF files.

encoding PDFEncoding Read-write. The type of compression to use
(default: PDFEncoding . PDFZIP).

interpolation boolean DEePRECATED for Adobe Photoshop CS4.
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Property Value type What it is (Continued)

jpegQuality number [0..12] Read-write. The quality of the produced
image, which is inversely proportionate to
the compression amount.
Valid only when encoding =
PDFEncoding.JPEG.

layers boolean Read-write. True to save the document’s
layers.

optimizeForWeb boolean Read-write. True to improve performance of
PDF files on Web servers.

outputCondition string Read-write. An optional comment field for
inserting descriptions of the output
condition. The text is stored in the PDF/X
file.

outputConditionID string Read-write. Indentifier for the output
condition.

PDFCompatibility PDFCompatibility Read-write. The PDF version to make the
document compatible with.

PDFStandard PDFStandard Read-write. The PDF standard to make the
document compatible with.

preserveEditing boolean Read-write. True to reopen the PDF in
Adobe Photoshop CS4 with native
Photoshop data intact.

presetFile string Read-write. The preset file to use for
settings.
Note: This option overrides other settings.

profileInclusionPolicy boolean Read-write. True to show which profiles to
include.

registryName string Read-write. URL where the output condition
is registered.

spotColors boolean Read-write. True to save spot colors.

tileSize nunber Read-write. Compression option.
Valid only when encoding =
PDFEncoding.JPEG2000.

transparency boolean DEePRECATED for Adobe Photoshop CS4.

typename string Read-only. The class name of the referenced
PDFSaveOptions object.

useOutlines boolean DEePRECATED for Adobe Photoshop CS4.
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Property Value type What it is (Continued)
vectorData boolean DEePRECATED for Adobe Photoshop CS4.
view boolean

Read-write. True to open the saved PDF in
Adobe Acrobat.
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DEPRECATED in Adobe Photoshop CS4. Kodak PhotoCD is now found in the Goodies folder on the Adobe
Photoshop CS4 Install DVD.

Options for opening a document in Kodak Photo CD (PCD) format (including high-resolution files from Pro
Photo CD discs) using the Application.open() method.

Property Value type What it is

colorProfileName string Read-write. The profile to use when reading the
image.

colorSpace PhotoCDColorSpace  Read-write. The colorspace for the image.

orientation Orientation Read-write. The image orientation.

pixelSize PhotoCDSize Read-write. The image dimensions.

resolution number Read-write. The image resolution (in pixels per
inch).

typename string Read-only. The class name of the referenced

photoCDOpenOptions object.
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Options for saving a document in PSD format using the Document.saveAs() method.

Property Value type Whatit is

alphaChannels boolean Read-write. True to save the alpha channels.

annotations boolean Read-write. True to save the annotations.

embedColorProfile boolean Read-write. True to embed the color profile in the
document.

layers boolean Read-write. True to preserve the layers.

spotColors boolean Read-write. True to save the spot colors.

typename string Read-only. The class name of the referenced

photoshopSaveOptions object.
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PICTFileSaveOptions

Options for saving a document in PICT format using the Document.saveAs() method.

Properties

Property Value type Whatitis

alphaChannels boolean Read-write. True to save the alpha channels.

compression PICTCompression Read-write. The type of compression to use
(default: PICTCOMpPression . NONE).

embedColorProfile boolean Read-write. True to embed the color profile in the
document.

resolution PICTBitsPerPixels  Read-write. The number of bits per pixel.

typename string Read-only. The class name of the referenced

PICTFileSaveOptions object.
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PICTResourceSaveOptions

Options for saving a document as a PICT Resource file using the Document.saveAs() method.

Properties

Property Value type Whatitis

alphaChannels boolean Read-write. True to save the alpha channels.

compression PICTCompression Read-write. The type of compression to use (default:
PICTCompression.NONE).

embedColorProfile boolean Read-write. True to embed the color profile in the
document.

name string Read-write. The name of the PICT resource.

resolution PICTBitsPerPixels Read-write. The number of bits per pixel.

resourceID number Read-write. The ID of the PICT resource (default:
128).

typename string Read-only. The class name of the referenced
PICTResourceSaveOptions object.
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PicturePackageOptions

Options for a picture package created with Application.makePicturePackage().

Properties

Property Value type What itis

content PicturePackageTextType Read-write. The content information (default:
PicturePackageTextType . NONE).

flatten boolean Read-write. True if all layers in the final
document are flattened (default: true).

font GalleryFontType Read-write. The font used for security text
(default: GalleryFont Type.ARIAL).

fontSize number Read-write. The font size used for security
text (default: 12).

layout string Read-write. The layout to use to generate the
picture package (default: " (2) 5x7").

mode NewDocumentMode Read-write. Read-write. The color profile to
use as the document mode (default:
NewDocumentMode . RGB).

opacity number Read-write. The web page security opacity as
a percent (default: 100).

resolution number Read-write. The resolution of the document
in pixels per inch (default: 72.0).

text string Read-write. The picture package custom text.
Valid only when content =
PicturePackageType.USER.

textColor RGBColor Read-write. The color to use for security text.

textPosition  GallerySecurityTextPositionType Read-write. The security text position
(default:
GallerySecurityTextPositionType.
CENTERED).

textRotate GallerySecurityTextRotateType Read-write. The orientation to use for
security text (default:
GallerySecurityTextRotateType.ZERO).

typename string Read-only. The class name of the referenced
PicturePackageOptions object.
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PixarSaveOptions

Options for saving a document in Pixar format using the Document.saveAs() method.

Properties
Property Value type What itis
alphaChannels boolean Read-write. True to save the alpha
channels.
typename string Read-only. The class name of the
referenced PixarSaveOptions
object.
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PNGSaveOptions

Options for saving a document in PNG format using the Document.saveAs() method.

Properties
Property Value type What it is
interlaced boolean Read-write. True to interlace rows (default: false).
typename string Read-only. The class name of the referenced
PNGSaveOptions object.
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Represents application preferences for Photoshop. Access this object through the Application.preferences

property. For example:

app.preferences.rulerUnits = Units.PIXELS

app.preferences.typelUnits = TypeUnits.PIXELS

Setting values in this object is equivalent to selecting Edit > Preferences (in Windows) or Photoshop >
Preferences (in Mac OS) in the Adobe Photoshop CS4 application. For explanations of individual settings,

see Adobe Photoshop CS4 Help.

Property Value type What it is

additionalPluginFolder File Read-write. The path to an additional
plug-in folder.
Valid only when
useAdditionalPluginFolder = true.

appendExtension SaveBehavior Read-write. The preferred policy for
writing file extensions in Windows.

askBeforeSavingLayeredTIFF boolean Read-write. True to ask the user to verify
layer preservation options when saving a
file in TIFF format.

autoUpdateOpenDocuments boolean Read-write. True to automatically update
open documents.

beepWhenDone boolean Read-write. True to beep when a process
finishes.

colorChannelsInColor boolean Read-write. True to display component
channels in the Channels palette in color.

colorPicker ColorPicker Read-write. The preferred color selection
tool.

columnGutter number [0.1..600.0] Read-write. The width of the column
gutters (in points).

columnWidth number [0.1..600.0] Read-write. Column width (in points)

createFirstSnapshot

dynamicColorSliders

editLogItems

boolean

boolean

EditLogItemsType

Read-write. True to automatically make
the first snapshot when a new document
is created.

Read-write. True if dynamic color sliders
appear in the Color palette.

Read-write. The preferred level of detail
in the history log. Valid only when

useHistoryLog = true.
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Property Value type What it is (Continued)

exportClipboard boolean Read-write. True to retain Adobe
Photoshop CS4 contents on the
clipboard after you exit the application.

fontPreviewSize FontPreviewType Read-write. The preferred type size to use
for font previews in the type tool font
menus.

fullSizePreview boolean Read-write. True to show image preview
as a full size image, false to show
thumbnail (in Mac OS only).

gamutWarningOpacity number [0..100] Read-write. Opacity value as a
percentage.

gridSize GridSize Read-write. The preferred size to use for
squares in the grid.

gridstyle GridLineStyle Read-write. The preferred formatting
style for non-printing grid lines.

gridSubDivisions nurber [1..100] Read-write. Number of grid subdivisions.

guideStyle GuideLineStyle Read-write. The preferred formatting
style for non-printing guide lines.

iconPreview boolean Read-write. True to use icon previews (in
Mac OS only).

imageCacheLevels number [1..8] Read-write. The number of images to
hold in the cache.

imagePreviews SaveBehavior Read-write. The preferred policy for
writing image previews in Windows.

interpolation ResampleMethod Read-write. The method to use to assign
color values to any new pixels created
when an image is resampled or resized.

keyboardZoomResizesWindows boolean Read-write. True to automatically resize
the window when zooming in or out
using keyboard shortcuts.

macOSThumbnail boolean Read-write. True to create a thumbnail
when saving the image (in Mac OS only).

maximizeCompatibility QueryStateType Read-write. The preferred policy for

maxRAMuse

nonLinearHistory

number [5..100]

boolean

checking whether to maximize
compatibility when opening PSD files.

Read-write. The maximum percentage of
available RAM used by Adobe
Photoshop CS4 (5 - 100).

Read-write. True to allow non-linear
history.
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Property Value type What it is (Continued)

numberofHistoryStates number Read-write. The number of history states
to preserve.

otherCursors OtherPaintingCursors |Read-write. The preferred type of pointer
to use with certain tools.

paintingCursors PaintingCursors Read-write. The preferred type of pointer
to use with certain tools.

parent Application Read-write. The containing application.

pixelDoubling boolean Read-write. True to halve the resolution
(double the size of pixels) to make
previews display more quickly.

pointSize PointType Read-write. The point/pica size.

recentFileListLength number [0..30] Read-write. The number of items in the
recent file list.

rulerUnits Units Read-write. The unit the scripting system
will use when receiving and returning
values.

saveLogItems SaveLogItemsType Read-write. Thepreferred location of
history log data when saving the history
items.

saveLogIltemsFile File Read-write. The path to the history log
file, when the preferred location is a file.

savePalettelLocations boolean Read-write. True to make new palette
locations the default location.

showAsianTextOptions boolean Read-write. True to display Asian text
options in the Paragraph palette.

showEnglishFontNames boolean Read-write. True to list Asian font names
in English.

showSliceNumber boolean Read-write. True to display slice numbers
in the document window when using the
Slice tool.

showToolTips boolean Read-write. True to show pop up
definitions on mouse over.

smartQuotes boolean Read-write. True to use curly, false to use
straight quote marks.

typename string Read-only. The class name of the
referenced preferences object.

typeUnits TypeUnits Read-write. The preferred unit for text

character measurements.
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Property Value type What it is (Continued)
useAdditionalPluginFolder boolean Read-write. True to use an additional
folder for compatible plug-ins stored
with a different application.
useHistoryLog boolean Read-write. True to create a log file for
history states.
useLowerCaseExtension boolean Read-write. True to use lowercase for file
extensions.
useShiftKeyForToolSwitch boolean Read-write. True to enable cycling
through a set of hidden tools.
useVideoAlpha boolean Read-write. True to enable Adobe
Photoshop CS4 to send transparency
information to your computer’s video
board. (Requires hardware support.)
windowsThumbnail boolean Read-write. True to create a thumbnail

when saving the image in Windows.
(Requires hardware support.)
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Options for Adobe PDF presentations created using Application.makePDFPresentation().

Property Value type Whatit is

autoAdvance boolean Read-write. True to auto advance images when when
viewing the presentation (default: true).
Valid only when presentation = true.

includeFilename boolean Read-write. True to include the file name for the image
(default: false).

interval number [1..60] Read-write. The time in seconds before the view is auto
advanced (default: 5).
Valid only when autoAdvance = true.

loop boolean Read-write. True to begin the presentation again after
the last page (default: false).
Valid only when autoAdvance = true.

magnification MagnificationType Read-write. The magnification type to use when viewing
the image.

PDFFileOptions PDFSaveOptions Read-write. Options to use when creating the PDF file.

presentation boolean Read-write. True if the output will be a presentation
(default: false); when false, the outputis a Multi-Page
document.

transition TransitionType Read-write. The method for transition from one image to
the next (default: TransitionType . NONE).
Valid only when autoAdvance = true..

typename string Read-only. The class name of the referenced

PresentationOptions object.
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Options for opening a document in RAW format using the Application.open() method.

Property Value type What it is

bitsPerChannel number Read-write. The number of bits for each channel.
The only valid values are BitsPerChannelType .EIGHT
Or BitsPerChannelType.SIXTEEN.

byteOrder ByteOrder Read-write. The order in which multibyte values are
read.
Valid only when bitsPerChannel =
BitsPerChannelType.SIXTEEN.

channelNumber number [1..56] Read-write. The number of channels in the image. The
value of cannot exceed the number of channels in the
image.
When bitsPerChannel =
BitsPerChannelType.SIXTEEN, the only valid values
are 1,3, or4.

headerSize number Read-write. The number of bytes of information that

[0..1919999] . . . . . .

will appear in the file before actual image information
begins; that is, the number of zeroes inserted at the
beginning of the file as placeholders.

height number Read-write. The height of the image (in pixels).

interleaveChannels boolean Read-write. True to store color values sequentially.

retainHeader boolean Read-write. True to retain the header when saving.
Valid only when headerSize is 1 or greater.

typename string Read-only. The class name of the referenced
RawFormatOpenOptions object.

width number Read-write. The image width in pixels.
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RawSaveOptions

Options for saving a document in RAW format using the Document.saveAs() method.

Properties
Property Value type What itis
alphaChannels boolean Read-write. True if alpha channels should be saved.
spotColors boolean Read-write. True if the spot colors should be saved.
typename string Read-only. The class name of the referenced RawsaveOptions
object.
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RGBColor

Defines an RGB color, used in the SolidColor object.

See also CMYKColor, GrayColor, HSBColor, LabColor, NoColor.

Properties
Property Value type What it is
blue number [0..255] Read-write. The blue color value (default: 255).
green number [0..255] Read-write. The green color value (default: 255)
hexValue string Read-write. The hexadecimal representation of the color.
red number [0..255] Read-write. The red color value (default: 255)
typename string Read-only. The class name of the referenced RGBColor object.
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The selected area of a document or layer. Access through the Document.selection property. For example:

app.activeDocument.selection.fill (app.foregroundColor)

Many of the properties and methods use the UnitValue type, which combines measurement values with
the measurement unit. For information about this type, see the JavaScript Tools Guide.

Property Value type What it is
bounds array of Unitvalue  Read-only. The bounding rectangle of the entire selection.
parent Document Read-only. The object's container.
solid boolean Read-only. True if the bounding rectangle is a solid.
typename string Read-only. The class name of the referenced selection
object.
Method Parameter type Returns What it does
clear Clears the selection and
0 does not copy it to the
clipboard.
contract Contracts (reduces) the
(by) Unitvalue selection by the specified
amount.
copy Copies the selection to the
([merge] ) boolean clipboard. When the
optional argument is used
and set to true, a merged
copy is performed (all visible
layers in the selection are
copied).
cut Clears the current selection
0 and copies it to the
clipboard.
deselect Deselects the current
0 selection.
expand Expands the selection by the
(by) UnitValue specified amount.
feather Feathers the edges of the
(by) Unitvalue selection by the specified

amount.
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Method Parameter type Returns What it does (Continued)
£ill Fills the selection.
(filltype SolidColor .
[ mode] ColorBlendMode opacity Is a percentage
[: opacity] number [1..100] value.
[, preserveTransparency]) boolean
grow Grows the selection to
(tolerance, Eumll’er include all adjacent pixels
antialias) cotean falling within the specified
tolerance range.
invert Inverts the selection
0 (deselects the selection and
selects the rest of the layer
or document).
Tip: To flip the selection
shape, see rotate.
load Loads the selection from the
(£rom Channel specified channel.
[, combination] SelectionType
[, inverting]) boolean
makeWorkPath number Makes this selection item
([tolerance]) the work path for this
document.
resize Resizes the selected area to
( [horizontall nuﬁer the specified dimensions
, t1 1 numoer .
% Zﬁ&éﬁi ] AnchorPosition and anchor position.
resizeBoundary Changes the size of the
([horizontall nuxer selection to the specified
, £1 1 numoer . .
% Zﬁ&éﬁi ] AnchorPosition d|m§q5|ons around the
! specified anchor.
rotate Rotates the selection by the
(angle 2““‘1;91’ N specified amount around
[, anchor]) PEROSEOSLELOn the specified anchor point.
rotateBoundary Rotates the boundary of the
(angle number selection around the
[, anchor]) AnchorPosition specified anchor.
select Selects the specified region.
(region array of number .
[ typel SelectionType The region parameter is an
[ feather] number array of four coordinates,
[, antiAlias]) boolean [left, top, right, bottom].
selectAll Selects the entire layer.

0
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Method Parameter type Returns What it does (Continued)
£ill Fills the selection.
(filltype SolidColor .
[ mode] ColorBlendMode opacity Is a percentage
[: opacity] number [1..100] value.
[, preserveTransparency]) boolean
grow Grows the selection to
(tolerance, Eumll’er include all adjacent pixels
antialias) cotean falling within the specified
tolerance range.
invert Inverts the selection
0 (deselects the selection and
selects the rest of the layer
or document).
Tip: To flip the selection
shape, see rotate.
load Loads the selection from the
(£rom Channel specified channel.
[, combination] SelectionType
[, inverting]) boolean
makeWorkPath number Makes this selection item
([tolerance]) the work path for this
document.
resize Resizes the selected area to
( [horizontall nuﬁer the specified dimensions
, t1 1 numoer .
% Zﬁ&éﬁi ] AnchorPosition and anchor position.
resizeBoundary Changes the size of the
([horizontall nuxer selection to the specified
, £1 1 numoer . .
% Zﬁ&éﬁi ] AnchorPosition d|m§q5|ons around the
! specified anchor.
rotate Rotates the selection by the
(angle 2““‘1;91’ N specified amount around
[, anchor]) PEROSEOSLELOn the specified anchor point.
rotateBoundary Rotates the boundary of the
(angle number selection around the
[, anchor]) AnchorPosition specified anchor.
select Selects the specified region.
(region array of number .
[ typel SelectionType The region parameter is an
[ feather] number array of four coordinates,
[, antiAlias]) boolean [left, top, right, bottom].
selectAll Selects the entire layer.

0
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Method Parameter type Returns What it does (Continued)
£ill Fills the selection.
(filltype SolidColor .
[ mode] ColorBlendMode opacity Is a percentage
[: opacity] number [1..100] value.
[, preserveTransparency]) boolean
grow Grows the selection to
(tolerance, Eumll’er include all adjacent pixels
antialias) cotean falling within the specified
tolerance range.
invert Inverts the selection
0 (deselects the selection and
selects the rest of the layer
or document).
Tip: To flip the selection
shape, see rotate.
load Loads the selection from the
(£rom Channel specified channel.
[, combination] SelectionType
[, inverting]) boolean
makeWorkPath number Makes this selection item
([tolerance]) the work path for this
document.
resize Resizes the selected area to
( [horizontall nuﬁer the specified dimensions
, t1 1 numoer .
% Zﬁ&éﬁi ] AnchorPosition and anchor position.
resizeBoundary Changes the size of the
([horizontall nuxer selection to the specified
, £1 1 numoer . .
% Zﬁ&éﬁi ] AnchorPosition d|m§q5|ons around the
! specified anchor.
rotate Rotates the selection by the
(angle 2““‘1;91’ N specified amount around
[, anchor]) PEROSEOSLELOn the specified anchor point.
rotateBoundary Rotates the boundary of the
(angle number selection around the
[, anchor]) AnchorPosition specified anchor.
select Selects the specified region.
(region array of number .
[ typel SelectionType The region parameter is an
[ feather] number array of four coordinates,
[, antiAlias]) boolean [left, top, right, bottom].
selectAll Selects the entire layer.

0
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Method Parameter type Returns What it does (Continued)
selectBorder Selects the selection border
(width) UnitValue only (in the specified width);
subsequent actions do not
affect the selected area
within the borders.
similar Grows the selection to
(tolerance, Eum?er include pixels throughout
antiAlias) cotean the image falling within the
tolerance range.
smooth Cleans up stray pixels left
(radius) number inside or outside a
color-based selection
(within the radius specified
in pixels).
store Saves the selection as a
(into Channel channel.
[, combination]) SelectionType
stroke Strokes the selection border.
(strokeColor, % opacity is a percentage
i dth nu er
Yl location] StrokeLocation value.
[' node] ColorBlendMode
[’ opacity] number [1..100]
[, preserveTransparency]) boolean
translate Moves the entire selection
([deltax] % relative to its current
[, deltay]) UnitValue position.
translateBoundary Moves the selection relative
([deltax] UnitValue to its current position.
[, deltaY]) Unitvalue

The following script creates a checkerboard using the following steps:

e Create an 800 x 800 pixel document.

e Divide the entire document into 100 x 100 pixel squares.

e Select every other square in the first row, then shift the selection criteria to select the alternate squares
in the following row. Repeat until every other square in the document is selected.

e Fill the selected squares with the foreground color from the palette.

e Invert the selection and fill the newly selected squares with the background color from the palette.

e Deselect the squares to remove the selection outlines (the "marching ants").

Selection.jsx

// Save the current preferences

var startRulerUnits =

app.preferences.rulerUnits
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var startTypeUnits = app.preferences.typeUnits
var startDisplayDialogs = app.displayDialogs

// Set Adobe Photoshop CS4 to use pixels and display no dialogs
app.preferences.rulerUnits = Units.PIXELS
app.preferences.typeUnits = TypeUnits.PIXELS
app.displayDialogs = DialogModes .NO

//Close all the open documents
while (app.documents.length)
app.activeDocument.close ()

}

//Create variables for the 800 pixel board divided in even 100 x 100 squares
var docSize = 800

var cells = 8

var cellSize = docSize / cells

// create a new document
var checkersDoc = app.documents.add (docSize, docSize, 72, "Checkers")

// Create a variable to use for selecting the checker board

// That allows me to shift the selection one square to the right
//on every other row, and then shift back for the rows in between.
var shiftIt = true

// loop through vertically to create the first row
for (var v = 0; v < docSize; v += cellSize) {

// Switch the shift for a new row
shiftIt = !shiftIt

// loop through horizontally
for (var h = 0; h < docSize; h += (cellSize * 2)) {

// push over the cellSize to start with only
if (shiftIt && h == 0) {
h += cellSize

// Select a square
selRegion = Array (Array(h, v),
Array (h + cellSize, v),
Array (h + cellSize, v + cellSize),
Array (h, v + cellSize),
Array (h, v))

// In the first ineration of the loop, start the selection
//In subsequent iterations, use the EXTEND constant value
//of the select () method to add to the selection (in the loop’s else clause)

if (h == 0 && v == 0) {
checkersDoc.selection.select (selRegion)
} else {

checkersDoc.selection.select (selRegion, SelectionType.EXTEND)

// turn this off for faster execution
// turn this on for debugging
WaitForRedraw ()
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}

// Fill the current selection with the foreground color
checkersDoc.selection.fill (app. foregroundColor)

//Invert the selection
checkersDoc.selection.invert ()

// Fill the new selection with the background color
checkersDoc.selection.fill (app.backgroundColor)

// Clear the selection to get rid of the non-printing borders
checkersDoc.selection.deselect ()

// Reset the application preferences
app.preferences.rulerUnits = startRulerUnits
app.preferences.typeUnits = startTypeUnits
app.displayDialogs = startDisplayDialogs

// A helper function for debugging
// It also helps the user see what is going on
// if you turn it off for this example you
// get a flashing cursor for a number time
function WaitForRedraw ()
{
var eventWait = charIDToTypeID("Wait")
var enumRedrawComplete = charIDToTypeID ("RdACm")
var typeState = charIDToTypeID("Stte")
var keyState = charIDToTypelID("Stte")

var desc = new ActionDescriptor ()
desc.putEnumerated (keyState, typeState, enumRedrawComplete)

executeAction (eventWait, desc, DialogModes.NO)
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SGIRGBSaveOptions

Options for saving a document in SGIRGB format using the Document.saveAs() method.

Note: The SGIRGB format is not installed automatically with Adobe Photoshop CS4.

Properties

Property Value type Whatitis

alphaChannels boolean Read-write. True to save the alpha
channels.

spotColors boolean Read-write. True to save the spot
colors.

typename string Read-only. The class name of the
referenced SGIRGBSaveOptions
object.
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SolidColor

A color definition used in the document. Maps a color to equivalents in all available color models.

e Used in Application.backgroundColor and foregroundColor properties, in Channel.color, in

ColorSampler.color, and in Textltem.color

e Passed to Pathltem fillPath(), Selection fill(), and Selection.stroke().

Properties
Property Value type What it is
cmyk CMYKColor Read-write. The CMYK color mode.
gray GrayColor Read-write. The Grayscale color mode.
hsb HSBColor Read-write. The HSB color mode.
lab LabColor Read-write. The LAB color mode.
model ColorModel Read-write. The color model.
nearestWebColor  RGBColor Read-only. The nearest web color to the current color.
rgb RGBColor Read-write. The RGB color mode.
typename string Read-only. The class name of the referenced solidcolor
object.
Methods
‘ Method Parameter type Returns What it does
isEqual boolean True if the solidcolor object is visually
(color) SolidColor equal to the specified color.
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An array of PathPoint objects that describes a straight or curved segment of a path, used to create a
SubPathltem.

Pass an array of these objects to the Pathltems.add() method. This method creates a SubPathltem object

for each subrathInfo object, and creates and returns a new Pathltem object for the path represented by
all of the subpaths.

e Use subPathInfo to create subpaths; the properties are writeable.

e Use the SubPathltem object to retrieve information about existing subpaths. The properties are

read-only.

Property Value type Whatit is

closed boolean Read-write. True if the path describes an enclosed area.

entireSubPath array of PathPoint Read-write.

operation ShapeOperation Read-write. The subpath’s operation on other
subpaths. Specifies how to combine the shapes if the
destination path already has a selection.

typename string Read-only. The class name of the referenced

SubPathInfo object.
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Represents a subpath; a collection of subpaths make up a Pathltem.

Create these objects by passing SubPathInfo objects to the Pathltems.add() method. This method creates
a subPathItem object for each SubPathInfo object, and creates and returns a new Pathltem object for the
path represented by all of the subpaths. Access these objects in the Pathltem.subPathltems collection.

e Use the SubPathltem object to retrieve information about existing subpaths. The properties are

read-only.

e Use SubPathlInfo to create subpaths; the properties are writeable.

Property Value type What it is

closed boolean Read-only. True if the path is closed.

operation ShapeOperation Read-only. How this object behaves when it intersects
another SubPathltem object. Specifies how to combine the
shapes if the destination path already has a selection.

parent PathItem Read-only. The object's container.

pathPoints PathPoints Read-only. The PathpPoints collection.

typename string Read-only. The class name of the referenced subrPathItem

object.
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SubPathltems

A collection of SubPathltem objects that make up a Pathltem. Access this object in the
Pathltem.subPathltems collection property.

e Use SubPathlInfo to create subpaths; the properties are writeable.

e Use the SubPathltem object to retrieve information about existing subpaths. The properties are

read-only.
Properties
Property Value type What it is
length number Read-only. The number of elements in the collection.
parent PathItem Read-only. The containing path item.
typename string Read-only. The class name of the referenced subrathItems
object.
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Options for saving a document in TGA (Targa) format using the Document.saveAs() method.

Property Value type Whatit is

alphaChannels boolean Read-write. True to save the alpha channels.

resolution TargaBitsPerPixels Read-write. The number of bits per pixel (default:
TargaBitsPerPixels.TWENTYFOUR).

rleCompression boolean Read-write. True to use RLE compression (default: true).

typename string Read-only. The class name of the referenced

TargaSaveOptions object.
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Describes a font that is available to the application. Access this object in the Application.fonts collection.
For example:

var myFont = app.fonts.getByName ("ArialMT") ;

Property Value type What it is

family string Read-only. The font family.

name string Read-only. The name of the font.

parent Application Read-only. The containing application.
postScriptName string Read-only. The PostScript name of the font.

style string Read-only. The font style.

typename string Read-only. The class name of the referenced TextFont

object.
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The collection of fonts available on your computer. Fonts are represented by TextFont objects. Access this

object in the Application.fonts collection property. For example, this displays the number of available
fonts:

alert (app.fonts.length) ;

Property Value type What it is

length number Read-only. The number of elements in the collection.

parent Application Read-only. The containing application.

typename string Read-only. The class name of the referenced TextFonts object.

Method Parameter type Returns What it does

getByName . TextFont Gets the first element in the TextFonts
(name) string

collection with the provided name.




Adobe Photoshop CS4
JavaScript Scripting Reference JavaScript Object Reference 180

The text in an ArtLayer object whose kind property is Layerkind . TEXT. Access this object in the
ArtLayer.textltem property. For example:

myLayers [i] .textItem.contents = "Layer in " + textArray[i] + " Set Inside "
yLay

Many of the properties use the UnitValue type, which combines a measurement value with a
measurement unit. For information about this type, see the JavaScript Tools Guide.

Propert Value type What it is
y

alternateLigatures boolean Read-write. True to use alternate ligatures.

Note: Alternate ligatures are the same as
Discretionary Ligatures. See Adobe
Photoshop CS4 Help for more information.

antiAliasMethod AntiAlias Read-write. The method of anti aliasing to use.
autoKerning AutoKernType Read-write. The auto kerning option to use.
autoLeadingAmount number Read-write. The percentage to use for auto (default)

[0.01..5000.00] leading (in points).

Valid only when useAutolLeading = true.

baselinesShift UnitValue Read-write. The unit value to use in the baseline
offset of text.

capitalization TextCase Read-write. The text case.

color SolidColor Read-write. The text color.

contents string Read-write. The actual text in the layer.
desiredGlyphScaling number [50..200] Read-write. The desired amount by which to scale the

horizontal size of the text letters. A percentage value;
at 100, the width of characters is not scaled.

Valid only when justification =
Justification.CENTERJUSTIFIED,
FULLYJUSTIFIED, LEFTJUSTIFIED, Of
Justification.RIGHTJUSTIFIED.

When used, the minimumGlyphScaling and
maximumGlyphScaling values are also required.
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Property

Value type

What it is (Continued)

desiredLetterScaling

desiredWordScaling

direction

fauxBold

fauxItalic

firstLineIndent

font

hangingPunctuation

height

horizontalScale

number

[100..500]

number

[0..1000]

Direction

boolean

boolean

UnitValue
-1296..1296]

points

string

boolean

UnitValueX

number

[0..1000]

Read-write. The amount of space between letters (at
0, no space is added between letters).

Equivalent to Letter Spacing in the Justification
dialog (Select Justification on the Paragraphs
palette menu).

Valid only when justification =
Justification.CENTERJUSTIFIED,
FULLYJUSTIFIED, LEFTJUSTIFIED, Of
Justification.RIGHTJUSTIFIED

When used, the minimumLetterScaling and
maximumLetterScaling values are also required.

Read-write. The amount (percentage) of space
between words (at 100, no additional space is added
between words).

Equivalent to Word Spacing in the Justification
dialog (Select Justification on the Paragraphs
palette menu).

Valid only when justification =
Justification.CENTERJUSTIFIED,
FULLYJUSTIFIED, LEFTJUSTIFIED, Of
Justification.RIGHTJUSTIFIED.

When used, the minimumWordScaling and
maximumWordScaling values are also required.

Read-write. The text orientation.

Read-write. True to use faux bold (default: false).

Setting this to true is equivalent to selecting text and
clicking Faux Bold in the Character palette.

Read-write. True to use faux italic (default: false).

Setting this to true is equivalent to selecting text and
clicking Faux Italic in the Character palette.

Read-write. The amount (unit value) to indent the
first line of paragraphs.

Read-write. The text face of the character. Use the
PostScript Name of the font. See TextFont and use
the postScriptName property.

Read-write. True to use Roman hanging punctuation.

Read-write. The height of the bounding box (unit
value) for paragraph text.

Valid only when kind = TextType.PARAGRAPHTEXT.

Read-write. Character scaling (horizontal) in
proportion to verticalScale (a percentage value).
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Property Value type What it is (Continued)
hyphenateAfterFirst number [1..15] Read-write. The number of letters after which
hyphenation in word wrap is allowed.
hyphenateBeforeLast number [1..15] Read-write. The number of letters before which
hyphenation in word wrap is allowed.
hyphenateCapitalWords boolean Read-write. True to allow hyphenation in word wrap
of capitalized words.
hyphenateWordsLongerThan number [2..25] Read-write. The minimum number of letters a word
must have in order for hyphenation in word wrap to
be allowed.
hyphenation boolean Read-write. True to use hyphenation in word wrap.
hyphenationZone UnitValue Read-write. The distance at the end of a line that will
[0..720] pica cause a word to break in unjustified type.
hyphenLimit number Read-write. The maximum number of consecutive
lines that can end with a hyphenated word.
justification Justification  Read-write. The paragraph justification.
kind TextType Read-write. The text-wrap type.
language Language Read-write. The language to use.
leading Unitvalue Read-write. The leading amount.
leftIndent UnitValue Read-write. The amoun of space to indent text from
T-1296..1296] he lef
points the left.
ligatures boolean Read-write. True to use ligatures.
maximumGlyphScaling number [50..200] Read-write. The maximum amount to scale the

horizontal size of the text letters (a percentage value;
at 100, the width of characters is not scaled).

Valid only when justification =
Justification.CENTERJUSTIFIED,
FULLYJUSTIFIED, LEFTJUSTIFIED, Of
Justification.RIGHTJUSTIFIED.

When used, the minimumGlyphScaling and
desiredGlyphScaling values are also required.




JavaScript Scripting Reference

Adobe Photoshop CS4

JavaScript Object Reference 183

Property

Value type

What it is (Continued)

maximumLetterScaling

maximumWordScaling

minimumGlyphScaling

number

[100..500]

number

number

[0..1000]

[50..200]

Read-write. The maximum amount of space to allow
between letters (at 0, no space is added between
letters).

Equivalent to Letter Spacing in the Justification
dialog (Select Justification on the Paragraphs
palette menu).

Valid only when justification =
Justification.CENTERJUSTIFIED,
FULLYJUSTIFIED, LEFTJUSTIFIED, Of
Justification.RIGHTJUSTIFIED.

When used, the minimumLetterScaling and
desiredLetterScaling values are also required.

Read-write. The maximum amount of space to allow
between words (a percentage value; at 100, no
additional space is added between words).

Equivalent to Word Spacing in the Justification
dialog (Select Justification on the Paragraphs
palette menu).

Valid only when justification =
Justification.CENTERJUSTIFIED,
FULLYJUSTIFIED, LEFTJUSTIFIED, Of
Justification.RIGHTJUSTIFIED.

When used, the minimumWordScaling and
desiredWordScaling values are also required.

Read-write. The minimum amount to scale the
horizontal size of the text letters (a percentage value;
at 100, the width of characters is not scaled).

Valid only when justification =
Justification.CENTERJUSTIFIED,
FULLYJUSTIFIED, LEFTJUSTIFIED, Of
Justification.RIGHTJUSTIFIED.

When used, the maximumGlyphScaling and
desiredGlyphScaling values are also required.
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Property Value type What it is (Continued)
minimumLetterScaling rExlnglgerSOo] Read-write. The minimum amount of space to allow

minimumWordScaling

noBreak

oldstyle
parent

position

rightIndent

size

spaceAfter

number [0..1000]

boolean

boolean

ArtLayer

array of
UnitValue

UnitValue
-1296..1296]

points

UnitValue

UnitValue
-1296..1296]

points

between letters (a percentage value; at 0, no space is
removed between letters).

Equivalent to Letter Spacing in the Justification
dialog (Select Justification on the Paragraphs
palette menu).

Valid only when justification =
Justification.CENTERJUSTIFIED,
FULLYJUSTIFIED, LEFTJUSTIFIED, Of
Justification.RIGHTJUSTIFIED

When used, the maximumlLetterScaling and
desiredLetterScaling values are also required.

Read-write. The minimum amount of space to allow
between words (a percentage value; at 100, no
additional space is removed between words).

Equivalent to Word Spacing in the Justification
dialog (Select Justification on the Paragraphs
palette menu).

Valid only when justification =
Justification.CENTERJUSTIFIED,
FULLYJUSTIFIED, LEFTJUSTIFIED, Of
Justification.RIGHTJUSTIFIED

When used, the maximumWordScaling and
desiredWordScaling values are also required.

Read-write. True to disallow line breaks in this text.

Tip: When true for many consecutive characters, can
prevent word wrap and thus may prevent some
text from appearing on the screen.

Read-write. True to use old style type.
Read-write. The containing layer.

Read-write. The position of origin for the text. The
array members specify the X and Y coordinates.

Equivalent to clicking the text tool at a point in the
document to create the point of origin for text.

Read-write. The amount of space to indent text from
the right.

Read-write. The font size in unitvalue . NOTE: Type
was points for CS3 and older..

Read-write. The amount of space to use after each
paragraph.
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Property Value type What it is (Continued)
spaceBefore Unitvalue Read-write. The amount of space to use before each
T-1296..1296]
points paragraph.
strikeThru StrikeThruType Read-write. The text strike-through option to use.
textComposer TextComposer Read-write. The composition method to use to
evaluate line breaks and optimize the specified
hyphenation and justification options.
Valid only when kind = TextType.PARAGRAPHTEXT.
tracking number Read-write. The amount of uniform spacing between
[-1000..10000] .
multiple characters.
Tracking units are 1/1000 of an em space. The width
of an em space is relative to the current type size. In a
1-point font, 1 em equals 1 point; in a 10-point font, 1
em equals 10 points. So, for example, 100 unitsin a
10-point font are equivalent to 1 point.
typename string Read-only. The class name of the referenced
textItem object.
underline UnderlineType  Read-write. The text underlining options.
useAutoLeading boolean Read-write. True to use a font's built-in leading
information.
verticalScale number [0-1000] Read-write. Vertical character scaling in proportion to
horizontalScale (a percentage value).
warpBend number Read-write. The warp bend percentage.
[-100..100]
warpDirection Direction Read-write. The warp direction.
warpHorizontalDistortion number Read-write. The horizontal distortion of the warp (a
(-100..100] percentage value).
warpStyle WarpStyle Read-write. The style of warp to use.
warpVerticalDistortion number Read-write. The vertical distortion of the warp (a
(-100..100] percentage value).
width UnitValue Read-write. The width of the bounding box for

paragraph text.

Valid only when kind = TextType.PARAGRAPHTEXT.




Adobe Photoshop CS4

JavaScript Scripting Reference JavaScript Object Reference 186
Method Parameter type Returns What it does
convertToShape Converts the text item and its containing layer to
0 a fill layer with the text changed to a clipping
path.
createPath Creates a clipping path from the outlines of the

0 actual text items (such as letters or words).
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Options for saving a document in TIFF format using the Document.saveAs() method.

Property Value type What it is

alphaChannels boolean Read-write. True to save the alpha channels.

annotations boolean Read-write. True to save the annotations.

byteOrder ByteOrder Read-write. The order in which the document’s
multibyte values are read (default:
ByteOrder .MACOS in Mac OS, ByteOrder. IBM
in Windows).

embedColorProfile boolean Read-write. True to embed the color profile in
the document.

imageCompression TIFFEncoding Read-write. The compression type (default:
TIFFEncoding.NONE).

interleaveChannels boolean Read-write. True if the channels in the image

jpegQuality

layerCompression

layers

saveImagePyramid

spotColors

transparency

typename

number [0..12]

LayerCompression

boolean

boolean

boolean

boolean

string

will be interleaved.

Read-write. The quality of the produced
image, which is inversely proportionate to the
amount of JPEG compression.

Valid only when imageCompression =
TIFFEncoding.JPEG.

Read-write. The method of compression to use
when saving layers (as opposed to saving
composite data).

Valid only when layers = true.
Read-write. True to save the layers.

Read-write. True to preserve multi-resolution
information (default: false).

Read-write. True to save the spot colors.

Read-write. True to save the transparency as
an additional alpha channel when the file is
opened in another application.

Read-only. The class name of the referenced
TiffSaveOptions object.
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ExtendScript defines the JavaScript class Unitvalue to represent measurement values together with their
measurement units; see ‘JavaScript support in Adobe Photoshop CS4’ on page 33. For references details of
these classes, see the JavaScript Tools Guide.
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Camera RAW image XMP metadata.

For camera RAW image files, the XMP metadata is stored in a sidecar file, which is a file in the same folder as
the RAW file with the same base name and an XMP extension.

Property Value type What it is
parent Document Read-only. The containing document.
rawData string Read-write. A string containing the XMP metadata in

XML (RDF) format. See the XMP Specification for
details of this format.

typename string Read-only. The class name of the referenced
xmpMetadata object.




3

JavaScript Resource

This section describes the JavaScript resource that enables your JavaScripts to behave like a plug-in. This

includes:

e the ability to specify a menu the script appears in as a command,

e aterminology resource so the script can function with the Action Manager, which allows your script to
record and be automated by scripting parameters,

e acategory to enable ordering and grouping of commands within menus, and

e an enable string that indicates whether the command is enabled or disabled given a set of conditions.

e The strings must be valid XML syntax. The "&" character will not work for example. Use the samp; samp;
for example to get logical ‘s&' in the enableinfo block.

The JavaScript Resource has an HTML-style syntax, with each <tag> matched by a closing </tag>. This
resource needs to appear within comments ( /* ... */)and should be defined at the top of your script
file (within the first 10,240 characters of the file.)

Tag

Description

<javascriptresources>

<name>

<menu>

<about >

<enableinfo>

<eventids>

The resource definition tag.

The command name that appears in the Photoshop menu.

If this tag is not provided in the resource, the name of the command in the
menu defaults to the name of the script.

The menu the command appears in. If this tag is not provided, the
command appears in the File > Scripts menu.

Note: Currently the only supported values for <menu> are automate,
filter and help. automate puts the scriptin the File >
Automate menu for example.

A string that appears in an About box, which the user can select from the
Help > About Plug-in menu.

A boolean expression that indicates whether the command is enabled in
the menu. See Enable-info grammar.

Note: If you provide this tag, the menu item is enabled if and only if there
is at least one document open, and the boolean expression
evaluates to true. If you always want the menu item enabled, do not
use this tag.

A unique string that identifies the event. Using a UUID will ensure that your
script wont share this identifier with another script.

190
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Tag Description
<category> The category the command appears within in the menu. Used to group

and order commands in the menu. Commands are placed in the menu
alphabetically based on the string in <categorys. If two commands use
the same category, they are grouped together.

<terminology> The terminology dictionary for the script to function with the Action
Manager. See the Terminology dictionary.

This example shows a very basic <javascriptresources. With this resource, the script can be executed
by selecting the command Add a Document, which appears in the Automate menu. This command is
enabled in the menu, provided at least one document is already open. If the user requests information
about the script from the About Plug-in menu, the string contained in the <about > tag is displayed in a
dialog box.
/*

<javascriptresources

<name>Add a Document</name>

<type>automate</type>

<about>A short string providing information about the script.</about>

<enableinfos>true</enableinfo>

</javascriptresources>

*/

app .documents.add () ;

The <enableinfo> tag provides a boolean expression that, when evaluated, indicates whether the
command is enabled in the menu. You can use this expression to enable or disable the menu item based
on various characteristics of the document. The Enable Info grammar is as follows:

<booleanExpressions := <conjunction> { "||" <conjunctions> }

<conjunctions := <relation> {"&&" <relations> }

<relations> := <equality> {<relationOperators><equality>}

<equality> := <simpleExpression> {<equalityOperator><simpleExpressions}

<simpleExpression> := <term> {<addOperators><terms}

<term> := <factor> {<mulOperators<factors}

<factor> := <integer> | <intrinsics> | <ident> |
" (" <booleanExpression ")" | "(" simpleExpression ")"
"4t <factor> | "-" <factor> | "!" <factors>

<integers := digit {digit}

<intrinsics> := <limitFunction> | <dimFunction> | <inFunctions

<limitFunctions> := ( "min" | "max") " (" <simpleExpression> ","
<simpleExpression> { "," <simpleExpressions } ")"

<dimFunctions> := "dim" " (" <simpleExpression> "," <simpleExpression> ")"
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<ident> := (alpha | " ") {alpha | digit | " " }
<mulOperator> := ek |/
<addOperator> := L
<equalityOperators := M=t | mi=
<relationOperator> := L R T R
<inFunctions> := "in" " (" <simpleExpression> {"," <simpleExpression> } ")"

Operator precedence is shown in the following table. Operators are listed with the highest order of
precedence at the top of the table

Operator Description

| Or

&& And

+ - Addition or subtraction

* / Multiply or divide

< <= >= > Less than, less than or equal, greater than or equal, greater than

== I= Equals, or does not equal.

(..) in() max() min()  Functions
unary + - ! Unary operators: increment, decrement, not

The grammar provides variables and constants that you can use in the <enableinfos> expression. The
following table provides a list of the constants that are available.

Constant Name

Description

true

false
BitmapMode
GrayScaleMode
IndexedMode
RGBMode
CMYKMode
HSIMode
HSBMode
MultiChannelMode
DuotoneMode

LabMode

Boolean true
Boolean false
Bitmap mode.
Grayscale mode, 8 bit depth.
Indexed color mode.
RGB color mode.
CMYK color mode.
HSL color mode.
HSB color mode
Multichannel mode.
Duotone mode.

Lab color mode.
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Constant Name Description

Grayl6Mode Grayscale mode, 16 bits per channel
RGB48Mode RGB color mode, 16 bits per channel.
Lab48Mode LAB mode, 16 bits per channel.
CMYK64Mode CMYK mode, 16 bits per channel.

DeepMultichannelMode | Deep multichannel mode.

DuotoneléMode Duotone mode, 16 bit depth.
RGBY96Mode RGB color mode, 32 bits per channel.
Gray32Mode Grayscale mode, 32 bit depth.

The following table show the set of variables you can use in the <enableinfo> expression. The value of
these variables is set based on the properties of the active document.

Variable Name

Description

PSHOP_ImageMode

PSHOP_ ImageDepth
PSHOP_HasLayerMask
PSHOP HasSelectionMask
PSHOP_HasTransparencyMask
PSHOP_NumTargetChannels
PSHOP NumTrueChannels
PSHOP_IsAdjustorSheet
PSHOP_IsTargetComposite
PSHOP_ IsTargetSection
PSHOP_ IsTargetVisible
PSHOP_ImageWidth
PSHOP_ImageHeight

PSHOP TargetProtectFlags.

Image mode of the active document.

Depth of the active document.

Boolean indicating presence of layer mask.
Boolean indicating presence of selection mask.

Boolean indicating presence of transparency mask.

Number of target channels.
Numer of image channels.

Boolean

Boolean indicating whether channels are flattened.

Boolean.
Boolean.
Width of the image.

Height of the image.

If any arithmetic or relation operation contains an operand whose value is undefined, or a variable that is
undefined, the result of that evaluation is false.

Boolean values are treated as in C/C++, where non-zero values are true, and zero is false, with the

exception that an undefined value is also false.
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The in function (see <inFunctions) returns true is the first parameter is equal to at least one of the
subsequent parameters. A typical use might be to see if the image mode of the active document is one of
a set of image modes. For example:

in (PSHOP_ImageMode, RGBMode, CMYKMode, LabMode)

For your script to be able to record scripting parameters and be automated by them, it requires the
addition of two basic mechanisms:

e A terminology dictionary that maps your script’s user interface to human readable text, providing text
and type information for each parameter the script uses.

e Code to read parameter information when it comes from the Action Manager, rather than from the
user-interface, and code to write parameter information to the Action Manger. This code uses the
Action Manager classes ActionDescriptor, ActionList, and ActionReference.

See conditional Mode Change.jsx foran example of a script that can record and be automated by
scripting parameters.

The JavaScript resource provides a <terminology> tag that allows you to provide the terminology
dictionary for your script. The first step in creating a terminology dictionary is to review your script’s user
interface, and create human-readable strings for each element in your user interface.

For example, in the Conditional Mode Change command, the user interface requests a source mode and a
target mode. Both source mode and target mode have several options. All of these elements of the user
interface need to have entries in the terminology dictionary.

The terminology dictionary is created in a PDF dictionary format, with the following entries, and must have
the following format in the <javascriptresources:

<terminology><! [CDATA [<<<
/Version integer
/Events <<event dictionarys>>
/Classes <<class dictionary>>
/Enumerations <<enumeration dictionarys>>
>>> ]]></terminology>

Note: The information in the terminology tag needs to be wrapped in a cpaTa block so the xml parser will
ignore "/" and other tags that appear in the terminology.

The defintions for events, classes and enumerations dictionaries are provided below.
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The /Events dictionary contains an entry for each event:

/eventName [ // Name used in string-based API
(String event name) // required
/direct parameter type // optional; if omitted, no parameter
<< // optional parameter dictionary
/parameterName [ // Name used in string-based API
(String name) // required
/parameter type // required

1
// other parameters
>>

The /classes dictionary contains and entry for each class:

/className [ // Name used in string-based API
(ZString class name) // required
<< // property dictionary
/propertyName [ // Name used in string-based API
(String name) // required
/property type // required

1
// other properties
>>

The /Enumerations dictionary contains an entry for each enumerated type:

/enumTypeName // Name used in string-based API
<<
/enumValue (String name) // required

>>

For /parameter typeand /property type definitons, you can use the Class and Enumeration type
declarations you make in your own terminology dictionary, you can use declarations provided by
Photoshop or you can use basic value types.

Basic Value Types

The basic value types are shown in the following table:

Name Code Description

typelnteger 'long’ int32

typeFloat "doub IEEE 64 bit double

typeBoolean 'bool! TRUE Of FALSE.

typeText 'TEXT' Block of any number of readable characters.

typeAlias ralis’ Macintosh file system path.
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Name Code Description
typePaths 'Pth ! Windows file system path.
typePlatformFilePath 'alis' or'Pth typealias for Mac OS, typePath for Windows.
Predefined Class Types

Photoshop provides a number of predefined classes that are available for use in the terminology
dictionary. A useful subset of those classes is shown in the table below. Use these classes when they are
appropriate, but you can define new classes in the terminology resource, if necessary.

Name Code Description

classColor 'Clr ! Class for color classes.

classRGBColor '"RGBC' keyRed, keyGreen, keyBlue
classCMYKColor 'CMYC'! keyCyan, keyMagenta, keyYellow, keyBlack.
classUnspecifiedColo | 'UnsC' Unspecified.

r

classGrayscale 'Grsc' keyGray

classBookColor 'BkC1 ' Book color

classLabColor "LbCl' keyLuminance, keyA, keyB.

Generally, the names for terminology entries must be unique within a particular category and scope. It is
best to not make names unique unnecessarily; generic terms are prefereable, and if a name already exists
for something, go ahead and use it. Case matters in considering uniqueness of terminology entries.

The uniqueness rules for terminology entries are:

e All event names must be different from all other event names.

e All class names must be different from all other names.

e All enumeration type names must be different from all other enumeration type names.

e All keys must be different from all other keys used in the same class or event.

e All enumeration values must be different from all other enumeration values in the same enumeration
type.

e Aclass, event, enumeration type, key, and enumeration value can all have the same name.

This example demonstrates the terminology definition for a new event; the example uses ZStrings. The
event is called newannot, and it takes three parameters:

e annotType,an enumeration (annotType)
e at,aclass (point), and

e size, aclass (annotSizeClass).
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The annotsizeClass has two properties: width, and height, both of type £loatType. The enumeration
annotType has three values: annotUnknown, annotText, and annotSound

<terminology><! [CDATA [<<<
/Version 1
/Events
/newAnnot [ (New Annotation) <<
/annotType [ (Type) /annotType]
/at [(At) /Point]
/size [(Size) /annotSizeClass] >>]
/Classes
/annotSizeClass [(Size) <<
/width [(Width) /floatType]
/height [ (Height) /floatTypel]
>>]
/Enumerations
/annotType <<
/annotUnknown (Unknown)
/annotText (Text)
/annotSound (Sound)
>>> ]]></terminology>



Scripting Constants

This section lists and describes the enumerations defined for use with Adobe Photoshop CS4 JavaScript

properties and methods.

Constant type Values What it means
AdjustmentReference ABSOLUTE Method to use for interpreting
RELATIVE selective color adjustment
specifications:
ABSOLUTE = % of the whole.
RELATIVE = % of the existing color
amount.
Pass to ArtLayer.selectiveColor().
AnchorPosition BOTTOMCENTER The point around which to transform
BOTTOMLEFT an object. This is the point that does
BOTTOMRIGHT ‘ h biect is rotated or
MIDDLECENTER not move when an object is rotated o
MIDDLELEFT resized using methods in ArtLayer,
MIDDLERIGHT LayerSet, and Selection, or when the
ggiggﬁm entire canvas is resized with
TOPRTGHT Document.resizeCanvas().
AntiAlias CRISP Method to use to smooth edges by
NONE softening the color transition between
it dge pixels and background pixel
SMOOTH edge pixels and background pixels.
STRONG Used in a Textltem.antiAliasMethod.
AutoKernType MANUAL The type of kerning to use for
ggg?é:i characters. Used in
Textltem.autoKerning.
BatchDestinationType FOLDER The destination, if any, for
NODESTINATION batch-processed files, specified in the
SAVEANDCLOSE

BatchOptions used with the
Application.batch() method:

FOLDER: Save modified versions of the
files to a new location (leaving the
originals unchanged).

NODESTINATIONTYPE: Leave all files
open.

SAVEANDCLOSE: Save changes and
close the files.

198
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Constant type

Values

What it means

BitmapConversionType

BitmapHalfToneType

BitsPerChannelType

BlendMode

BMPDepthType

ByteOrder

CUSTOMPATTERN
DIFFUSIONDITHER
HALFTHRESHOLD
HALFTONESCREEN
PATTERNDITHER

CROSS
DIAMOND
ELLIPSE
LINE
ROUND
SQUARE

EIGHT

ONE
SIXTEEN
THIRTYTWO

COLORBLEND
COLORBURN
COLORDODGE
DARKEN
DIFFERENCE
DISSOLVE
EXCLUSION
HARDLIGHT
HARDMIX
HUE
LIGHTEN
LINEARBURN
LINEARDODGE
LINEARLIGHT
LUMINOSITY
MULTIPLY
NORMAL
OVERLAY
PASSTHROUGH
PINLIGHT
SATURATION
SCREEN
SOFTLIGHT
VIVIDLIGHT

BMP A1R5G5B5
BMP_A4R4G4B4
BMP_ASR8G8B8
BMP_R5G6B5
BMP_R8GSBS
BMP_X1R5G5B5
BMP_X4R4G4B4
BMP_X8R8G8B8
EIGHT

FOUR

ONE

SIXTEEN
THIRTYTWO
TWENTYFOUR

IBM
MACOS

Specifies the quality of an image you
are converting to bitmap mode. Used
in BitmapConversionOptions.

Specifies the shape of the dots (ink
deposits) in the halftone screen. Used
in BitmapConversionOptions.

The number of bits per color channel.
Value of Document.bitsPerChannel;
pass to Documents.add(). Also used in
PDFOpenOptions and
CameraRAWOpenOptions.

Controls how pixels in an image are
blended when a filter is applied. The
value of ArtLayer.blendMode and
LayerSet.blendMode.

The number of bits per channel (also
called pixel depth or color depth). The
number selected indicates the
exponent of 2. For example, a pixel
with a bit-depth of EI1GHT has 28 or
256, possible color values.

Used in BMPSaveOptions.

The platform-specific order in which
multibyte values are read.
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Constant type Values What it means
CameraRAWSettingsType CAMERA The default CameraRaw settings to
ggiggl‘;EDIMAGE use: the camera settings, custom
settings, or the settings of the selected
image. Set in
CameraRAWOpenOptions.
CameraRAWSize EXTRALARGE The camera RAW size type options:.
ﬁ?ﬁw EXTRALARGE=5120 x 4096
MEDIUM LARGE=4096 x 2731
“S’I;Igifw MAXIMUM=6144 X 4096
MEDIUM=3072 x 2048
MINIMUM=1536 x 1024
SMALL=2048 x 1365
Set in CameraRAWOQOpenOptions.
ChangeMode BITMAP The new color profile or mode for a
CMYK document, specified in
GRAYSCALE Document.changeMode().
INDEXEDCOLOR
LAB
MULTTCHANNEL Note: Colorimages must be changed
RGB to GRAYSCALE mode before you
can change them to BITMAP
mode.
ChannelType COMPONENT The type of a color channel:
MASKEDAREA
SELECTEDAREA COMPONENT: related to document color
SPOTCOLOR mode.

MASKEDAREA: Alpha channel where
color indicates masked area.

SELECTEDAREA: Alpha channel where
color indicates selected are.

SPOTCOLOR: Alpha channel to store a
spot color.
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Constant type

Values

What it means

ColorBlendMode

BEHIND
CLEAR
COLOR
COLORBURN
COLORDODGE
DARKEN
DARKERCOLOR
DIFFERENCE
DISSOLVE
EXCLUSION
HARDLIGHT
HARDMIXBLEND
HUE

LIGHTEN
LIGHTERCOLOR
LINEARBURN
LINEARDODGE
LINEARLIGHT
LUMINOSITY
MULTIPLY
NORMAL
OVERLAY
PINLIGHT
SATURATION
SCREEN
SOFTLIGHT
VIVIDLIGHT

The way color should be blended in a
fill or stroke operation. Pass to
Pathltem.fillPath(), Selection.fill(),
Selection.stroke()

ColorModel

CMYK
GRAYSCALE
HSB

LAB

NONE

RGB

The color model to use for a
SolidColor.

ColorPicker

ADOBE
APPLE
PLUGIN
WINDOWS

The preferred color-selection tool, set
in Preferences.

ColorProfileType

CUSTOM
NONE
WORKING

The type of color profile used to
manage this document, set in
Document.colorProfileType.

ColorReductionType

ADAPTIVE
BLACKWHITE
CUSTOM
GRAYSCALE
MACINTOSH
PERCEPTUAL
RESTRICTIVE
SELECTIVE
WINDOWS

The color reduction algorithm option
for ExportOptionsSaveForWeb.

ColorSpaceType

ADOBERGB
COLORMATCHRGB
PROPHOTORGB
SRGB

The type of color space to use in
CameraRAWOpenOptions.

CopyrightedType

COPYRIGHTEDWORK
PUBLICDOMAIN
UNMARKED

The copyright status of a document.
Usedin
DocumentPrintSettings.copyrighted.
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Constant type Values What it means
CreateFields DUPLICATION The method to use for creating fields.
INTERPOLATION Pass to ArtLayer.applyDelnterlace().
CropToType ARTBOX The style to use when cropping a page
Egggg?;éaox in a PDF document. Set in
CROPBOX PDFOpenOptions.cropPage.
MEDIABOX
TRIMBOX
DCSType COLORCOMPOSITE The type of composite DCS file to
Egég;gég?ggmogm create with DCS1_SaveOptions or
DCS2_SaveOptions:
COLORCOMPOSITE: Creates a color
composite file in addition to DCS files.
GRAYSCALECOMPOSITE: Creates a
grayscale composite file in addition to
DCS files.
NocoMPOSITE: Does not create a
composite file.
DepthMapSource IMAGEHIGHLIGHT The source to use for the depth map.
LAYERMASK Pass to ArtLayer.applyLensBlur().
NONE yer.apply 0
TRANSPARENCYCHANNEL
DescValueType ALIASTYPE The value type of an action key,
2%2?1;1’;;% returned by
DOURLETYDE Act!onQescrlptor.getType() and
ENUMERATEDTYPE ActionList.getType().
INTEGERTYPE
LISTTYPE
OBJECTTYPE
RAWTYPE
REFERENCETYPE
STRINGTYPE
UNITDOUBLE
DialogModes ALL Controls the type of dialogs
ESROR Photoshop displays when running
scripts.
Direction HORIZONTAL e The direction in which to flip the
VERTICAL document canvas, passed to
Document.flipCanvas().
e The orientation of text in
Textltem.direction.
e The direction of text warping in
Textltem.warpDirection.
DisplacementMapType STRETCHTOFIT Describes how the displacement map
TILE

fits the image if the image is not the
same size as the map. Pass to
ArtLayer.applyDisplace().
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Constant type Values What it means
Dither DIFFUSION The type of dithering to use in
E&EEE GIFSaveOptions,
PATTERN IndexengnversmnOptlons and
ExportOptionsSaveForWeb.
DocPositionStyle PRINTCENTERED The type of positioning to use in
USERDEFINED DocPosition
DocumentFill BACKGROUNDCOLOR The fill type of a new document,
TRANSPARENT passed to Documents.add().
WHITE B —
DocumentMode BITMAP The color mode of a open document,
%?ONE Document.mode. See also
GRAYSCALE Document.changeMode().
INDEXEDCOLOR
LAB
MULTICHANNEL
RGB
EditLogItemsType CONCISE The preferred level of detail in th
DETAILED history log, set in Preferences:
SESSIONONLY —
CONCISE: Save a concise history log.
DETAILED: Save a detailed history log.
SESSIONONLY: Save history log only for
the session.
ElementPlacement INSIDE The object’s position in the Layers
PLACEATBEGINNING palette.
PLACEATEND
PLACEBEFORE .
PLACEAFTER Note: No.t all values are valid forg!l
object types. See the specific
object description to make sure
you are using a valid value.
EliminateFields EVENFIELDS The type of fields to eliminate. Pass to
ODDFIELDS ArtLayer.applyDelnterlace().
ExportType ILLUSTRATORPATHS The type of export for
SAVEFORWEB Document.exportDocument().
This is equivalent to choosing File >
Export > Paths To lllustrator, or File
> Save For Web and Devices.
Extension LOWERCASE The policy and format for appending
NONE an extension to the filename when
UPPERCASE

saving with Document.saveAs().
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Constant type Values What it means
FileNamingType DDMM File naming options for the
BSNMY; AVELOWER BatchOptions used with the
DOCUMENTNEMEMIXED Application.batch() method.
DOCUMENTNAMEUPPER
EXTENSTIONLOWER
EXTENSIONUPPER
MMDD
MMDDYY
SERTALLETTERLOWER
SERTALLETTERUPPER
SERTALNUMBER1
SERTALNUMBER2
SERTALNUMBER3
SERTALNUMBER4
YYDDMM
YYMMDD
YYYYMMDD
FontPreviewType LARGE The preferred type size to use for font
II‘%EEUM previews in the type tool font menus,
SMATL set in Preferences.
ForcedColors BLACKWHITE The type of colors to be included the
NONE color table regardless of their usage.
PRIMARIES . .
WEB Used in GIFSaveOptions and
IndexedConversionOptions.
BLACKWHITE: Pure black and pure
white.
NONE: None
PRIMARIES: Red, green, blue, cyan,
magenta, yellow, black, and white.
WEB: the 216 web-safe colors.
FormatOptions OPTIMIZEDBASELINE The option with which to save a JPEG
PROGRESSIVE file, in JPEGSaveOptions.
STANDARDBASELINE
OPTIMIZEDBASELINE: Optimized color
and a slightly reduced file size.
PROGRESSIVE: Displays a series of
increasingly detailed scans as the
image downloads.
STANDARDBASELINE: Format
recognized by most web browsers.
GalleryConstrainType CONSTRAINBOTH The type of proportions to constrain
CONSTRAINHEIGHT forimages. Used in
CONSTRAINWIDTH

GallerylmagesOptions.
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Constant type Values What it means
GalleryFontType ARIAL The fonts to use for the Web photo
ggﬁ?ﬁi‘” gallery captions and other text. Used
TTMESNEWROMAN in GalleryBannerOptions,
GallerylmagesOptions, and
GalleryThumbnailOptions.
Also used in PicturePackageOptions.
GallerySecurityTextColorType BLACK The color to use for text displayed over
%H??EDM gallery images as an antitheft
deterrent. Used in
GallerySecurityOptions.
GallerySecurityTextPositionType CENTERED The position of the text displayed over
Egﬁigg; gallery images as an antitheft
UPPERLEFT deterrent. Used in
UPPERRIGHT GallerySecurityOptions.
Also used in PicturePackageOptions.
GallerySecurityTextRotateType CLOCKWISE45 The orientation of the text displayed
CLOCKWISE90 over gallery images as an antitheft
COUNTERCLOCKWISE45 deterrent. Used in
COUNTERCLOCKWISE90 :
ZERO GallerySecurityOptions.
Also used in PicturePackageOptions.
GallerySecurityType CAPTION The content to use for text displayed
ggggﬁ(}m over gallery images as an antitheft
CUSTOMTEXT deterrent. Used in
FILENAME GallerySecurityOptions.
NONE
TITLE Note: All types draw from the image’s
file information except
CUSTOMTEXT.
GalleryThumbSizeType CUSTOM The size of thumbnail images in the
I\L/'IEAE%M web photo gallery. Used in
SMATL GalleryThumbnailOptions.
Geometry HEPTAGON Geometric options for shapes, such as
HEXAGON the iris shape in the Lens Blur Filter.
OCTAGON
PENTAGON Pass to ArtLayer.applyLensBlur().
SQUARE
TRIANGLE
GridLineStyle DASHED The preferred line style for the
ggggD nonprinting grid displayed over
images, set in Preferences.
GridSize LARGE The preferred size of grid line spacing,
MEDIUM set in Preferences.
NONE —

SMALL
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Constant type Values What it means
GuideLineStyle DASHED The preferred line style for
SOLID nonprinting guides displayed over
images, set in Preferences.
IllustratorPathType ALLPATHS The paths to export to an lllustrator
DOCUMENTBOUNDS file using
NAMEDPATH
Document.exportDocument().
Intent ABSOLUTECOLORIMETRIC  The rendering intent to use when
PERCEPTUAL converting from one color space to
RELATIVECOLORIMETRIC th th
SATURATION another wi .
Document.convertProfile() or
Document.print()
Justification CENTER The placement of paragraph text
CENTERJUSTIFIED within the bounding box. Used in
FULLYJUSTIFIED Textltem.iustificati
LEFT extltem.justification.
LEFTJUSTIFIED
RIGHT
RIGHTJUSTIFIED
Language BRAZILLIANPORTUGUESE  The language to use for text. Used in
CANADIANFRENCH Textltem.language.
DANISH
DUTCH
ENGLISHUK
ENGLISHUSA
FINNISH
FRENCH
GERMAN
ITALIAN
NORWEGIAN
NYNORSKNORWEGIAN
OLDGERMAN
PORTUGUESE
SPANTSH
SWEDISH
SWISSGERMAN
LayerCompression RLE Compression methods for data for
ZIP

pixels in layers, when saving to TIFF
format. Used in TiffSaveOptions.
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Constant type Values What it means
LayerKind BLACKANDWHITE The type of a layer object, in
BRIGHTNESSCONTRAST ArtLaver.kind.
CHANNELMIXER e
COLORBALANCE
CURVES Note: You can create a text layer only
EXPOSURE from an em pty art layer.
GRADIENTFILL
GRADIENTMAP
HUESATURATION
INVERSION
LEVELS
NORMAL
PATTERNFILL
PHOTOFILTER
POSTERIZE
SELECTIVECOLOR
SMARTOBJECT
SOLIDFILL
TEXT
THRESHOLD
LAYER3D
VIBRANCE
VIDEO
LensType MOVIEPRIME The type of lens to use. Pass to
PRIME105 ArtLayer.applyLensFlare().
PRIME35 yerapply 0
ZOOMLENS
MagnificationType ACTUALSIZE The type of magnification to use when
FITPAGE viewing an image. Used in
PresentationOptions.
MatteType BACKGROUND The color to use to fill anti-aliased
BLACK edges adjacent to transparent areas of
FOREGROUND the i When t .
N eimage. When transparency is
NONE turned off for an image, the matte
SEMIGRAY color is applied to transparent areas.
WHITE ] )
Used in GIFSaveOptions,
IndexedConversionOptions, and
JPEGSaveOptions.
MeasurementRange ALLMEASUREMENTS The measurement to act upon. Pass to
ACTIVEMEASUREMENTS MeasurementLog methods.
MeasurementSource MEASURESELECTION The source for recording
MEASURECOUNTTOOL measurements. Pass to
MEASURERULERTOOL
Document.recordMeasurements().
NewDocumentMode BITMAP The color profile to use for a new
CMYK document.
GRAYSCALE
LAB Pass to Documents.add().
RGB
Also used in ContactSheetOptions and
PicturePackageOptions.
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Constant type Values What it means
NoiseDistribution GAUSSIAN Distribution method to use when
UNIFORM applying an Add Noise filter. Pass to
ArtLayer.applyAddNoise().
OffsetUndefinedAreas REPEATEDGEPIXELS Method to use to fill the empty space
SETTOBRACKGROUND left by offsetting a an image or
WRAPAROUND .
selection. Pass to
ArtLayer.applyOffset().
OpenDocumentMode CMYK The color profile to use when opening
ii:YSCALE an EPS or PDF document. Pass to
RGB app.open () in EPSOpenOptions or
PDFOpenOptions.
OpenDocumentType ALIASPIX The format in which to open the
BMP document, using app.open ().
CAMERARAW ! 9 app - open
COMPUSERVEGIF .
DICOM Note: pHOTOCD is deprecated. Kodak
ELECTRICIMAGE PhotoCD is now found in the
EPS Goodies folder on the Adobe
EPSPICTPREVIEW Photoshop CS4 Install DVD.
EPSTIFFPREVIEW
FILMSTRIP .
IPEG Note: The pICOM option is for the
PCX Extended version only.
PDF
PHOTOCD
PHOTOSHOP
PHOTOSHOPDCS_ 1
PHOTOSHOPDCS_2
PHOTOSHOPEPS
PHOTOSHOPPDF
PICTFILEFORMAT
PICTRESOURCEFORMAT
PIXAR
PNG
PORTABLEBITMAP
RAW
SCITEXCT
SGIRGB
SOFTIMAGE
TARGA
TIFF
WAVEFRONTRLA
WIRELESSBITMAP
OperatingSystem 0s2 The target operating system in
WINDOWS BMPSaveOptions.
Orientation LANDSCAPE Page orientation for
PORTRAIT

PhotoCDOpenOptions, deprecated in
Photoshop CS3.

Note: Kodak PhotoCD is now found in
the Goodies folder on the
Adobe Photoshop CS4 Install
DVD.
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Constant type Values What it means
OtherPaintingCursors PRECISEOTHER The preferred pointer for the following
STANDARDOTHER tools: Eraser, Pencil, Paintbrush,
Healing Brush, Rubber Stamp, Pattern
Stamp, Smudge, Blur, Sharpen, Dodge,
Burn, Sponge.
Set in Preferences.
PaintingCursors BRUSHSIZE The preferred pointer for the following
g?ECISE tools: Marquee, Lasso, Polygonal
Lasso, Magic Wand, Crop, Slice, Patch
Eyedropper, Pen, Gradient, Line, Paint
Bucket, Magnetic Lasso, Magnetic Pen,
Freeform Pen, Measure, Color Sampler.
Set in Preferences.
PaletteType EXACT The palette type to use in
Egcmigigggm GIFSaveOptions and
i lipintens IndexedConversionOptions.
MACOSPALETTE
MASTERADAPTIVE
MASTERPERCEPTUAL
MASTERSELECTIVE
PREVIOUSPALETTE
UNIFORM
WEBPALETTE
WINDOWSPALETTE
PathKind CLIPPINGPATH The type of a Pathltem.
NORMALPATH
TEXTMASK
VECTORMASK
WORKPATH
PDFCompatibility PDF13 The PDF version to make the
igié document compatible with. Used in
H— PDFSaveOptions.
PDF17
PDFEncoding JPEG The type of compression to use when
giggggggﬁggm% saving a document in PDF format.
JTPEG2000LOW Used in PDFSaveOptions.
JPEG2000MED
JPEG2000MEDHIGH
JPEG2000MEDLOW
JPEGHIGH
JPEGLOW
JPEGMED
JPEGMEDHIGH
JPEGMEDLOW
NONE
PDFZIP

PDFZIP4BIT
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Constant type Values What it means

PDFResample NONE The down sample method to use.
PDFAVERAGE Used in PDFSaveOptions.
PDFBICUBIC
PDFSUBSAMPLE

PDFStandard NONE The PDF standard to make the
iggﬁggg; document compatible with. Used in
BDFX32002 PDFSaveOptions.
PDFX32003
PDFX42008

PhotoCDColorSpace LAB16 The color space for
Eégi PhotoCDOpenOptions, deprecated in
RGRS Photoshop CS3.

Note: Kodak PhotoCD is now found in
the Goodies folder on the
Adobe Photoshop CS4 Install
DVD.

PhotoCDSize EXTRALARGE The pixel dimensions of the image in
ﬁ?ﬁw PhotoCDOpenOptions, deprecated in
MEDIUM Photoshop CS3.
MINIMUM EXTRALARGE = 1024x1536
SMALL LARGE = 512x768

MAXIMUM = 2048x3072

MEDIUM = 256x384

MINIMUM = 64x96

SMALL = 128x192

Note: Kodak PhotoCD is now found in
the Goodies folder on the
Adobe Photoshop CS4 Install
DVD.

PICTBitsPerPixels EIGHT The number of bits per pixel to use
g?ﬁEEN when compression a PICT file. Used in
THIRTYTHO PICTFileSaveOptions and
THO PICTResourceSaveOptions.

Note: Use 16 or 32 for RGB images;
use 2, 4, or 8 for bitmap and
grayscale images.

PICTCompression JPEGHIGHPICT The type of compression to use when
ggggﬂ?ﬁplm saving an image as a PICT file. Used in
JPEGMEDTUMPICT PICTFileSaveOptions a.nd
NONE PICTResourceSaveOptions.
PicturePackageTextType CAPTION The function or meaning of textin a
ggg;ﬁGHT Picture Package. Used in
FTLENAME PicturePackageOptions.
NONE
ORIGIN

USER
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Constant type Values What it means
PointKind CORNERPOINT The role a PathPoint plays in a
SMOOTHPOINT Pathltem
PointType POSTSCRIPT The preferred measurement to use for
TRADITIONAL type points, set in
Preferences.pointSize:
POSTSCRIPT = 72 points/inch.
TRADITIONAL = 72.27 points/inch.
PolarConversionType POLARTORECTANGULAR The method of polar distortion to use.
RECTANGULARTOPOLAR Pass to
ArtLayer.applyPolarCoordinates().
Preview EIGHTBITTIFF The type of image to use as a
ﬁgggg;ﬁgﬂm low-resolution preview in the
MACOSMONOCHROME destination application.
ESECE)CHROMETIFF Used in DCS1_SaveOptions,
DCS2_SaveOptions, and
EPSSaveOptions.
PrintColorHandling PRINTERMANAGED The type of color handling to use for
PHOTOSHOPMANAGED ColorHandling
SEPARATTIONS
NOTMANAGED
PrintEncoding ASCII The type of encoding to use for
?EESRY printing to PostScript with
Document.print().
PurgeTarget ALLCACHES Cache to be targeted in an
CLIPBOARDCACHE Application.purge() operation.
HISTORYCACHES 2 purge() op
UNDOCACHES
QueryStateType ALWAYS The preferred policy for checking
ASK = whether to maximize compatibility
when opening PSD files, set in
Preferences.maximizeCompatibility.
RadialBlurMethod SPIN The blur method to use. Pass to
ZOOM ArtLayer.applyRadialBlur().
RadialBlurQuality BEST The smoothness or graininess of the
9
ggégT blurred image. Pass to
ArtLayer.applyRadialBlur().
RasterizeType ENTIRELAYER The layer element to rasterize, using
FILLCONTENT ArtLayer.rasterize().
LAYERCLIPPINGPATH
LINKEDLAYERS
SHAPE

TEXTCONTENTS
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Constant type Values What it means
ReferenceFormType CLASSTYPE The type of an ActionReference
ENUMERATED ;
object, returned by getForm().
IDENTIFIER Ject Y 0
INDEX
NAME
OFFSET
PROPERTY
ResampleMethod BICUBIC The method to use for image
Eimiggﬁéﬁ;ﬁ; interpolation. Passed to
BILINEAR Document.re5|zelmage()f and used.as
NEARESTNEIGHBOR the value of Preferences.interpolation.
NONE
RippleSize LARGE The size of undulations to use. Pass to
MEDIUM A ;
rtLayer.applyRipple().
VAL yer.applyRipple()
SaveBehavior ALWAYSSAVE The application’s preferred behavior
ASKWEEESVING when saving a document. See
Preferences.appendExtension and
imagePreviews
SaveDocumentType ALIASPIX The format in which to save a
EDO/II\E/IPUSERVEGIF document when exporting with
BT.ECTRTCTMAGE Document'.exportDocument(). Pass in
JPEG ExportOptionsSaveForWeb.format, to
PCX to specify the type of file to write. Only
giggg:gggms . the following are supported for
PHOTOSHOPDC8:2 export: COMPUSERVEGIF, JPEG, PNG-8,
PHOTOSHOPEPS PNG-24, and BMER
PHOTOSHOPPDF
PICTFileFORMAT
PICTRESOURCEFORMAT
PIXAR
PNG
PORTABLEBITMAP
RAW
SCITEXCT
SGIRGB
SOFTIMAGE
TARGA
TIFF
WAVEFRONTRLA
WIRELESSBITMAP
SaveEncoding ASCII The type of encoding to use when
?;géﬁGH saving a file to DCS or EPS with
TPEGLOW Document.saveAs().
JPEGMAXIMUM
JPEGMEDIUM
SaveLogItemsType LOGFILE The preferred location of history log
LOGFILEANDMETADATA data, set in Preferences.savelLogltems.
METADATA
SaveOptionsType DONOTSAVECHANGES The policy for closing a document
PROMPTTOSAVECHANGES | \yjth Document.close().
SAVECHANGES —
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Constant type Values What it means
SelectionType DIMINISH The selection behavior when a
EXTEND selection already exists:
INTERSECT
REPLACE DIMINISH: Remove the selection from
the already selected area.
EXTEND: Add the selection to an
already selected area.
INTERSECT: Make the selection only
the area where the new selection
intersects the already selected area.
REPLACE: Replace the selected area.
Used in Pathltem.makeSelection(),
Selection.load(), Selection.select(), and
Selection.store().
ShapeOperation SHAPEADD How to combine the shapes if the
SHAPE INTERSECT destination path already has a
SHAPESUBTRACT lecti
SHAPEXOR selection.
Set for SubPathInfo.operation, stored
in the resulting SubPathltem.
SmartBlurMode EDGEONLY The method to use for smart blurring:
NORMAL
OVERLAYEDGE EDGEONLY, OVERLAYEDGES: Apply blur
only to edges of color transitions.
NORMAL: Apply blur to entire image.
Pass to ArtLayer.applySmartBlur().
SmartBlurQuality HIGH The blur quality to use. Pass to
Low ArtLayer.applySmartBlur().
MEDIUM yer.apply 0
SourceSpaceType DOCUMENT The color space for source when
PROOF printing with Document.print().
SpherizeMode HORTZONTAL The curve (or stretch shape) to use for
5%% the distortion. Pass to
ArtLayer.applySpherize().
StrikeThruType STRIKEBOX The style of strikethrough to use in
STRIKEHEIGHT text. Used in Textltem.strikeThru.
STRIKEOFF
StrokeLocation CENTER The placement of path or selection
égi;?g]ﬂ boundary strokes. Pass to
Selection.stroke().
TargaBitsPerPixels SIXTEEN The resolution to use when saving an
THIRTYTWO image in Targa format. Used in
TWENTYFOUR

TargaSaveOptions.
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Constant type Values What it means
TextCase ALLCAPS The capitalization style to use in text.
NORMAL Used in Textltem.capitalization.
SMALLCAPS
TextComposer ADOBEEVERYLINE The composition method to use to
ADOBESINGLELINE optimize the specified hyphenation
and justification options. Used in
Textltem.textComposer.
TextType PARAGRAPHTEXT The type of text, used in Textltem.kind.
POINTTEXT
PARAGRAPHTEXT: Text that wraps
within a bounding box.
POINTTEXT: Text that does not wrap.
TextureType BLOCKS The type of texture or glass surface
CANVAS image to load for a texturizer or glass
FILE filter. Pass t
FROSTED ilter. Pass to
TINYLENS ArtLayer.applyGlassEffect().
TIFFEncoding JPEG The type of compression to use for
NONE TIFF files. Used in TiffSaveOptions.
TIFFLZW
TIFFZIP
ToolType ARTHISTORYBRUSH The tool to use with
BACKGROUNDERASER Pathltem.strokePath().
BLUR
BRUSH
BURN
CLONESTAMP
COLORREPLACEMENTTOOL,
DODGE
ERASER
HEATLINGBRUSH
HISTORYBRUSH
PATTERNSTAMP
PENCIL
SHARPEN
SMUDGE
SPONGE
TransitionType BLINDSHORIZONTAL The method to use for transition from
BLINDSVERTICAL one image to the next in a PDF
BOXIN tation. Used i
BOXOUT presentation. Used in
DISSOLVE PresentationOptions.
GLITTERDOWN
GLITTERRIGHT
GLITTERRIGHTDOWN
NONE
RANDOM
SPLITHORIZONTALIN
SPLITHORIZONTALOUT
SPLITVERTICALIN
SPLITVERTICALOUT
WIPEDOWN
WIPELEFT
WIPERIGHT

WIPEUP
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Constant type Values What it means
TrimType BOTTOMRIGHT Type of pixels to trim around an
TOPLEFT image, passed to Document.trim().:
TRANSPARENT -
BOTTOMRIGHT = bottom right pixel
color.
TOPLEFT = top left pixel color.
TypeUnits MM The preferred unit for text character
PIXELS measurements, set in Preferences.
POINTS —
UndefinedAreas REPEATEDGEPIXELS The method to use to treat
WRAPAROUND undistorted areas or areas left blank in
an image to which the afilter in the
Distort category has been applied.
Pass to ArtLayer.applyDisplace(),
applyShear(), applyWave().
UnderlineType UNDERLINELEFT The placement of text underlining.
UNDERLINEOFF Used in Textltem.underline.
UNDERLINERIGHT
Note: UNDERLINELEFT and
UNDELINERIGHT are valid only when
direction = Direction.VERTICAL.
Units CM The preferred measurement unit for
DI/HI\\/I[CHES type and ruler increments, set in
DERCENT Preferences.rulerUnits.
PICAS
PIXELS
POINTS
Urgency FOUR The editorial urgency status of a
I;é%H document, setin
NONE DocumentPrintSettings.urgency.
NORMAL
SEVEN
SIX
THREE
TWO
WarpStyle ARC The warp style to use for text. Used in
ARCH Textltem.warpStyle.
ARCLOWER
ARCUPPER
BULGE
FISH
FISHEYE
FLAG
INFLATE
NONE
RISE
SHELLLOWER
SHELLUPPER
SQUEEZE
TWIST

WAVE
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Constant type Values What it means
WaveType SINE The type of wave to use. Pass to
SQUARE ArtLayer.applyWave().
TRIANGULAR APl 0
WhiteBalanceType ASSHOT Lighting conditions that affect color
?:Eggm balance. Setin
CUSTOM CameraRAWOpenOptions.
DAYLIGHT
FLASH
FLUORESCENT
SHADE
TUNGSTEN
ZigZagType AROUNDCENTER The method of zigzagging to use. Pass
OUTFROMCENTER

to ArtLayer.applyZigZag().

PONDRIPPLES




Appendix A: Event ID Codes

The following table lists events and their four-character ID codes or string identifiers for use with the

notifier object.

Note: Do not include single quotes (') with four-character IDs in your code. The single quotes are

used in this table to illustrate the placement of required spaces in codes that do not contain four
letters. However, string identifiers, which are longer than four characters, require double quotes in

the code.

Tip: If you can’t find the event you want to use for notification in this table, you can use ScriptListener to
determine the event ID code. See the ScriptListener documentation in the Action Manager chapter of

the Photoshop CS4 Scripting Guide.

Event 4-char ID or String
3DTransform 'TdT !
Average 'Avrg'
ApplyStyle 'ASty!
Assert 'Asrt’
AccentedEdges 'AccE'"
Add 'Add !
AddNoise 'AdNs'
AddTo 'AddAT!
Align 'Algn’
All 'All
AngledStrokes 'AngS'
ApplyImage 'AppI!
BasRelief 'BsR1'
Batch 'Btch'
BatchFromDroplet 'BtcF!
Blur 'Blr !
BlurMore 'BlrM'
Border 'Brdr'
Brightness 'BrgC'
CanvasSize 'Cnvs'
ChalkCharcoal 'Chlc!
ChannelMixer 'ChnM'
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Event 4-char ID or String
Charcoal 'Chrc'
Chrome 'Chrm'
Clear 'Cler’
Close 'Cls
Clouds 'Clds'
ColorBalance 'ClrB'
ColorHalftone 'ClrH'
ColorRange 'ClrR!
ColoredPencil 'Clrp!’
ContactSheet "0B71D221-F8CE-11d2-B21B-0008C75B322C"
ConteCrayon 'CntC'
Contract 'Cntc'!
ConvertMode 'CnvM'
Copy 'copy'’
CopyEffects 'CpFX!
CopyMerged 'CpyM'
CopyToLayer 'CpTL'
Craquelure 'Crql!
CreateDroplet 'CrtD!
Crop 'Crop'
Crosshatch 'Crsh'
Crystallize 'Crst’
Curves 'Crvs'
Custom 'Cstm'
Cut 'cut !
CutToLayer 'CtTL!'
Cutout 'ct !
DarkStrokes 'DrkS'
DelInterlace 'Dntr’
DefinePattern 'DfnpP’
Defringe 'Dfrg’
Delete 'Dlt !
Desaturate 'Dstt’
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Event 4-char ID or String
Deselect 'Dslc’
Despeckle 'Dspc'!
DifferenceClouds 'DrfcC’
Diffuse 'Dfs !
DiffuseGlow 'DEsG'
DisablelLayerFX 'dlfx’
Displace 'Dspl’
Distribute 'Dstr’
Draw 'Draw'
DryBrush 'DryB'
Duplicate 'Dplc’
DustAndScratches 'DstS'
Emboss 'Embs'
Equalize 'Eqlz’
Exchange 'Exch'
Expand 'Expn'’
Export 'Expr!
Jumpto 'Jpto!

ExportTransparentImage

"02879e00-cb66-11d1-bc43-0060b0al3dc4™"

Extrude 'Extr’
Facet 'Fet !
Fade 'Fade'
Feather 'Fthr'
Fibers 'Fbrs'
Fill 'F1 !
FilmGrain 'FlmG'
Filter 'Fltr'
FindEdges 'FndE'
FitImage "3caal3434-cb67-11d1-bc43-0060b0all3dc4™"
FlattenImage 'F1tI!
Flip 'Flip'
Fragment 'Frgm'
Fresco 'Frsc'
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Event 4-char ID or String
GaussianBlur 'GsnB'
Get 'getd!
Glass 'Gls '
GlowingEdges 'G1lwE'
Gradient 'Grdn'
GradientMap 'GrMp'
Grain 'Grn '
GraphicPen 'GrabP'
Group 'GrpL’'
Grow 'Grow'
HalftoneScreen 'H1fS'
Hide 'HA '
HighPass '"HghP'
HSBHSL 'HsbP'!
HueSaturation '"HStr'
ImageSize 'ImgS'
Import ' Impr'
InkOutlines 'InkO'
Intersect 'Intr’'
IntersectWith "IntwW!'
Inverse 'Invs'
Invert 'Invr'
LensFlare 'LnsF!
Levels 'Lvls'
LightingEffects 'LghE'
Link 'Ink '
Make 'Mk !
Maximum 'Mxm '
Median 'Mdn '
MergeLayers 'Mrg2"'
MergeLayersOld 'MrgL'
MergeSpotChannel 'MSpt'
MergeVisible 'MrgV'
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Event 4-char ID or String
Mezzotint 'Mztn'
Minimum 'Mnm '
ModeChange "8cbaB8cd6e-cb66-11d1-bc43-0060b0al3dc4"
Mosaic 'Msc '
Mosaic_ PLUGIN 'MscT'
MotionBlur 'MtnB'
Move 'move'
NTSCColors 'NTSC'
NeonGlow 'NGlw'
Next 'Nxt !
NotePaper 'NtPr'
Notify 'Ntfy!
Null typeNull
OceanRipple 'OcnR'’
Offset 'Ofst’
Open "Opn '
Paint 'Pnt '
PaintDaubs 'PntD’
PaletteKnife 'P1tK'
Paste 'past’!
PasteEffects 'PaFX!'
Pastelnto 'PstI!’
PasteOutside 'PstO’
Patchwork 'Ptch’
Photocopy 'Phtc!
PicturePackage "4C1lABF40-DD82-11d2-B20F-0008C75B322C"
Pinch 'Pnch'’
Place 'Plc '
Plaster 'Plst’
PlasticWrap 'PlswW'
Play 'Ply !
Pointillize 'Pntl’
Polar 'Plr !
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Event 4-char ID or String
PosterEdges 'PStE"
Posterize 'Pstr’
Previous 'Prvs'
Print 'Prnt’
ProfileToProfile '"PriT!
Purge 'Prge’
Quit 'quit'
RadialBlur 'RA1B'
Rasterize 'Rstr’
RasterizeTypeSheet 'RstT'
RemoveBlackMatte 'RmvB'
RemoveLayerMask 'RmvL'
RemoveWhiteMatte 'RmvW'
Rename 'Rnm '
ReplaceColor 'RplC!
Reset 'Rset’
ResizeImage "1333¢cf0c-cb67-11d1-bcd3-0060b0al3dc4"
Reticulation 'Rtcl’
Revert 'Rvrt'
Ripple 'Rple’
Rotate 'Rtte!
RoughPastels 'RghP'
Save 'save'
Select 'slct’
SelectiveColor 'SlcC!
Set 'setd’
SharpenEdges 'ShrE'
Sharpen 'Shrp'
SharpenMore 'ShrM'
Shear 'Shr !
Show 'Shw '
Similar 'Smlr'
SmartBlur 'SmrB'
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Event 4-char ID or String
Smooth 'Smth'
SmudgeStick 'SmdS'’
Solarize 'Slrz’
Spatter 'Spt !
Spherize 'Sphr'
SplitChannels 'Splc!’
Sponge 'Spng'!
SprayedStrokes 'SprS!
StainedGlass 'StnG'
Stamp 'Stmp'!
Stop 'Stop'!
Stroke 'Strk!’
Subtract 'Sbtr'
SubtractFrom 'SbtF'
Sumie 'Smie’
TakeMergedSnapshot 'TkMr'
TakeSnapshot 'TkSn'
TextureFill 'TxtF!
Texturizer 'Txtz'
Threshold 'Thrs'
Tiles 'Tls '
TornEdges 'TrnE'’
TraceContour 'TreC!
Transform 'Trnf’
Trap 'Trap'
Twirl 'Twrl'
Underpainting 'Undr'’
Undo 'undo'
Ungroup 'Ungr!
Unlink 'Unlk’
UnsharpMask 'UnsM'
Variations 'Vrtn'
Wait 'Wait'
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Event 4-char ID or String
WaterPaper 'WtrP!'
Watercolor 'Wtre'
Wave 'Wave'
Wind 'Wnd !
ZigZag '2979'
BackLight 'BacL'
FillFlash 'FilE'
ColorCast 'ColE’
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Action Manager 194
actions
command lists 42
descriptions 45
descriptors 39
playing 49
active document 47
activePrinter 97
Add Noise filter
adjustments
brightness 56
color 198
color balance 56, 62
contrast 56, 60
curves 56
highlights 63
levels 56, 60
shadows 63
temperature 62
Adobe lllustrator, exporting paths to 106
alpha channels
defined 73
from transparency (TIFF documents) 187
opacity 73
saving
in BMP documents 70
in PDF documents 147
in PICT documents 152
in PICT resources 153
in Pixar documents 155
in PSD documents 151
in RAW documents 163
in SGIRGB documents 172
in Targa documents 177
in TIFF documents 187
anchor points
adding 142
annotations, importing 93
anti aliasing
text 180
application
activating 49
checking if feature enabled 49
defaults 157
location 48
preferences 157
artLayers, See layers
Asian text 159
authors 100
auto kerning 180, 198
auto leading 185
auto spacing, contact sheets 83

available memory 47
Average filter 56

background color
application 47
galleries 111
background layers 54
backgroundColor 97
baseline shift 180
batch command 49
batches
destination folder 67, 198
specifying options 67
beeping 157
bitmap documents
converting to 199
depth type 199
halftone type 199
opening 208
saving 70
bitmap images
See bitmap documents
black and white images 63
bleedWidth 97
blending modes
layer sets 128
layers 54
Blur filter 56
blur filters
Average 56
Blur More 56
Gaussian Blur 57
Lens Blur 58
Motion Blur 59
Radial Blur 59
Smart Blur 60
Blur More filter 56
BMP documents
See bitmap documents
brightness 56
adjusting 56

equalizing 61
build 47
C
caches
images 158
purging 51
camera raw documents
opening 71

settings 200
size options 200
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canvas
flipping 93
resizing 93
canvas, defined 89
caption 97
captions
contact sheets 83
documents 100
gallery images 112
gallery thumbnails 116
images 100
centerCropMarks 97
channels
activating 89
adding 75
adjusting 56
alpha See alpha channels
creating 75
deleting 73
displaying in color 157
duplicating 73
making visible 73
merging 73
mixing 62
splitting 94
spot See spot channels
types of 73
clipping paths
from paths 138
from text 186
Clouds filter 56
CMYKColor 80
color balance, adjusting 62
color picker 157
color profiles
changing 92
determining type of 90
naming 89
color profiles, see individual document formats
color samplers
adding 82
creating 82
moving 81
removing 81
colorBars 97
colorHandling 97
colors
active links 111
adjusting 198
balancing 56
channels 73
CMYK 80
custom settings 114
in galleries 111
inverting 61
modifying 63
none 134
preserving (GIF only) 117
reduction 107
settings 47

solid color objects 173
testing if equal 173
visited links 111
comments, layer comps 125
compatibility, maximizing 158
component channels
color balance 56
defined 73
listing 89
See composite channels
composite channels 73
See component channels
Compuserve GIF documents
opening 208
saving 117
contact sheets
captions 83
columns 83
dimensions 83
making 50
rows 83
contrast
adjusting 56
adjusting automatically 60
camera raw settings 71
midtones 63
copies 97
copyrights 100
cornerCropMarks 97
count items
adding 85
creating 85
removing 84
cropping 92
CS4 version changes 35
cursors 159
curves, adjusting 56
Custom filters 56

D

DCS 1 documents, saving 86
De-Interlace filter 57
desaturate 61
Despeckle filter 57
dialogs
displaying 47
Difference Clouds filter 57
Diffuse Glow filter 57
Displace filter 57
distort filters
Diffuse Glow 57
Displace 57
Glass Effect 57
Ocean Ripple 59
Pinch 59
Polar Coordinates 59
Ripple 59
Shear 59
Spherize 60
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Twirl 60
Wave 60
Zigzag 60
document formats, see individual document formats
DocumentPrintSettings 97
documents 89
activating 47
adding 103
closing 91
code sample 95
color profiles 89
color samplers 89
counting items 90
counting objects 92
cropping 38,92
dimensions 89
duplicating 38,92
exporting 93
info 100
loading 50
managed 90
measurement scale 90
metadata 90, 100
open with Photoshop dialog 51
opening 51
optimizing for web 107
printing 93
resizing 93
resolution 91
saving 93, 94
suspending history 94
trapping (CMYK) 94
trimming 94
Dust and Scratches filter 57

E

Enable Info
constants 192
grammar 191
operator precendence 192
variables 193
EPSSaveOptions 105
equalize 61
event IDs
using ScriptListener to find 217
Events Manager 48
executing scripts 34
exif 100
exporting
documents 93
paths 106
to lllustrator 106
to Web 107
ExportOptionslllustrator 106
ExportOptionsSaveForWeb 107

F
file extensions
format 160

including 157
script files 33
file metadata 100
files
merging 50
filetypes
macOS 48
Windows 49
filling
paths 137
selections 166, 167, 168
filter, see individual filter names
flip 97
Folder object 33
fonts
detecting 47
determining family of 178
determining style of 178
formats, see individual document formats

G

galleries 114
background color 111
banners 110
captions 112
color options 111
credits 112
dimensions 112
filenames 112
link colors 111
making 49, 50
metadata 114
photographer 110
security text 115
thumbnail images 116
GalleryBannerOptions 110
GalleryCustomColorOptions 111
GallerylmagesOptions 112,113
GalleryOptions 114
GallerySecurityOptions 115
GalleryThumbnailOptions 116
Gaussian Blur filter 57
GIF documents
See Compuserve GIF documents
GIFSaveOptions 117
Glass Effect filter 57
glyph scaling 180-183
GrayColor 118
grids 158
grouped layers 54
guides 158

H

halftone screen 69
hanging punctuation 181
hardProof 97
High Pass filter 57
highlights

adjusting 63
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color balance 56
histograms
channels 73
history log 160
history states
activating 89
allowing nonlinear 158
default number of 159
snapshot 119
suspending 94
HSBColor 121
hypenation 182

IDs
getting 39
PICT Resource 153
property 45
runtime 49
runtime to string 52
string to runtime 51
string to type 51
type to char 51
lllustrator
See Adobe lllustrator
image
resizing 93
image pyramids 187
images
bitmap 69
black and white 63
caches 158
captions 112
definition of 89
desaturating 61
equalizing 61
filetypes 48
from split channels 94
inverting colors 61
previewing 158
pyramids 187
resizing 93
resizing in galleries 113
thumbnails 116
indexed color model 122
IndexedConversionOptions 122
individual document formats, examples 94
installing scripts 34
Intent 97
interpolate 97
interpolation 158

J

JavaScript
changes in Photoshop CS4 35
supported features 33
JavaScript Resource
Enable Info grammar 191
javascriptresource syntax 190

javascriptresource tag 190
JPEG

quality 123
JPEG documents

quality 123

saving 123
JPEG options

scans 123
JPEGSaveOptions 123
justification 182

K

kerning 180
text
auto kerning 198
keyboard behavior 158

L
LabColor 124
labels 97
languages 182
layer comps 125
adding 126
applying 125
in documents 90
layer sets
adding 130
art layersin 128
duplicating 129
in documents 90
linked layers in 128
linking 129
locking contents 128
moving 129
nesting 128
opacity 128
unlinking 129
layer styles, applying 60
LayerComps 126
layered TIFFdocuments, saving 157
Layers 127
layers
adding 66
applying styles 60
background 54
blending mode 54
bounds 54
clipboard commands 60
comps 125
copying 60
duplicating 61
flattening 93
grouping 54
in documents 90
inverting 61
kind 54
linking 61
locking contents 54-55
making visible 55
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merging 61
merging visible 93
moving 62
rasterizing 93
rasterizing contents 62
removing 66
resizing 63
rotating 63
saving in PDF documents 147
unlinking 63
LayerSet 128
LayerSets 130
layersets
merging 129
leading 182,185
Lens Blur filter
applying 58
Lens Flare filter 58
letter spacing 181-184
levels
adjusting 56
adjusting automatically 56
ligatures 180-182
linked layers 61
unlinking 63
links
colors 111

M
MacOS

filetypes 48
managed documents 90
mapBlack 97
maximizing compatibility 158
Maximum filter 58
Median Noise filter 58
memory 47
merging

layers 61

visible layers 93
metadata

document 90

document object 100

galleries 114

xmp 91,189
methods

batch 49
midtones

color balance 56
Minimum filter 59
Motion Blur filter 59

N

negative 97
noise filters
Add Noise
Despeckle 57
Dust and Scratches 57
Median Noise 58

nonlinear history 158
notifications

events within scripts 135
notifiers

adding 136

eventIDs 217

removing 135
NTSC filter 59

(o)

object model
changes in Photoshop CS4 35
Ocean Ripple filter 59
Offset filter 59
old style type 184
opacity
channels 73
gallery security text 115
layer fill 54
layer sets 128
layers 55
picture packages 154
open options
DICOM format 88
EPS format 104
PDF format 146
Photo CD format 150
RAW format 71, 162
optimizing 107
other filters
Custom 56
High Pass 57
Maximum 58
Minimum 59
Offset 59

P

palettes 159

pasting 93

path 48

path items
adding 141
deselecting 137
filling 137
from text 186
making selection 138
path points 175
selecting 138
specifying path kind 137
stroking 138
sub items 137
sub path info 174
sub path items 175
work path from selection 166, 167, 168

path point info
anchor points 143
left direction 143
right direction 143

path points
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anchor points 142

left direction 142

right direction 142
Pathltems 141
paths

See path items
PDF documents

opening 146

saving 147
PDF presentations

auto advance 161

making 50

output format 161

transition type 161
Photo CD discs, opening 150
photo filtering 62
photo galleries

See galleries
photomerge 50
Photoshop documents

opening 208

saving 151
Photoshop files, maximizing compatibility 158
PICT documents

opening 208

saving 152
PICT resources

opening 208

saving 153
picture packages

contents 154

flattening 154

making 50

opacity 154

options 154

text properties 154
Pinch filter 59
Pixar documents

opening 208

saving 155
PixarSaveOptions 155
pixels

aspect ratio 90

doubling 159

equalizing 61

interpolation 158

locking 55

unit measures 215
playback options 48
playbackDisplayDialogs 48
plug-in folder

additional plug-in folder 160
PNG 8 documents, saving 107
PNG documents

saving 156
PNGSaveOptions 156
Polar Coordinates filter 59
posterrize 62
postscript encoding 93
PostScript names 178

posX 97
posY 97
Preferences 157
PresentationOptions 161
presentations
making 50
PDF presentations
printBorder 97
printing, documents 93
printOneCopy 93
printSelected 97
printSettings 90
printSpace 97
property
measurementLog 48
PSD documents
opening 208
saving 151
purging 51

Q
quickMaskMode 90
quote style 159

R
Radial Blur filter 59
rasterize 62
rasterizing
document layers 93
RAW documents
opening 162
RawSaveOptions 163
recentFiles 48
registrationMarks 98
render filters
Clouds 56
Difference Clouds 57
Lens Flare 58
renderintent 97
resolution
bitmap conversions 69
documents 91
RGBColor 164
Ripple filter 59
rotation 63
ruler units 159
runMenultem 51

S
save as 94
saved 91
saving 93
saving, see individual document formats.
scale 98
scripting interface
build date 48
version 48

scriptingVersion 48
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scripts
automation 190, 194
enabling/disabling in menu 190
executing 34
grouping in menu 190
installing 34
startup 34
terminology dictionary 194
valid file extensions 33
Scripts Events Manager 48
selected areas 91
selections 165
boundaries 165
clearing 165
copying 165
cutting 165
deselecting 165
feathering 165
filling 166,167, 168
from paths 138
making work path from 166, 167, 168
resizing 165, 166, 167, 168
rotating 166, 167, 168
smoothing 169
stroking 169
selective color 63
SGIRGB documents
saving 172,212
SGIRGBSaveOptions 172,198
shadows
adjusting 63
color balance 56
Sharpen Edges filter 59
Sharpen filter 59
sharpen filters
Sharpen 59
Sharpen Edges 59
Sharpen More 59
Unsharp Mask 60
Sharpen More filter 59
Shear filter 59
Smart Blur filter 60
smart quotes 159
Spherize filter 60
spot channels
defined 73
merging into component channels 74
opacity 73
saving
in DCS 2 documents 87
in PDF documents 148
in PSD documents 151
in RAW documents 163
in SGIRGB documents 172
in TIFF documents 187
spotColors 172
startup scripts 34
strike thru 185
stroking
default stroke color 47

path items 138

selections 169
styles, applying 60
sub path items 137
systemInformation 48

T

temperature 62
terminology dictionary
defined 194
syntax 194
text
Asian 159
auto kerning 180
auto leading 185
captions 112
color
composer 185
content 180
creating paths from 186
formatting 185
gallery security 115, 205
hyphenation 182
in picture packages 154
justification 182
languages 182
offset 180
orientation 181
spacing 181-184
tracking 185
wrapping 182
text composer 185
text fonts
See fonts
text items
See text
text layers
adding contents 180
creating 54
Texture Fill filter 60
texture filters, Texture Fill 60
threshold 63
thumbnails 116
Mac OS 158
Windows 160
TIFF documents
layered 157
saving 187
togglePalettes 52
tool tips 159
tracking, text 185
transmission info 100
trapping 94
Twirl filter 60
type units 159

U

underlining 185
units
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ruler 159

type 159
UnitValue object 33,188
Unsharp Mask filter 60
URLs, document 100
UTF8 Encoding 114

Vv

vectorData 98
version
application 49
scripting interface 48
video alpha 160
video filters
De-Interlace 57
NTSC 59
visibility
channels 73
layer comps 125
layers 55

w

warp 185

Wave filter 60

Web photo galleries
See galleries.

webSnap 108

width 91

Windows
filetypes 49

word spacing 181-184

work paths
designating 209
from selected area 166, 167, 168

wrapping, text 182

X

XML 189
Xxmp metadata 91, 189

Y4
Zigzag filter 60
zoom 158
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